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Chapter 1: Introduction

Lightworks is an Academy and Emmy award-winning, professional Non-Linear Editing (NLE) 
system for editing and mastering of audio-visual media. It supports resolutions up to 4K as well as 
video in PAL, NTSC and HD formats. Lightworks provides an enhanced user experience with an 
optional keyboard and Console control surface, allowing you to easily perform your NLE work. 

This document introduces you to the purpose and functions of your Lightworks system, explains 
the concepts you’ll need to understand to use it effectively, and describes workflow procedures. 
The manual is designed for anyone who uses the Lightworks system. 

Lightworks was first developed back in the early 1990s and has been used on some incredible films 
over the years. The interface is different from other editing software you may have used, but this 
does not mean it is difficult or not suited for your needs. It is a powerful and friendly application 
which just needs some basics explained in order to use it as it was intended. A number of video 
tutorials and supplementary documentation have been prepared which can be used in 
conjunction with this User Guide. See "Additional Documentation and Tutorials" on page 14. 

One of the critical differences with Lightworks compared to other applications is that Lightworks 
is constantly saving everything you do. There is no Save or Save As function for this reason, and is 
why you will not find anything about it in this Guide. Any changes you make within the project, 
moving a panel, changing an edit or adding an effect, is backed up the moment you have made 
the change. 

See the following topics:

• "Features" on page 12

• "System Requirements" on page 12

• "Hardware Components" on page 12

• "Additional Documentation and Tutorials" on page 14

• "Troubleshooting" on page 15

• "Technical Support Contracts" on page 15
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Features

Lightworks has the following features: 

• Support for a wide range of formats and codecs 

• Advanced Multi-Cam editing

• Third Party support for Boris Graffiti and Boris FX (Windows 64-bit and macOS / OS X only) 

• Sub-frame audio editing, direct to timeline voice over tool, Mackie protocol support. 

• Advanced Project Sharing features 

• Full-screen video output through a DVI-attached LCD display and support up to 4K Full Frame 

• Advanced Stereoscopic support with independent editorial control of Left and Right eyes 

To enable all of Lightworks’ features, including advanced codec support, you must purchase a 
Lightworks Pro license. Advanced codec support is for export markets only. 

Instructions for upgrading to Lightworks Pro are provided in the EditShare Lightworks Installation 
and Activation Guide. 

You can compare how the versions of Lightworks differ by navigating to the web site 
www.lwks.com/compareversions. 

System Requirements

Minimum system specifications are described in the EditShare Lightworks Installation and Activation 
Guide. They can also be found at www.lwks.com/techspecs 

Hardware Components

The Hardware components supported by Lightworks are described below: 

Hardware I/O

The following Hardware I/O devices are supported: 

• Blackmagic (Windows, macOS / OS X and Linux) 

• AJA (Windows and macOS / OS X) 

• Matrox (Windows only) 

Mouse

Lightworks has many functions that can be accessed by a standard two-button mouse with a 
central wheel.
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Hardware Components

Standard Keyboard

Many of Lightworks’ editing functions can be accessed from shortcuts on your keyboard. Although 
the default set of shortcuts will be familiar to regular users of Lightworks, you can change the key 
assignments to your own preferences, such as editing applications you are already familiar with. 
See "Keyboard Shortcuts" on page 240. 

A keyboard specially designed for use with Lightworks is available, see "Customized Keyboards" on 
page 13. 

Customized Keyboards

You can order a custom designed USB keyboard specially designed for Lightworks, containing 
shortcuts and application functions. Color coded for ease of use, the keys are printed with icons 
and labels to ensure a fast learning curve. 

Keyboards for the following languages and regions are available: 

• English (United Kingdom)

• English (United States)

• French, German, Spanish

• Czech

• Italian

• Chinese (Hong Kong)

• Chinese (Taiwan)

• Japanese

When you import Lightworks Preferences, the keyboard template that matches your physical 
keyboard is imported. 
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Lightworks Console

The Lightworks Console can be used to play video and audio, and to control many of Lightworks’ 
editing functions. 

The console has keys for the more common editing functions and a flat bed-style paddle to 
facilitate post production operations. A free USB port is required to connect the Lightworks 
Console. Power for the Lightworks Console is provided from the USB port of the host system. 

Consoles may be ordered from the Lightworks web site: www.lwks.com. For a full description of 
the Lightworks Console, see "Appendix A: Lightworks Console" on page 251. A series of video 
tutorials for the Lightworks Console are available on the Lightworks website at 
www.lwks.com/the-console. 

Additional Documentation and Tutorials

The following documentation is available from EditShare:

• Lightworks v14.1 Installation and Activation Guide

• Lightworks v14.1 Quick Start Guide

We strongly recommend watching the Lightworks video tutorials, including the Quick Start Video, 
which can be found at http://www.lwks.com/tutorials  These videos will give you an excellent 
overview of the Lightworks and how best to use it. 

You should also refer to the Lightworks ReadMe supplied with your version of Lightworks for 
features introduced after this Guide was published. 
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Troubleshooting

Troubleshooting

If you experience an issue with your Lightworks installation, or something isn't working as 
expected, visit our FAQ page at http://www.lwks.com/faq where you can type in a question 
relating to the issue and view the search results. If you do not find an answer to your question, you 
can refer to the Lightworks forums at http://www.lwks.com/forum 

Technical Support Contracts

For assistance beyond this document and that provided in your Lightworks documentation, you 
can purchase a Technical Support Contract for Lightworks from our online shop at 
http://www.lwks.com/shop. Technical Support is by Telephone and Email. 

http://www.lwks.com/faq
http://www.lwks.com/forum
http://www.lwks.com/shop
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The keyboard shortcuts described in this manual are the defaults for Lightworks. You can 
change the keyboard shortcuts to suit your preferences, see "Keyboard Shortcuts" on 
page 240. 

This chapter provides a brief overview of Lightworks with some tutorials to get you started. It 
shows you how to create projects, add media to them, and how to use the Content Manager. 

See the following topics: 

• "Starting Lightworks" on page 18

• "Overview" on page 19

• "Changing the Desktop" on page 23

• "Projects" on page 24

• "The Content Manager" on page 29
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Starting Lightworks

To start Lightworks: 

STEPS

1. Windows: Double-click the Lightworks desktop icon. 
Linux and Macintosh: Single click on the Lightworks desktop 
icon. 

2. The Lightworks application opens in the Project Browser view. 

3. The first time you start Lightworks, the Project Browser displays a grid of blank tiles. 

4. Existing Lightworks projects display as tiles with a title in the tile header and, optionally, a 
small preview or thumbnail of a media item from the project. 

5. If you are using the free version of Lightworks, the time remaining before the license expires 
displays in the bottom right corner of the screen. 

You have a seven day automatic Free license which can be renewed by simply registering an 
account. This is renewable every seven days. 

2

5

4 3
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Overview

Overview

For an overview of Historic Lightworks, see "Appendix B: Flexible Lightworks" on page 257. 

See the following topics: 

• "Projects View" on page 19

• "Edit / Sequence View" on page 20

• "Video Effects (VFX) View" on page 21

• "Audio View" on page 22

Projects View

The Projects view is the view that displays when you first open a Project in Lightworks: 

513

12

11

6

9

4

10

2

7

8

1. Log Tab 7. Cue Markers Panel

2. Function Tabs 8. Hints Popup Panel

3. Project Contents Tab 9. Metadata Panel

4. Local Files Tab 10. Clip Thumbnail 

5. Media Viewer 11. Content Manager

6. Scrub Bar 12 Exit / Project Browser Button
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Edit / Sequence View

Click the Edit tab (1) or press F2 to access the Edit/ Sequence View. 

312

4

5

6

9

7

8

11

10

1. Edit Tab (for Sequence view) 7. Sequence Timeline

2. Project Contents Tab 8. Timeline Indicator 

3. Media Viewer 9. Clip in Sequence 

4. Marker IN / Out / Clear Buttons 10. Video (V) and Audio (A) Tracks

5. Undo / Redo Buttons 11. Timeline Zoom In / Zoom Out 

6. Add Voice Over Button 
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Overview

Video Effects (VFX) View

Click the VFX tab (1) or press F3 to access the Video Effects (VFX) View. 

412

56

7

3

1. VFX Tab 5. VFX Timeline

2. Settings Tab 6. Effects Track

3. Effect Enabled Indicator 7. Transition / Effect Panel 

4. Media Viewer 
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Audio View 

Click the Audio tab (1) or press F4 to access the Audio View. 

412

89

11

10

3

5

6

7

1. Audio Tab (accesses Audio view) 7. Audio Channel Indicator

2. Add Audio Effect Tab 8. Timeline 

3. Media Viewer 9. Track Labels

4. Audio Mixer 10. Apply Audio Effect Button

5. Audio Channel Balance Control 11. Audio Effect Panel

6. Audio Channel Level Indicator 
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Changing the Desktop

Changing the Desktop

See the following topics: 

• "Resizing Panels" on page 23

• "Hints and Tips" on page 24

To change the Projects view to Historic Lightworks, see "Appendix B: Flexible Lightworks" on 
page 257. 

See "Appearance" on page 234 to change other aspects of the Lightworks desktop. 

Resizing Panels

You can resize most panels in Lightworks if you want a larger viewing area for media items. Do the 
following: 

STEPS

1. Hover your mouse over two adjoining vertical or horizontal panels 
until the cursor changes to a double-ended arrow. 

2. Hold down the left mouse key and drag to resize the panel. 

3. Release the mouse button. 

2 2
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Hints and Tips

To help you learn the basics of lightworks, information about functions you initiate display as hints 
and tips. 

STEPS

• To clear a hint, click the OK button. 

• To stop these messages displaying, click on ‘Show hints’ to turn off the green indicator. 

• If you have disabled hints, you can restore them as follows: 

a) Click the button at the top left corner to return to the Project Browser. 

b) Click on the Cogs icon at the top right corner of the Project Browser. 

c) From the menu that opens, click ‘Show hints’ to alternately hide or show hints. 

Projects

Projects are used to organize your media, allowing you to group clips into separate projects, which 
you can then choose to share with other users if you wish. When you start Lightworks, you are 
presented with a series of graphical tiles arranged into a grid. Each tile represents a project. You 
open a project by double-clicking on it. 

See the following topics: 

• "Opening an Existing Project" on page 26

• "Creating a New Project" on page 25

• "Closing a Project" on page 28

• "Deleting a Project" on page 28
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Projects

Creating a New Project

To create a new project: 

STEPS

1. Click on the ‘Create a new project’ link. 

2. When the dialog box opens: 

a) Type a name for your project in the Name text box. 

b) Select the frame rate for the media in your project. If you want to use mixed frame rates, 
select ‘Mixed rates’. 

c) Click Create. 

3. A new, empty project is created and opens with the Log tab selected. 

4. Add media, as required, as described in "Importing Clips into a Project" on page 27. 

2

1

34
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Opening an Existing Project

To open an existing project: 

STEPS

1. In the Project Browser, double-click on the tile representing the project you want to open. 

2. If there are too many projects to display on screen at once: 

a) Use the scroll bar at the right hand side to reveal projects hidden from view. 

b) Use the Sort tool to sort by Name or sort by Date. 

c) Click on the Search icon, type your search criteria in the text box opens, and press Enter. 

Only projects that match the text you typed are displayed. Double-click on the project 
you require. 

3. Your project opens. 

2b

2a

1 2c



TP-00387-01 27

Projects

Importing Clips into a Project

To import files from local folders and network drives: 

STEPS

1. Make sure you have the Edit or Log tab selected. 

2. Click on the Local Files tab. 

3. Click on the Places tab to navigate to the drive and folder you require. 

4. If the frame rate is of a clip is not compatible with your project, it displays in red. You will not 
be able to import the clip into your project. 

5. Select the import method from the drop down list. The options are: 

• Create Link. Keeps the imported file in its original location and format so you can work 
with the file natively.

• Copy Local. Copies the file to the material drive without transcoding.

• Transcode. Converts the file into the chosen file type and compression option. 
See“Transcoding Tab” on page 125.

6. Click on a clip to select it for import to your project, or hold down the Shift or Ctrl key (Cmd 
key on Mac OS X) to select multiple clips, and: 

a) Click the Import button. 

b) Drag a single clip on to the clip viewer. 

7. On importing the clips, the Content Manager auto switches to the Bin or Filter containing 
the clips you imported. 

12

6b6

4

56a

3 7



28 TP-00387-01

Chapter 2: Getting Started

Closing a Project

To close a project, and return to the Project Browser, click the Exit button at 
the top left of the Project window. 

Deleting a Project

Deleting projects does not delete any media on your system. If you have imported files from the 
Local files tab and you delete a project, that media is deleted only if it was imported as ‘Transcode’ 
or ‘Copy Local’. If media was imported using ‘Create Link’, only the link is deleted, not the file. 

To delete a project: 

STEPS

1. In the Project Browser, click on the Cogs icon for the project you want to delete. 

2. From the menu that opens, click Delete. 

3. A message box opens, warning you that your project is about to be deleted and that you 
may lose data. 

4. Click Yes to confirm the deletion, or No to cancel the operation. 

3

1

2 4
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The Content Manager

The Content Manager is a panel in the Project Contents window that allows you to organize and 
manage all your Clips, Sequences, Bins and Searches in one location. 

You can select Bins from the Content List panel and filter results by selecting the appropriate filter. 
You can also add your own filters through the Search function. 

See the following topics: 

• "Browsing the Content Manager" on page 29

• "Using the Media Types Filter" on page 30

• "Bins" on page 31

Browsing the Content Manager

To browse the Content Manager: 

STEPS

1. Select a view by clicking on any item displayed under Filter or Bins in the Content List panel. 

2. Results display in the main window. 

3. Step backwards and forwards through Content List items by clicking the Browse buttons. 

4. Toggle between Tile and List views by clicking the View button. The Content Manager has 
two main display modes: 

• Tile View. Clips and Sequences display as thumbnails 

• List View. Clips and Sequences display in a list format with relevant metadata and a 
smaller thumbnail to aid identification 

1

3 4 2
Tile View

List View
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Using the Media Types Filter

The Content Manager uses a set of filters that allows you to organize your media by type, creation 
date, search criteria, and so on. You can also review your searches through the Content Manager 
Search Filter. See "Creating an Empty Bin" on page 31. 

To use the Media Types filters: 

STEPS

1. In the Content List panel, click on one of the following media types: 

• Clips 

• Subclips 

• Sequences 

• Everything 

• Recent 

2. The main panel displays the type of media you selected. 

3. If you selected Recent, the media displays in chronological order. 

4. To change the sort order of displayed items, click the column header you want to sort on. 
Clicking the same column header again reverses the displayed order. 

5. Use the horizontal scroll bar to show columns positioned beyond the viewing frame border. 

1

3

2 4

5
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Bins

Bins are used to organize and display your clips and sequences. You can move and copy clips to 
other bins, and change the way bins display clips. 

It is possible for a clip to be in more than one bin at the same time. You can use this feature to help 
organize your material more flexibly. However, seeing a clip in more than one place on the screen 
does not mean there is more than one copy of the clip on the hard disk. 

• "Creating an Empty Bin" on page 31

• "Copying Clips to Bins" on page 32

• "Creating a Bin with Clips" on page 32

For further information about Bins, refer to"Chapter 8: Bins and Groups" on page 127.

Creating an Empty Bin

To create a new empty bin: 

STEPS

1. Do one of the following: 

• Click on the Bins + icon in the Content List panel. 

• Select one or more clips, right-click and, from the menu that opens, select Bin Commands 
> Bin from selection. 

2. The new bin displays as an entry below ‘Bins’ in the Content List panel. 

3. Type the name you want for you Bin directly in to the text box. 

2

3

1a 1b 1b
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Copying Clips to Bins

To copy one or more clips to a bin: 

STEPS

1. Open the bin containing the clip or clips you want to copy. 

2. Click on the clip you wish to copy. To select multiple clips, hold down the Shift or Ctrl key, 
and then click on each clip you want to copy. 

Mac OS X users should use the Cmd key instead of the Ctrl key. 

3. The cursor changes to show you how many clips you have selected. 

4. Hold down the Ctrl key and drag the selected clips onto the intended destination. Mac OS X 
users should use the Cmd key instead of the Ctrl key. 

Creating a Bin with Clips

You can create an empty bin as described in "Creating an Empty Bin" on page 31, - or you can select 
the clips you want as you create a bin as described in the following procedure: 

STEPS

1. Select a filter in the Content Manager, e.g. Clip, Subclips, Sequences, and press Shift+Click or 
Ctrl+Click to select the clips you want. 

2. Right-click on one of the clips and, from the menu that opens, select Bin Commands > Make 
> Bin from selection. 

3. A bin called All #1 is created in the Contents List. If the bin already exists, the last number 
in the name is incremented. 
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Clips are created as a single continuous recording of picture and / or sound, and are stored as both 
a log file and a material file. The log file for a clip contains logging information such as the clip 
name, tape ID and timecode. The material file contains pictures or sound for the clip. 

You can move through your material in several additional ways. You can jump to a specific 
timecode, and you can insert Cue Markers and then jump to them. 

Recordings may need further preparation - for example, breaking down into subclips or shorter 
sections of a longer clip. 

See the following topics: 

• "Playing in Tile or List View" on page 34

• "Playback in a Viewer" on page 36

• "Managing Clips" on page 38

• "Selecting Timecode Labels" on page 42

• "Jumping to a Timecode" on page 43

• "Cue Markers" on page 44

• "Ranged Cue Markers" on page 47
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Playing in Tile or List View

When you import a file, it displays by default in one of the locations: 

• The ‘Recent’ tab of the Content Manager (default) 

• The ‘Search’ tab of the Content Manager (user option) 

• A bin of your choosing 

To play a clip, whether it is in Tile or List View: 

STEPS

1. Click anywhere in the picture area of the clip. 

2. The border changes to bright blue. 

3. Use the playback keyboard shortcuts. The default shortcuts are as follows: 

4. Hover your mouse over the tile or list item to reveal the scrub bar, then click on the red 
timeline marker to drag it backwards or forwards through the scrub bar.

1,2

4

Tile View

List View

4

Play/ Stop: Spacebar

Play (Backwards): j

Stop: k

Play (Forwards): l (Lower case ‘L’)

Shift+Play Holding down the Shift key while pressing the Play icon 
or shortcut key plays the media in reverse. 
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Playing in a Viewer

Playing in a Viewer

You can play clips in the Source Viewer on the right hand of the display. You can also watch clips 
in Full Screen mode. See the following topics:

• "Opening a Tile in a Viewer" on page 35

• "Playback in a Viewer" on page 36

• "Displaying Full Screen Video" on page 37

Opening a Tile in a Viewer

To open a tile in the viewer: 

STEPS

1. Make sure the Log tab is selected. 

2. Do one of the following:

a) Double-click on the tile or list item. 

b) Drag the tile or list item onto the viewer. 

3. The selected clip opens in the source viewer. 

4. The name of the clip displays at the top of the viewer.

5. The right and left ends of the scrub bar represent the start and end of the clip. 

6. To open another clip in the same Viewer, repeat step 2. 

1

5

4 32a 2b
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Playback in a Viewer

To play a clip in the viewer: 

STEPS

1. Open a clip in the viewer, as described in "Opening a Tile in a Viewer" 
on page 35.

2. Play the material by doing one of the following:

• Use the keyboard shortcuts for playback. 

• The playback controls on the viewer. 

3. To move through the material, click the red frame marker in the 
Indicator strip and drag it where you want.

4. To jump to a new point, click on the Indicator strip at the timecode position you want to 
jump to.

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 

23,4
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Playing in a Viewer

Displaying Full Screen Video

We recommend using two or more monitors so that the full screen display does not obscure the 
user interface. See "Using Multiple Monitors" on page 239. 

To display full screen video: 

STEPS

1. Do one of the following:  

• Press the Toggle Full Screen shortcut key. 

• Double-click on the image in the viewer. 

2. The media displays in full size on the monitor, complete with playback / marker controls and 
scrub bar. 

3. Move your mouse onto the full screen image to reveal the playback and marker controls, 
and scrub bar. 

4. Use the playback and marker controls to move through the clip and to add marks. 

5. Use the scrub bar to move backwards and forwards through the clip. 

6. To close full screen mode, press the Toggle Full Screen shortcut key 
again. 

7. You can also close the full screen mode by moving your mouse onto 
the full screen display and clicking the Exit Full Screen button. 

Default Shortcut: 

F12 = Toggle Full 
Screen 

2,3 7

4 5

Default Shortcut: 

F12 = Toggle Full 
Screen 
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Loading a Clip in Full Screen Mode

While in full screen mode, you can load a new clip from the currently selected bin. 

STEPS

1. Move your mouse to the top of the screen until a bin drop down menu opens. 

2. Use the scroll bar top right to view more clips in the bin. 

3. Click on the clip you want to load. 

4. The selected clip displays in full screen mode. 

 There is no method for switching to a different bin while in full screen mode. 

Managing Clips

See the following topics: 

• "Finding Information about Clips" on page 39

• "Renaming Clips" on page 40

• "Deleting Clips" on page 41

134

2
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Finding Information about Clips

Information about media is stored as metadata. To review a clip’s metadata: 

STEPS

1. Click on the Log tab to select it. 

2. Click on the Metadata tab to select it. 

3. Do one of the following: 

• Double-click the clip you want to review. 

• Drag and drop the clip you want onto the viewer. 

4. The clip loads into the viewer. 

5. The clip metadata displays below the viewer. 

6. Some metadata fields are read only, while others such as Scene, Take, and Comments can be 
edited by typing directly into the metadata field. 

Metadata can also be reviewed in the List View of Bins. 

3 4

5,6

1

2



40 TP-00387-01

Chapter 3: Clips

Viewing RED R3D Settings

If you are working with RED (R3D) files in Lightworks you can change the decode settings on a per 
clip basis.

STEPS

1. Click on the Log tab to select it

2. Set the RED decode quality from the drop down list.

3. Set the source for R3D decode settings from the Decode Using drop down box. If you select 
‘Clip Settings’, the following options are enabled:

a) Kelvin

b) Tint

c) Exposure

d) Saturation

e) Contrast

f) Brightness

g) DRX

h) ISO

i) DEB

j) Shadow

k) Detail

l) OLPFComp

m) Denoise

n) FLUT

o) Pixel Type

p) Color Science

q) Gamma Curve

Renaming Clips

Renaming a clip only changes the name of the clip in the database - it does not change the file name of 
the source file. 

To rename a clip:

STEPS

1. Follow steps 1 and 2 of "Finding Information about Clips" on page 39. 

2. Type the new name you want for your clip directly in to the Name text box. 
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Managing Clips

Deleting Clips

To delete a clip: 

STEPS

1. In the Content Manager, right-click on the clip or clips you want to remove and, from the 
menu that opens, select ‘Delete this clip’. 

2. A message displays warning that your clip is about to be deleted. 

3. Click to select the Clips or Video/audio box. The message box then displays information 
relevant to the action you have selected. 

4. Click Yes to delete the clip and/or associated media, or No to cancel the deletion. 



42 TP-00387-01

Chapter 3: Clips

Selecting Timecode Labels

The current timecode for selected clips display at the bottom of the source or sequence viewer. 
You can change the format of the displayed timecode format through the Labels menu. 

To change the timecode label a viewer displays: 

STEPS

1. Click the arrow to the right of the viewer timecode. 

2. The Labels dialog box opens. 

3. Select the timecode format you require. The options are: 

Alternatively, you can hover your mouse over the timecode label, using the mouse wheel to 
change the label.

4. The selected timecode format displays below the viewer. 

Primary T/C: Source timecode for the current frame (in blue). 

24 Frame Medium: Displays 24 Frame timecode if it exists, for example, on a telecined 
file that came from a 24 Frame origin. Allows 24 Frame EDLs to be 
generated from 25 / 30 Frame projects. 

Marked Duration: Duration between the mark and the current frame (shown in purple), 
or the duration between the start and the current frame if no mark 
exists.

Total Duration: Total length of the clip in the viewer (shown in red).

2,3

1
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Jumping to a Timecode

Jumping to a Timecode

Direct Timecode Entry

You can enter a direct timecode in to a source or sequence viewer as follows: 

STEPS

1. Click the Timecode text box in the label, type the timecode you want, starting from the 
left-most position, and press Enter. 

2. The viewer is cued at the timecode you entered in step 1. 

Timecode Tear-off

You can cue a source or sequence viewer to a timecode by doing the following:

STEPS

1. Create a Tear-off timecode as follows: 

a) Load a clip or sequence into a viewer, and stop at the timecode you want to tear-off. 

b) Hold down the left mouse button and drag the timecode label off the viewer. 

c) You can create as many tear-off labels as you want for a given clip or sequence. They do 
not have to contain different timecodes. 

2. To cue a viewer go to a specific timecode: 

a) Make sure the source or sequence viewer you want to cue is open. 

b) Click and drag the selected timecode over the timecode label. 

c) When the triangle on the tear-off’s bottom-left corner changes from yellow to green, 
release the left mouse button. 

d) The viewer is cued at the timecode of the selected tear-off. 

3. To cue any tile to go to a specific timecode: 

a) Make sure the tile you want cued is displayed in the Content Manager. 

b) Click and drag the selected timecode over the tile you want to cue. 

c) When the triangle on the tear-off’s bottom-left corner changes from yellow to green, 
release the left mouse button. 

d) The tile is cued at the timecode of the selected tear-off. 

4. Click the X button to remove an unused tear- off. 
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Cue Markers

Cue Markers let you mark points of interest in your material. You can use them later for reference 
points, you can move through material by jumping to them. Cue Markers are long-term markers 
and display as small triangles on the viewer timeline strip. 

See the following topics: 

• "Adding Cue Markers" on page 44

• "Jumping to Cue Markers" on page 45

• "Editing Cue Markers" on page 45

• "Exporting Cue Markers" on page 46

• "Removing Cue Markers" on page 47

You can use Cue Markers as references for subclips, see "Making Multiple Subclips from a Single 
Clip" on page 56. 

Adding Cue Markers

To add a Cue Marker: 

STEPS

1. Cue Markers are small triangular markers in the timeline which identify areas of interest in 
your clips. 

2. Move the timeline marker to the position in the clip you want. 

3. Click on the Cue Marker button below the viewer, or press the Cue 
Marker shortcut key. 

4. The Cue Marker displays as a small green triangle on the timeline. 

5. The Cue Marker dialog box opens below the viewer: 

a) Optional: Type a name for your Cue Marker in the Name field. 

b) Optional: Add a description for your Cue Marker in the 
Description field. 

c) Optional: Click on a color to set the color for your Cue Marker. 

6. To close the Cue Marker dialog box, click on the Close button (X), or click anywhere outside 
the dialog box. 

1

6

5b

2 3

5 5a

5c

Default Shortcuts: 

‘ = Cue Marker 
(apostrophe) 
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Cue Markers

Jumping to Cue Markers

Jump to a Cue Marker in the viewer by doing one of the following: 

STEPS

1. Click on the Cue Marker in the Cue Markers Panel (Log tab  only). 

2. Press the Cue Marker shortcut keys to move to the Cue Marker you require. 

3. Click on the Cue Marker in the Viewer scrub bar. 

Editing Cue Markers

To edit a Cue Marker: 

STEPS

1. Jump to the Cue Marker you want to edit as described in "Jumping to Cue Markers" on 
page 45. 

2. Change the color of a Cue Marker click on the color tab. When the color palette opens, click 
on the color you require. 

3. Rename a Cue Marker by typing directly into the Name text box, and then press Enter. 

4. Change the description for a Cue Marker by typing directly into its Description text box, and 
then press Enter. 

1

3

Default Shortcuts: 

a = Prev Cue Marker
s = Next Cue Marker

2 3 4
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Exporting Cue Markers

You can export Cue Markers to a Comma Separated Values (CSV) file as follows: 

STEPS

1. Right-click inside the Cue Marker Panel and, from the menu that opens, select ‘Export to text 
file’. 

2. The Export panel opens asking you where to save the file. 

3. Click Places to open the drop down list of folder locations to save your file. 

4. Type a name for your export file in the text box. 

5. Click OK. 

6. A message box opens, confirming the location where your export file was saved. 

1 43 2

6 5
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Ranged Cue Markers

Removing Cue Markers

To remove a Cue Marker: 

STEPS

1. Jump to the Cue Marker you want to remove as described in "Jumping to Cue Markers" on 
page 45. 

2. Do one of the following: 

a) Click on the Scrub bar marker. In the Cue Marker dialog box that opens, click on the 
Delete link. 

b) Click on the Cue Marker button below the scrub bar. You must park the timeline marker 
exactly on top of the cue marker. 

c) Click on the Cue Markers tab to open the panel, and click the Delete button see 
("Deleting Ranged Cue Markers" on page 49). 

Ranged Cue Markers

Ranged Cue Markers are Markers with a Start and End point for marking a region rather than an 
individual frame. See the following topics: 

• "Adding Ranged Cue Markers" on page 48

• "Deleting Ranged Cue Markers" on page 49

• "Updating Ranged Cue Markers" on page 49

‘A’

2a 2b
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Adding Ranged Cue Markers

To add a Ranged Cue Marker:

STEPS

1. Move the timeline marker to the position in the clip you want the Start point.

2. Click the In Point button or the press the Mark In shortcut key. 

3. Move the timeline marker to the position in the clip you want the End 
point.

4. Click on the Cue Marker button below the viewer, or press the Cue 
Marker shortcut key. 

5. The Ranged Cue Marker displays as a colored line between your Start 
and End Points.

6. The Marker dialog box opens below the viewer: 

a) Optional: Type a name for your Ranged Cue Marker in the Name field. 

b) Optional: Add a description for your Ranged Cue Marker in the Description field. 

c) Optional: Click on a color to set the color for your Ranged Cue Marker. 

7. To close the Marker dialog box, click on the Close button (X), or click anywhere outside the 
dialog box.

1

7

6b

2 4

6 6a

6c35

Default Shortcuts: 

i = Mark / Mark In 

‘ = Cue Marker 
(apostrophe) 
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Ranged Cue Markers

Deleting Ranged Cue Markers

To delete a Ranged Cue Marker: 

STEPS

1. Make sure the Cue Markers tab is selected. 

2. In the Cue Markers panel, click on the Ranged Cue Marker you want to delete. Shift+Click or 
Ctrl+Click to select multiple Cue Markers for deletion. 

3. Click the Delete button. 

4. A message box opens, asking you to confirm the deletion. 

5. Click Yes to delete, No to cancel the operation. 

Updating Ranged Cue Markers

You can edit and export Ranged Cue Markers the same way as you do with Cue Markers. See "Cue 
Markers" on page 44. 

4

2 1

53
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Chapter 4: Basic Editing

See the following topics: 

• "Marking a Section on a Clip" on page 51

• "Working with Subclips" on page 54

• "Working with Sequences" on page 57

• "Working with Syncs" on page 68

• "Live Editing" on page 70

• "Saving and Restoring" on page 73

Marking a Section on a Clip

You can define shorter sections of clips by creating marks in the timeline of the source clip. This 
technique is used mainly for creating subclips, inserting sections into Sequences and marking 
areas for audio-visual effects. See the following topics: 

• "Mark and Park" on page 52

• "Marking with In and Out Points" on page 53

• "Marking the Entire Clip" on page 53

• "Swapping In and Out Points" on page 54
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Mark and Park

The easiest way to mark a section from a longer clip is to use the Mark and Park function. You do 
this by marking the In point and using the current frame as the Out point. 

STEPS

1. Load your clip into the media viewer. 

2. Stop the media at the position in the timeline where you want the In 
Point. 

3. Click the In Point button. Alternatively, press the Mark In shortcut key. 

4. Move the current frame to where you want the section to end. 

5. The section between the mark and the current frame is now selected. 

1

42 35

Default Shortcuts:

i = Mark / Mark In 
o = Mark Out 
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Marking a Section on a Clip

Marking with In and Out Points

You can mark a clip with In and Out Points. Do the following: 

STEPS

1. Load your clip into the media viewer. 

2. Stop the media at the position in the timeline where you want the In Point. 

3. Click the In Point button. Alternatively, press the assigned shortcut 
key. 

4. Move the current frame to where you want the section to end. 

5. The section between the mark and the current frame is now selected. 

6. Press the Mark Out button on the viewer. Alternatively, press the 
assigned shortcut key. 

Marking the Entire Clip

You can select the entire clip by doing the following: 

STEPS

1. Press the shortcut key for selecting the entire clip. The default is ] 

2. The entire clip is selected. 

1

42 35 6

Default Shortcuts:

i = Mark / Mark In 
o = Mark Out 

Default Shortcut:

] = Select entire clip 
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Swapping In and Out Points

If you mark an In point and then want to jump to a different In point, you lose your Out mark. To 
swap In and Out points without losing the Out point: 

STEPS

1. Mark a section in the clip timeline using the Mark and Park procedure (see "Mark and Park" 
on page 52). 

2. Do one of the following: 

• Press the shortcut key assigned for Swap. 

• Hover your mouse over the In Point, then click and drag the In 
Point to the required position. 

3. The blue marker ‘A’ replaces the red current frame marker, and the red 
current frame marker ‘B’ replaces the blue marker. 

Although you have swapped the points around, the first marker is still the 
In point, that is, if you mark and park then press the Swap button, the In Point is now ‘park’, where 
previously it was ‘mark’. 

4. You can now change the position of the In point using the playback controls. 

Working with Subclips

A subclip is so named because it has no material of its own. When you play a subclip, it plays the 
pictures and sound from the material files of its original clip(s). 

See the following topics: 

• "Subclip Types" on page 55

• "Making Subclips" on page 55

• "Making Multiple Subclips from a Single Clip" on page 56

• "Deleting Subclips" on page 57

• "Undoing and Redoing Subclips" on page 57

Default Shortcut:

[ = Swap 
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Subclip Types

There are two types of subclips, which can be identified by the color of the flag displayed at the top 
left corner of sequence and tile views: 

Making Subclips

You can make a subclip from any clip that has been marked using one of the methods described in 
"Marking a Section on a Clip" on page 51. To make subclip: 

STEPS

1. Do one of the following: 

• Right-click inside the viewer and, from the menu that opens, select Make > Subclip. 

• Click the Add Subclip button on the viewer. 

• Create and use a keyboard shortcut for ‘Making a Subclip’. 

2. The subclip is added to the Content Manager. Subclips are identified by a 
blue flag in the top left corner of tiles, thumbnails, and viewers. 

Basic Subclip 

A section taken from a longer recording. 

Sync 

The result of syncing up separately 
digitized picture and sound clips. 

See "Working with Syncs" on page 68. 

Blue

Beige
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Making Multiple Subclips from a Single Clip

You can create multiple subclips from a single clip by adding Cue Markers to the timeline to mark 
In and Out points. The first Cue Marker represents the In point of the first subclip and the last Cue 
Marker the Out point of the final subclip. Any Cue Markers in between represent both the Out point 
of the preceding subclip and the In point of the following subclip. 

STEPS

1. Open the clip you want to edit in the source viewer. 

2. Clear any marks from the timeline, see "Removing Cue Markers" on page 47. 

3. Create a Cue Marker for the In point of the first subclip. See "Adding Cue Markers" on 
page 44.

4. Create a Cue Marker for the Out point of the first subclip. See "Adding Cue Markers" on 
page 44. 

5. Repeat Step 4 to create Out Points for the remaining subclips. 

6. Right-click inside the viewer and, from the menu that opens, select Make > Subclip.

7. A message box opens, asking you to confirm that you want to create multiple subclips. 

8. Click Yes.

9. New subclips are generated. These can be found in the Recent and Subclip Filters of the 
Content Manager.

7

1

4 2 8

6

3 5
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Deleting Subclips

If a subclip is deleted, the original clip (log and material) is not deleted. Deleting a subclip is like 
deleting a sequence, since a subclip does not actually have material of its own. 

If you delete the material for the original clip, any subclips that are referenced to them are also 
deleted. 

To delete a subclip: 

STEPS

1. Right-click on the subclip in the timeline and, from the menu that opens, select Source Clip 
> Delete. 

2. The subclip is deleted. No warning is given that the material is to be deleted. 

Undoing and Redoing Subclips

Undo and Redo have no effect when applied to a subclip. A sequence made of subclips behaves in 
the same way as a sequence made of clips. 

Working with Sequences

Sequences are a series of clips and subclips arranged in the required playing 
order. They can be identified by a red flag in the top corner (in Tile view) or in the 
Title bar of the Sequence viewer. 

In their basic form, sequences are a list of edit points without pictures, sound, or timecode, which 
refer to the logs of their constituent clips for labeling information such as timecode.

When you view the sequence, it plays the pictures and sound from the material files of the original 
clips. 

See the following topics: 

• "Creating Sequences" on page 58

• "Opening an Existing Sequence" on page 59

• "Using the Source Viewer" on page 60

• "Removing Material from a Sequence" on page 61

• "Replacing Material in a Sequence" on page 62

• "Deleting a Sequence" on page 66

• "Saving a Frame from a Sequence" on page 66

• "Making a Print" on page 67

• "Saving or Copying a Sequence" on page 67
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Creating Sequences

To create a new sequence: 

STEPS

1. Click on the Edit tab to reveal the Sequence view. New projects always open with a blank 
sequence. 

2. Click on the Project Contents tab. 

3. Click Clips in the Content Manager to display the available clips in your project. 

4. Select the first clip you want in your sequence and drag it onto the timeline. 

5. The clip’s video and audio display as separate tracks in the timeline. 

6. Move the timeline marker to where you want to add your next clip: 

• Press the Previous Cut shortcut key to move the marker left (to the 
end of the previous clip). 

• Press the Next Cut shortcut key to move the marker right (to the 
start of the next clip). 

7. Select the next clip you want in your sequence and drag it onto the timeline. 

8. The video and audio tracks of the clip display in the timeline. 

9. Repeat steps 6 and 7 to add further clips as required. 

63

75

42 1

Default Shortcuts:

a = Previous Cut
s = Next Cut
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Working with Sequences

Opening an Existing Sequence

To open an existing sequence: 

STEPS

1. Click on the Edit tab to reveal the Sequence view. 

2. Click on the Project Contents tab. 

3. Click on Sequences in the Content Manager to display the sequences in your project. 

4. Double-click on the Sequence you want to open. 

5. The Sequence displays in the sequence viewer. 

6. The video and audio tracks for each clip and subclip in your sequence display in the timeline. 

5

3

2 4 1

6



60 TP-00387-01

Chapter 4: Basic Editing

Using the Source Viewer

Sometimes when adding clips to a sequence, it is easier to view the source material inside a larger, 
dedicated viewer. This can be useful when you need to add In and Out Points before adding to the 
sequence. 

STEPS

1. Click the Edit tab and load the sequence you require into the viewer. 

2. Click on the Project Contents tab. 

3. Double-click on the source clip (in Tile or List view) you want to add to your sequence. 

4. The source material opens in the Source viewer. 

5. Make the adjustments you require to the source, for example marking In and Out Points. 

6. Drag and drop the source material in to the required position in the sequence. 

7. To close the source viewer, click the Close button (X) at the top right corner of the viewer. 

5

2 13 4 7

6
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Removing Material from a Sequence

When a clip is removed from the sequence timeline, you have the option to leave an empty black 
section where the clip used to reside, or move the remaining clips to fill the gap. 

STEPS

1. Click the Edit tab and load the sequence into the viewer. 

2. Position the timeline marker at the start of the cut you want to 
remove. Use the shortcut keys to jump left or right to the cut you want. 

3. Click the Mark In button, or press the Mark In shortcut key. 

4. A blue In point marker is placed on the scrub bar. 

5. Press the Next Cut shortcut key to position the timeline marker at the 
end of the cut you want to remove. 

6. Do one of the following: 

a) Click the Remove button to replace the clip with black. 

b) Click the Delete button to delete the clip and move the remaining clips to fill the gap. 

7. The marked section is removed from the sequence. 

32 5

1

7 4 6a 6b

Default Shortcuts:

a = Previous Cut
i = Mark In 
s = Next Cut
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Replacing Material in a Sequence

You can replace material in several ways. See the following topics: 

• "Open-Ended Replace from Tile" on page 62

• "Open-Ended Replace from Source Viewer" on page 63

• "Source Selection Replace" on page 64

• "Backward Replace from Out Point in Source" on page 65

• "Backward Replace from Out Point in Sequence" on page 65

Open-Ended Replace from Tile

In an open ended replace, the In point is the first frame of the clip: 

STEPS

1. In the Sequence viewer, place the timeline marker where you want to insert your media (In 
point).

Do not press the Mark button. The current frame is the In point. 

2. Select the clip tile you want to insert from the Project Contents 
window. Drag the mouse over the tile’s timeline to select where you 
want the inserted material to start. 

3. Make sure neither viewer has a blue mark in the timeline strip. If a blue 
mark is present, click the Unmark button on the Sequence viewer, or 
the default Unmark shortcut key on the Source view. 

4. Press the Replace shortcut key.

5. Everything from the source In point on replaces everything from the 
Sequence In point on.

12 37

Default Keys:

b = Replace 
p = Unmark
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Open-Ended Replace from Source Viewer

To perform an open-ended replace from a source viewer: 

STEPS

1. In the Sequence viewer place the timeline marker where you want to insert your media (In 
point).

Do not press the Mark button. The current frame is the In point. 

2. Double-click on the clip you want to insert from the Project Content 
window. 

3. The clip opens in a larger Source viewer. 

4. Drag the mouse over the clip’s timeline to select where you want the 
inserted material to start. 

5. Make sure neither viewer has a blue mark in the timeline strip. If a blue 
mark is present, click the Unmark button on the Sequence viewer, or 
the default Unmark key on the Source viewer. 

6. Press the Replace shortcut key.

7. Everything from the source In point on replaces everything from the 
Sequence In point on.

8. Click the Close button ‘X’ at the top right of the Source viewer to close it. 

14

32 8

7 5

Default Keys:

b = Replace 
p = Unmark
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Source Selection Replace

Use this method if you want to edit in a specific cutaway with a known start and end point.

STEPS

1. Position the timeline marker where you want to start the new material. 

2. Click the Mark In button, or press the Mark In shortcut key. 

3. Position the timeline marker where you want the new material to 
finish. There is no need to click the Mark Out button as the timeline 
marker is the Out Point (Mark and Park). 

4. Do one of the following: 

• Select the clip tile you want to insert from the Project Contents 
window, as described in step 2 of "Open-Ended Replace from Tile" 
on page 62. 

• Double-click on the clip you want to insert from the Project 
Content, as described in step 2 of "Open-Ended Replace from 
Source Viewer" on page 63. The clip opens in the Source viewer. 

5. Drag the mouse over the clip or clip tile’s timeline to select where you 
want the inserted material to start. 

6. Press the Replace shortcut key. 

7. The new material is inserted in to the Mark and Park section you 
marked earlier. 

1 35 2

4b

7

Default Shortcuts:

b = Replace 
i = Mark In 
p = Unmark 
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Backward Replace from Out Point in Source

If you know only the Out point for a replace in the source, you can use the Backward Replace 
method. 

STEPS

1. Make sure the Sequence view does not have a blue mark in the 
timeline strip. If a blue mark is present, click the Unmark button on the 
viewer, or press the Unmark shortcut key. 

2. Position the timeline marker where you want the start of the new 
material in the timeline. 

3. Click the Mark In button, or press the Mark In shortcut key. 

4. Position the timeline marker where you want the new material to 
finish. There is no need to click the Mark Out button as the timeline 
marker is the Out Point (Mark and Park). 

5. Select the clip you want to insert from the Project Contents window. 
Drag the mouse over the clip’s timeline to select where you want the 
inserted material to finish. 

6. Press the Backtime shortcut key. 

7. The selected section in the timeline is replaced by material from the 
source and is trimmed to the same duration. The start point of the source material is 
calculated backwards from the source viewer end (Out) point. 

Backward Replace from Out Point in Sequence

If you know only the Out point for a Replace in the Sequence timeline, you can use the Backward 
Replace method. 

STEPS

1. Select the clip you want to insert from the Project Contents window and mark the section 
you want using the Mark and Park method: 

a) Drag the mouse over the clip’s timeline to select where you want the inserted material 
to finish, and press the Mark Out shortcut key. 

b) Press the Reverse Playback shortcut key and stop at the required In Point by pressing 
the Pause shortcut key. 

2. Make sure the Sequence view does not have a blue mark in the timeline strip. If a blue mark 
is present, click the Unmark button on the viewer, or press the Unmark shortcut key. 

3. Position the Sequence timeline marker where you want the inserted material to finish. This 
is the Out point. 

Default Shortcuts:

\ = Backtime 
i = Mark In 
o = Mark Out 
p = Unmark

Default Shortcuts:

\ = Backtime 
i = Mark / Mark In 
j = Reverse Pb 
k = Pause
o = Mark Out
p = Unmark 
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4. Press the Backtime shortcut key. 

5. The selected section in the timeline is replaced by material from the source and is trimmed 
to the same duration. The start point of the source viewer material is calculated backwards 
from the Sequence viewer end (Out) point.

Deleting a Sequence

To delete a sequence: 

STEPS

1. If the Content Manager, right-click on the sequence you want to delete and, from the menu 
that opens, click ‘Delete this sequence’. 

2. A message box displays, asking you to confirm removal of your project. 

3. Click on Yes to confirm the deletion, or click No to cancel it. 

Saving a Frame from a Sequence

Frames are saved in the Portable Network Graphic (PNG) format. To save the current frame from a 
sequence: 

STEPS

1. Pause the Sequence viewer at the frame you want. 

2. Press the keystroke you assigned for ‘Save current frame’. 

3. The still frame is saved as a Portable Network Graphic (PNG) file on your local drive. 

4. The file manager for your workstation opens in the folder where your image was saved. 
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Making a Print

Prints are copies of sequences which display as one continuous clip, with no apparent 
joins between cuts. Prints behave like clips during editing and behave like sequences 
during project management processes. Prints are identified by a yellow flag in the top left 
corner of viewers, lists and tiles. 

When working with prints, do not delete any of the original clips, as each print refers to the log of 
its original clip for labels such as timecode. 

STEPS

1. Do one of the following: 

• Right-click on a tile, or in the timeline and, from the menu that opens, select Sequence 
Commands > Make > Print. 

• Right-click on the viewer and, from the menu that opens, select Make > Print.

2. If you marked a section of the timeline, a message displays asking you if you want to print 
the entire sequence or just the marked section: 

• Click All to make a print of the entire sequence.

• Click ‘Marked section’ to print only the section marked on the timeline.

3. The print displays in the Print and Recent Filters of the Content Manager. If this is the first 
print you created, a Print filter is created in the Content Manager. 

Saving or Copying a Sequence

Normally you do not have to save anything as every change or modification you make in 
Lightworks is saved automatically. If you want to save your sequence, you can make a copy of it, 
and continue working on the original sequence. 

STEPS

1. Do one of the following: 

• Right-click on a tile or in the timeline and, from the menu that opens, select Sequence 
Commands > Make > Copy. 

• Right-click on the viewer and, from the menu that opens, select Make > Copy.

2. If you marked a section of the timeline, a message displays asking you if you want to make 
a copy of the entire sequence or just the marked section: 

• Click All to make a copy of the entire sequence.

• Click ‘Marked section’ to copy only the section marked on the timeline.

3. A copy of the sequence is created, with the text ‘(copy)’ appended to the name in the title 
bar. 

4. The copy displays in the Content Manager as a separate sequence. 
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Working with Syncs

Syncs are subclips that are the result of syncing up separately digitized picture and 
sound clips. They are identified by a beige flag displayed in the top left corner of tiles, 
thumbnails and viewers.

You can also add ranged markers to a sequence and create syncs from them. See “Marking with In 
and Out Points” on page 53.

See the following topics: 

• "Making a Sync" on page 68

• "Synchronizing Audio and Video Tracks" on page 69

Making a Sync

You can create a Sync from any sequence, selecting or deselecting any tracks as required.

STEPS

1. Load the sequence containing the material you want to synchronize. See "Opening an 
Existing Sequence" on page 59. 

2. Disable the video (V) or audio (A) tracks you do not want in your Sync. (Click on the track 
labels to alternately disable or enable them.) 

3. Mark and Park the region you want for your first Sync. see "Mark and Park" on page 52. 

4. Create a Ranged Cue Marker, see "Adding Ranged Cue Markers" on page 48. 

5. Repeat steps 3 and 4 to add further Syncs. 

6. Right click inside the Sequence viewer and, from the menu that opens, select Make > Sync. 

7. You can select the following options from the dialog box that opens:

a) Whole sequence - make a sequence from the whole section, ignoring the ranged 
markers.

b) Marked section - make a sequence from the Mark/Park region on the sequence.

c) Cue markers - make a sequence from the cue markers. These can be a mix of markers 
and ranged markers.

d) V1 segments - make a sequence from the segments on the video track.

e) A1 segments - make a sequence from the segments on the audio tracks.

2a
2b
2c
2d
2e

8
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8. Click Do It.

9. The generated media can be found in the Sync and Recent Filters of the Content Manager. 

Synchronizing Audio and Video Tracks

You can synchronize separate audio and video tracks together based on their labels selection. This 
feature can be useful in workflows where the sound is imported separately from the video, and 
they need to be synced together. You can choose to display the result as a Sync or as a Sequence. 

To sync video and audio tracks: 

STEPS

1. Open a bin of material that you wish to sync together. 

2. Right-click inside the bin and, from the menu that opens, select Bin Commands > Make > 
Sync(s). 

3. The Synchroniser dialog box opens. 

4. Select the sync option from the ‘Synchronise by’ drop down list.

5. If you selected Clip labels or Playout timecodes from the previous step, make the settings for 
the following options: 

a) Type the value (in frames) to offset the sound by in to the text box. 

b) Tick the Match date box if you want to match by date.

6. Set the options you require for ‘Result starts at’ and ‘Result ends at’.

If the picture and audio clips do not share common start and / or end times, but overlap, you 
may want some way to determine how the start and end points are treated in the sync. You 
can elect to: 

• have a black slug at the start and / or end of each track 

• Omit the blank sections and create a sync that starts later and / or finishes earlier 

7. From the ‘Produce result as’ drop down list, select Sequence or Sync. 

8. Click ‘Do It’. 

9. A Syncing Bin progress box opens, showing the attempted sync. 

3

6

4

7
8

9

5
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10. When the process is complete, the synced media displays in the Syncs tab of the 
Content Manager. Syncs are identified by a beige flag in the top left corner in 
Tile views, and in the title bar when they are displayed in the clip viewer. 

11. If the media cannot be synced, the syncing process fails, and a message displays, confirming 
that no media was synced. Try changing the criteria and start again. 

Live Editing

Lightworks can play four or more separate sources together in real time, called concurrent playing. 
If you lock them together as a Multicam Bin, you can cut between the sources as they run to create 
an edit on-the-fly, in a similar way to live vision mixing. Lightworks calls this Live Editing. 

See the following topics: 

• "Starting a Live Edit" on page 71

• "Stopping a Live Edit" on page 72

• "Using the Lightworks Console Cut Buttons" on page 72

• "Viewing a Sequence Created by Live Editing" on page 73

• "Multicam Bins" on page 139

Preparing for Live Editing

The Live Editing feature makes editing from multiple sources quick and simple. It is worth taking 
some time to consider how you can best use this feature to produce the desired end result. This 
depends on the nature of the production, how many camera sources it uses, and how it is divided 
up. 

The Sequence viewer on the graphics screen does not play during Live Editing. It either 
remains empty or displays the first frame of the clip you cut to. 

Shortcut cut key assignments are available for Live Editing. You need to create these 
manually and name them in sequence from ‘Live cut source 1’ to ‘Live cut source 8’. 

You can assign shortcut keys for Live Edit Cuts. See "Chapter 15: System and User Settings" on 
page 233. 

If you use Historic Lightworks, you can open separate viewers for each camera source. See "Live 
Editing with Multiple Viewers" on page 273. 
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Starting a Live Edit

To start a Live Edit session: 

STEPS

1. Click on the Edit tab. 

2. Click on the Project tab and then click on the Multicam bin you want to live edit. 

3. Enable ‘Auto sync with record edit’. 

4. Right-click inside the Multicam bin. From the menu that opens: 

a) Select ‘Live-editing enabled’ > Yes. 

b) Select ‘Concurrent players’ > Yes. 

5. Click one of the tiles or source viewers to give it playback focus. 

The audio from the selected source is monitored throughout the Live Editing session, irrespective 
of cuts you make. You do not hear audio edits as they are made, only when you play back the 
completed edit. 

6. Start playing the sources by doing one of the following: 

• Press the Play shortcut key (lowercase ‘L’ or spacebar) 

• Press the Lightworks Console Play button 

7. At the source In point you want for the first clip, do one of the following: 

• Click on the source tile to select it 

• Press the Live Cut shortcut key you assigned to the source 

• Press the assigned Cut buttons on the Lightworks Console - see "Using the Lightworks 
Console Cut Buttons" on page 72

6

4a

4b

3

5 1

2 9
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8. Repeat the step 7 to add more clips to your edit. 

9. Clips display in the Sequence timeline as you select them. 

Stopping a Live Edit

To stop a Live Edit: 

STEPS

• Press the Stop shortcut key (‘K’ or the spacebar) 

• Press the Lightworks Console Stop button 

Using the Lightworks Console Cut Buttons

When you are Live Editing, the top four console buttons — Mark, Unmark, Swap, or Cue - operate 
as live cutting controls for each of the first four clips: 

When Live Editing is enabled and the viewers are playing, pressing one of the Console Cut buttons 
cuts to the source it represents and adds it to the edit at that point, in a similar way to live vision 
mixing.

When Live Editing is enabled, you cannot use the top four buttons for their normal editing 
functions, even when the sources are not playing. During Live Editing, you can see each cut on the 
video output the Sequence viewer is assigned to. 

STEPS

1. Start playing the sources as described in step 6 of "Starting a Live Edit" on page 71. 

2. At the source In point you want, press the console Cut button for the first clip. The edit is 
created. 

To make the selected clip the first one in an edit, press its console Cut button as soon as it plays. 

3. Press a Console Cut button again. The clip is added to the edit as an open-ended replace. 

4. Cut to any other source by pressing its console Cut button. 

MARK UNMARK SWAP CUE

JUMP 
BACK

JUMP 
F’WARD

TRIM 
LEFT

TRIM 
RIGHT

USER 1

USER 3

USER 2

USER 4

REPLACE REMOVE
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Viewing a Sequence Created by Live Editing

To view a sequence you created by Live Editing: 

STEPS

1. Stop Live Editing as described in ‘"Stopping a Live Edit" on page 72’. 

2. Make sure the ‘Auto sync with record edit’ button is enabled.

3. Start playing the sequence. 

4. The sequence plays back in real time. 

5. When you stop playback, the synced items stop at the correct section. 

Saving and Restoring

In addition to regular backups, Lightworks makes automatic backups called Milestones. Milestone 
backups are created for sequences after every ten edit operations (mods). 

You do not have to save anything as every change or modification you make in the application is 
saved automatically. If you want to save a sequence, you actually make a copy which is saved at 
that point in time and displays in the Content Manager. See "Saving or Copying a Sequence" on 
page 67. 

Anything you delete is backed up: if you delete a clip, subclip or sequence, it is saved automatically 
into the Milestones folder. Therefore, any mistakes you make can be undone. 

See the following topics:

• "Automatic Milestone Backups" on page 73

• "Restoring Sequences from a Milestone Backup" on page 74

Automatic Milestone Backups

By default, the last ten milestones are stored for a sequence. The milestones are stored in 
Lightworks\Projects\Pxxxxxxx\Milestones\Exxxxx\. 

The milestones are numbered from zero (0) through nine (9), but are not necessarily in 
chronological order. 
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Restoring Sequences from a Milestone Backup

Any shot or sequence that is deleted in Lightworks is automatically backed up to the Milestones 
folder. You can recover deleted shots and sequences from this folder. In case of an emergency, you 
can restore sequences from an automatic backup. 

To restore sequences from an automatic backup: 

STEPS

1. In the Projects Browser, click on the Cogs icon at the top right corner of the project 
containing the sequence you want to restore. 

2. From the menu that opens, select ‘Restore item(s) from backup’. 

3. A dialog box opens, displaying all the sequences that are backed up. Recent backups display 
in white, Milestones display in red. 

4. Click on the sequence you want to restore. If you want to restore multiple sequences, hold 
down the Shift or Ctrl key while selecting sequences with the mouse. 

5. Click the Restore button. 

6. If one or more original sequences still exist in your project, a warning message displays. Click 
Yes if you want to overwrite the sequence(s) in your project, or No if you do not want to 
overwrite it. 

7. A confirmation message displays when sequences are restored. 

2

65

41 3 7



TP-00387-01 75

Saving and Restoring

Recovering Deleted Items

Any shot or sequence that is deleted in Lightworks is automatically backed up to the Milestones 
folder. You can recover deleted shots and sequences from this folder. In case of an emergency, you 
can restore sequences from an automatic backup. 

To restore sequences from an automatic backup: 

STEPS

1. In the Projects Browser, click on the Cogs icon at the top right corner of the project 
containing the item(s) you want to restore. 

2. From the menu that opens, select ‘Restore item(s) from backups..’ 

3. A dialog box opens, displaying all the items that are deleted.

4. Click the Deleted tab on the restore panel.

5. Click on the item(s) you want to restore. If you want to restore multiple item(s), hold down 
the Shift or Ctrl key while selecting sequences with the mouse. 

6. Click the Restore button. 

7. A confirmation message displays when item(s) are restored. 

2

6

41 3 75
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Chapter 5: Timeline Editing

This chapter covers the functions that can be performed using the timeline in the Edit tab. See the 
following topics: 

• "Navigating the Timeline" on page 77

• "Timeline Settings" on page 79

• "Working with Tracks on the Timeline" on page 84

• "Trimming Cuts" on page 86

• "Undo and Redo" on page 95

• "Using Drag-and-Drop" on page 96

• "Changing Playback Speed" on page 100

Navigating the Timeline

See the following topics: 

• "Main Features" on page 77

• "Locking the Timeline Marker" on page 78

• "Enabling Audio while Scrubbing" on page 79

• “Using the Reveal function” on page 79

Main Features

The main features of the timeline are: 

STEPS

1. The left end of a track represents the beginning of the clip or sequence and the right end 
represents the end. 

2. The Zoom In (+) and Zoom Out (-) buttons are used to zoom in and out on the timeline. The 
Timeline ruler ‘A’ rescales according to the level of zoom selected. 

32 ‘A’ 4



78 TP-00387-01

Chapter 5: Timeline Editing

When the Timeline is completely zoomed out, or when it is close to the start or end of a sequence, 
the current frame marker behaves in the normal way. 

3. The Timeline marker indicates the position of the current frame on each track. 

4. Do not click directly on cuts unless you want to unjoin the associated clips for trimming. See 
"Trimming Cuts" on page 86. 

5. From within the timeline you can select multiple segments to move, delete, and copy. Select 
segments on the timeline by right-mouse clicking, with subsequent mouse clicks you can 
select other segments. To deselect, click anywhere in the timeline that is not a segment. For 
example:

Locking the Timeline Marker

You can lock the timeline marker in a fixed position. When the sequence is played, the timeline 
marker stays fixed, rather like the heads on a synchronizer or flatbed editor, and the tracks scroll 
past it. 

STEPS

1. Press and hold the Alt key, and then click on the timeline marker. 

2. Release the Alt key. The timeline marker locks in the current position. 

3. The timeline marker changes color to violet. 

4. When the sequence is played, the timeline marker stays fixed while the timecode ruler and 
tracks scroll in the reverse direction.

When the Timeline is completely zoomed out, or when it is close to the start or end of a sequence, 
the current frame marker behaves in the normal way.

5. To unlock the timeline marker, press and hold the Alt key, and then click on the timeline 
marker. 

6. The timeline marker color changes back to red. Release the Alt key.
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Timeline Settings

Enabling Audio while Scrubbing

This feature is not available when the timeline marker is locked. 

To listen to audio while scrubbing through a sequence: 

STEPS

1. Hold down the SHIFT key, and then click on the timeline marker, keeping the mouse button 
held down.  

2. The timeline marker changes color to light blue. 

3. With the mouse button held down, drag the timeline marker backwards and forwards 
through the sequence. The audio tracks can be heard as you scrub through the sequence. 

4. Release the mouse button to disable audio playback. 

5. The timeline marker color changes back to red. Release the SHIFT button. 

Using the Reveal function

STEPS

1. Right-click in one of the Timeline tracks.

2. From the menu that opens, click on one of the following options: 

a) Reveal - Bins to reveal any bins in the project that contain the clip you right clicked.

b) Reveal - Media Files to open the file explorer for the operating system, revealing where 
the file is actually stored.

Timeline Settings

See the following topics: 

• "Displaying Text on the Timeline" on page 80

• "Changing Clip Colors" on page 81

• "Setting Trim Behavior Options" on page 82

• "Setting Mouse Actions" on page 83
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To change how the timeline displays audio waveforms, see "Audio Waveforms and Levels" on 
page 104. 

To disable or enable keyframes, see "Disabling and Enabling Keyframes" on page 192. 

Displaying Text on the Timeline

You can change the text shown in the timeline for each clip. You can choose from a list of various 
clip metadata, including Name, Scene, Media Format, and so on. Not all metadata items display on 
all tracks, for example: 

• The Track source metadata (A1, A2, A3, etc.) only displays on audio tracks 

• The Media Format metadata only displays on video tracks 

• Metadata that requires input from users (Scene, Take, etc.) display blank if no values have been 
entered 

You can display up to three metadata items from list items Segment text, Segment text (2) and 
Segment text (3). 

STEPS

1. Right-click in one of the Timeline tracks. 

2. From the menu that opens, click on Timeline Commands > Settings. 

3. The Timeline Settings panel opens, with the Appearance tab selected. 

4. Click on the Segment text drop down list. 

5. From the list that opens, select the parameter you want to display in the timeline. If you do 
not want to display anything, select None. A blue marker indicates your selection. 

6. Optional: Repeat steps 4 and 5 for the Segment text (2) and Segment text (3) drop down lists. 
Selections from Segments (2) and (3) are appended to any Segmented text item you 
selected in step 4 the first time. 

7. Track texts are applied immediately. 

5

2

43
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Changing Clip Colors

To change the colors of the tracks in the timeline: 

STEPS

1. Right-click in one of the Timeline tracks. 

2. From the menu that opens, click on Timeline Commands > Settings. 

3. The Timeline Settings panel opens, with the Appearance tab selected. 

4. From the ‘Clip colors based on’ drop down list, select one of the following items: 

5. Track colors are applied immediately. 

5

2

43

Cookie: Colors are determined by a unique Lightworks identifier for a clip 
known as a ‘Cookie’. 

Reel: Colors are determined by Reel ID 

Picture Format: Colors are determined by video clip format 

Track: Colors depend on track type - whether it is a video or audio track 
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Setting Trim Behavior Options

EditShare does not recommend disabling Safe Trimming. 

The Behaviors tab enables you to enable or disable media boundaries for clips (Safe trimming) 
although this is not recommended. 

STEPS

1. Right-click in one of the Timeline tracks. 

2. From the menu that opens, click on Timeline Commands > Settings. 

3. When the Timeline Settings panel opens, click on the Behavior tab. 

4. Disable Safe Trimming by unticking the box. 

2

43
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Timeline Settings

Setting Mouse Actions

The Actions tab allows you to define which mouse button is used for certain timeline editing 
functions. 

STEPS

1. Right-click in the timeline area.

2. From the menu that opens, click on Timeline Commands > Settings. 

3. When the Timeline Settings panel opens, click on the Actions tab. 

4. For each mouse action, select which mouse button you want to assign from the drop down 
list. The options are Left, Center, Right or None. Select None if you do not want your mouse 
to control the selected action. 

5. For each mouse action, select which key you want to assign in conjunction with the selected 
mouse button. The choices from the drop down list are None, Shift, Ctrl and Alt. 

6. If two or more mouse actions share the same mouse button and key assignment, the 
duplicate assignments display in red. Change the duplicate assignments as required, or 
delete the ones you do not need. 

7. To reset Mouse Actions to their default values, click on the Reset switch. 

2

43

5

7

6
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Working with Tracks on the Timeline

You can work with tracks on the Timeline in several ways. See the following topics: 

• "Selecting Tracks on the Timeline" on page 84

• "Grouping Tracks in an Edit" on page 85

• "About Editing Grouped Tracks" on page 85

• "Ungrouping Tracks" on page 85

Selecting Tracks on the Timeline

Each displayed track has a Track Selector button. When the track is enabled, the button is blue - 
when it is disabled, it is grey. 

Any sequences using keyboard shortcuts affect only enabled tracks. A track does not have to be 
enabled for you to edit it in the Timeline. 

All tracks are enabled by default. 

STEPS

1. Click on a Track Selector button to disable the corresponding track. Click again to re-enable 
the track. 

2. Right-click on the Track Selector button: 

1,2

2a 2b

a) From the menu that opens, click Select. 

b) From the sub menu that opens, select one of the following options: 

All: Enable all tracks 

None: Disable all tracks 

Invert: Enable all disabled tracks and vice-versa 

This track only: Enable only the track for the button you clicked 

All except this track: Enable all tracks except the one for the button you 
clicked 
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Working with Tracks on the Timeline

Grouping Tracks in an Edit

Grouping tracks in the Timeline affects only how they are displayed and Edited in the 
Timeline. They are still treated as separate tracks for audio routing or video output. 

Audio tracks are grouped by default on all new Edits. 

You can group tracks together so that any Edits or trims affect all tracks in a group. This is 
particularly useful when you Edit stereo pairs. You can group audio tracks together or group video 
tracks together in an Edit. However, you cannot group audio and video tracks together. 

To group tracks: 

STEPS

1. Right-click on a track in the timeline and, from the menu that opens, select Sequence 
Commands > Tracks > Group video, or select Sequence Commands > Tracks > Group Audio. 

2. The Group Video Tracks or Group Audio Tracks dialog box opens, depending on your 
selection in step 1. 

3. Select Audio tracks or Video tracks from the list. 

4. Click OK. The grouped tracks display as a single track in the Timeline. 

About Editing Grouped Tracks

You can select cuts on individual tracks for trimming by Shift-clicking them. Edits apply to all 
grouped tracks that are currently selected.

Ungrouping Tracks

To ungroup audio or video tracks: 

STEPS

1. Right-click on a track in the timeline and, from the menu that opens, select Sequence 
Commands > Tracks > Ungroup. 

2. The Ungroup Tracks dialog box opens.

3. Select the Audio tracks or Video tracks from the list and then click OK. 

4. Click the group you want to ungroup, and then click OK.

5. The tracks display individually in the Timeline
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Trimming Cuts

The main purpose of the Timeline is to make adjustments to the timing of cuts. You do this by 
opening or disconnecting the cuts so when you play the edit, you can move the position of the cut. 
When you are done, you rejoin the cuts. You can unjoin a cut in three places: 

• On the outgoing (left) side

• On the incoming (right) side

• In the middle (moving a cut)

You should select the cuts on every track of the edit to avoid tracks sliding out of sync. After you 
select cuts and nudge or play them backwards or forwards, the clip is extended or shortened. The 
rest of the edit is pushed along or pulled back, but is otherwise unaffected. See the following 
topics: 

• "Auto Track Sync" on page 86

• "Trimview" on page 87

• "Trimming an Outgoing Clip" on page 88

• "Trimming an Incoming Clip" on page 89

• "Moving a Cut" on page 90

• "Slipping a Clip" on page 91

• "Sliding a Clip" on page 92

• "Reopening Edits" on page 93

• "Trimming by Numbers" on page 94

• "Trimming Shortcut Keys" on page 93

• "Previewing Trims" on page 94

• "Closing a Trim" on page 95

Auto Track Sync

Auto Track Sync allows the video and audio tracks of a clip to be picked up and moved around the 
timeline as one clip. It also allows all tracks contained in a clip to be trimmed simultaneously. By 
default, all trims use Auto Track Sync. 

To turn off Auto Track Sync: 

STEPS

1. Right-click in the Timeline and, from the menu that opens, select Timeline Commands > 
Auto Track Sync. 

2. Tick the Auto Track Sync box to enable Auto Track Sync, or untick to disable it. 

3. Holding down the Alt key while trimming, temporarily overrides the current Auto Track Sync 
setting, thus avoiding the need to keep changing the setting. 
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Trimming Cuts

Trimview

Trimming controls the way that picture trims display on screen. 

STEPS

1. Hover your mouse close to the cut you want to trim. When white brackets display, click the 
left mouse button. 

2. Alternatively, right-click on the clip you want to trim, and from the menu that opens, select 
Segment Commands > {Trim Option} - where {Trim Option} can be: 

• "Trimming an Outgoing Clip" on page 88

• "Trimming an Incoming Clip" on page 89

• "Moving a Cut" on page 90

• "Slipping a Clip" on page 91

• "Sliding a Clip" on page 92

- then press the shortcut key for the Trim option you require. 

3. Brackets display in yellow on all tracks next to the cut, denoting that 
the clip has been disconnected from the cut. 

4. The viewer changes to Trimview mode, displaying frames from the 
clips on both sides of the cut. 

5. Click the Preview button under the Viewer to play the two clips in 
sequence. 

6. To exit Trim View, click the Close button. 

6

5

4

1, 3 2

Default Shortcuts:

e = Trim Out 
t = Slide 
w = Trim In 
y = Slip
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Trimming an Outgoing Clip

Trimming an outgoing clip changes the end point of the outgoing clip (A) while the start of the 
incoming clip remains unchanged (B). 

To trim an outgoing clip: 

STEPS

1. Do one of the following: 

a) Hover your mouse close to the end of the clip you want to trim. When white brackets 
display, click the left mouse button. 

b) Right-click on the clip you want to trim, and from the menu that opens, select Segment 
Commands > Trim Out. 

c) Press the Trim Out shortcut key. 

2. Brackets display in yellow on tracks, denoting that the clip has been 
disconnected from the cut. 

3. Shorten or lengthen the outgoing clip by doing one of the following: 

a) moving the mouse left or right while holding down the left 
mouse button. Release the left mouse button to set the cut point. 

b) pressing the Play button on the viewer. Press Shift+Play to play in 
reverse. 

c) pressing the play or reverse playback shortcut keys. 

Timeline A

Unchanged Clip

B

Trimmed Clip

1a, 2 1b

Default Shortcuts:

e = Trim Out
j = Reverse Play 
k = Pause 
l = Play 
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Trimming an Incoming Clip

Trimming an incoming clip changes the start point of the incoming clip (B) while the end of the 
outgoing clip (A) remains unchanged. 

To trim an incoming clip: 

STEPS

1. Do one of the following: 

a) Hover your mouse close to the start of the clip you want to trim. When white brackets 
display, click the left mouse button. 

b) Right-click on the clip you want to trim, and from the menu that opens, select Segment 
Commands > Trim In. 

c) Press the Trim In shortcut key. 

2. Brackets display in yellow on the clip, denoting that it has been 
disconnected from the cut. 

3. Shorten or lengthen the incoming clip by doing one of the following: 

a) moving the mouse left or right while holding down the left 
mouse button. Release the left mouse button to set the cut point. 

b) pressing the Play button on the viewer. Press Shift+Play to play in 
reverse. 

c) pressing the play or reverse playback shortcut keys. 

Timeline A

Unchanged Clip

B

Trimmed Clip

1a,21b

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 
w = Trim In 
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Moving a Cut

 Moving a cut is where both the end of the incoming clip and the start of the outgoing clip move. 

To move a cut: 

STEPS

1. Do one of the following: 

a) Hover your mouse close to the cut you want to trim. When 
white brackets display on both sides of the cut, click the left 
mouse button. 

b) Position the timeline marker over the cut you want to trim, and then press the ‘Move 
Cut’ shortcut key. 

2. Brackets display in yellow on both sides of the cut. 

3. Shorten or lengthen both sides of the cut by doing one of the 
following: 

a) moving the mouse left or right while holding down the left 
mouse button. Release the left mouse button to set the cut point. 

b) pressing the Play button on the viewer. Press Shift+Play to play in 
reverse. 

c) pressing the play or reverse playback shortcut keys. 

Timeline A

Trimmed Clip

B

Trimmed Clip

1a,2

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 
u = Move Cut 
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Slipping a Clip

Slipping a clip is where you change the In and the Out points of a clip (B) at the same time. 

To slip a clip: 

STEPS

1. Do one of the following: 

a) Hover your mouse over the start of the clip (B) you want to trim. When white brackets 
display, click the left mouse button. Repeat for the end of the clip (B). 

b) Right-click on the clip you want to slip, and from the menu that opens, select Segment 
Commands > Slip. 

c) Press the Slip shortcut key. 

2. Brackets display in yellow at both ends of the clip. 

3. Change the start and end frames of the clip by doing one of the 
following: 

a) moving the mouse left or right while holding down the left 
mouse button. Release the left mouse button to set the cut point. 

b) pressing the Play button on the viewer. Press Shift+Play to play in 
reverse. 

c) pressing the play or reverse playback shortcut keys. 

Timeline C

Unchanged Clip

A

Trimmed Clip

B

Unchanged Clip

B, 2 1bA, 2

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 
y = Slip 
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Sliding a Clip

Sliding a clip is where you move the entire clip (B) up or down the edit timeline. 

To slide a clip: 

STEPS

1. Do one of the following: 

a) Hover your mouse over the end of the first clip (A) you want to trim. When white 
brackets display, click the left mouse button. Repeat for the start of the last clip (C). 

b) Right-click on the clip you want to slide, and from the menu that opens, select Segment 
Commands > Slide. 

c) Press the Slide shortcut key. 

2. Brackets display in yellow at the end of the first clip and the beginning 
of the last clip. 

3. Shorten or lengthen the outgoing clip by doing one of the following: 

a) moving the mouse left or right while holding down the left 
mouse button. Release the left mouse button to set the cut point. 

b) pressing the Play button on the viewer. Press Shift+Play to play in 
reverse 

c) pressing the play or reverse playback shortcut keys. 

Timeline C

Sliding Clip

A

Sliding Clip

B

Unchanged Clip

A, 2 1b1 B, 2

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 
t= Slide 
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Reopening Edits

You can reopen edits at the points where they were last opened for trimming. We recommend 
practising selecting cuts in the Timeline before you start serious work to familiarize yourself with 
what happens when you click in different places. 

Trimming Shortcut Keys

You can use the following default keyboard shortcuts for trimming: 

Note that the shortcut keys (q, w, e, r, t, y and u) are the first row of lowercase letters on a QWERTY 
keyboard. 

Replacing a Clip with Black or Audio Spacing

This is the process of removing part of a clip and replacing it with black in the edit timeline. The rest 
of the edit is unaffected, only the clip where you unjoined is changed. 

STEPS

1. (Option) Group the tracks to maintain sync.

2. While holding down the Ctrl key, click and drag on the cut you wish to add black to. 

Trimming Function Shortcut Key

Open tail of previous clip q

Open head of current clip (Trim In) w

Open tail of current clip (Trim Out) e

Open head of next clip r

Slip a Clip y

Slide a Clip t

Move Cut u
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Trimming by Numbers

You can type the number of frames by which you want to trim a cut using the numeric keypad on 
your keyboard.

STEPS

1. To trim forwards:

a) Unjoin the cut using one of the trim functions. 

b) Press the plus sign (+) on the numeric keypad. 

c) The Nudge Forwards dialog box opens. 

d) Type the number of frames you want to trim, and then 
press Do It. 

2. To trim backwards:

a) Unjoin the cut using one of the trim functions. 

b) Press the minus sign (-) on the numeric keypad. 

c) The Nudge Backwards dialog box opens. 

d) Type the number of frames you want to trim, and then 
press Do It. 

Previewing Trims

You can preview trims by playing or shuttling through cuts while they are unjoined. You can then 
make adjustments quickly without needing to join the trim. 

To preview trims: 

STEPS

1. Do one of the following:  

• In trim mode, click the Preview button on the viewer. 

• Press the Preview shortcut key. 

2. The current frame marker jumps back by the preview preroll time. The 
edit immediately plays forward across the unjoined cut and continues 
to play. 

3. To stop the preview, click the Stop button or Stop shortcut key. 

4. The current frame marker returns to its original position. This is usually 
at the first trim point. 

5. Adjust the trim using the following controls: 

• Playback controls on the viewer 

• The shortcut keys on the keyboard 

Default Shortcuts:

k = Stop 

Alt+
Space = Preview 
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Undo and Redo

Closing a Trim

To close a trim: 

STEPS

1. Do one of the following: 

• Click the Close button on the viewer 

• Click the cut point that you clicked initially to perform the trim 

• Press the Join shortcut key. 

2. The cut is joined and the Trim viewer reverts to the normal view. 

Undo and Redo

Undo the Last Action

If you undo a trim, pressing Unjoin does not unjoin the cut. Undo returns the edit to its 
previous state, which has no information about future trims made to it. 

You can undo your last action as follows: 

STEPS

1. Click the Undo button under the sequence viewer. 

Alternatively click the shortcut button for Undo
You can also use Ctrl+Z (Windows) or Cmd+Z (Mac OS X).

2. The last action is reversed. 

3. You can undo up to the last 20 operations. 

Redoing Changes

If you click Undo too many times, you can click the Redo button to step back to the previous Undo 
operation. 

STEPS

1. Click the Redo button. 

Alternatively click the shortcut button for Redo
You can also use Ctrl+Y (Windows) or Cmd+Shift+Z (Mac 
OS X). 

2. The last undo action is reversed. 

3. You can redo up to the last 20 operations. 

Default Shortcuts:

Tab = Join 

1 Default Shortcuts:

`= Undo 

1 Default Shortcuts:

Alt+`= Redo 
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Using Drag-and-Drop

You can copy or move a section of video or audio to a new position in the Timeline using 
drag-and-drop. You can also insert or replace clips in the Timeline.

See the following topics:

• "Moving with Drag-and-Drop" on page 97

• "Copying with Drag-and-Drop" on page 98

• "Inserting or Replacing Clips" on page 99

Segment Drag Region Size

The segment drag region size is the area in which the mouse cursor changes to allow you to pick 
up and move a clip on the sequence timeline. We recommend that you try different settings here 
to see what better suits your editing style. By default the drag and drop region is the majority of 
the clip region leaving a short section at the start and end of the clip to enable trimming. 

To set the segment drag region size:

STEPS

1. Right-click in the timeline area.

2. Select Settings.. from the menu. The Timeline Settings menu displays.

3. Click the Behavior tab.

4. Select the drag region size from the drop down list.

For example: The 33% setting splits the clip into three sections meaning only the middle 
third of the clip section is available to pick up that segment, the start/end end 33% are used 
for left clicking the beginning or end of a clip to enable trimming.

5. If you select Disabled you are prevented from dragging and dropping clips in the sequence 
timeline.

32

4
5
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Using Drag-and-Drop

Moving with Drag-and-Drop

This procedure assumes you have assigned the left mouse button and Shift key for Segment 
delete. See "Setting Mouse Actions" on page 83 to change the assignment. 

To move a section of video or audio to a new position in the Timeline using drag-and-drop:

STEPS

1. Select the section you want using the Mark and Park method. If you want to move a single 
clip, you do not need to use Mark and Park.

2. Place the mouse in the middle of the section you wish to move. A 
double-ended arrow displays to the right of the mouse pointer. 

3. Do one of the following: 

• Click and drag the clip to the required point in the timeline - a gap is left where the clip 
previously resided. 

• While holding down the Shift key (or the key you assigned for segment delete), click and 
drag the clip to the required point in the timeline - no gap is left behind. 

4. Before dropping the selected material onto the timeline, do one of the following: 

• To overwrite material (Replace), release the Shift key before releasing the mouse button. 

• To insert the section without overwriting material in the timeline, hold down the Shift 
key. 

The tooltip next to the mouse pointer displays ‘Insert’ when the Shift key is held down, and 
‘Replace’ when it is released. 

5. When the mouse button is released, the section snaps to the nearest cut point, mark, cue or 
timeline marker. 

2 3 1
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Copying with Drag-and-Drop

This procedure assumes you have assigned the left mouse button and Ctrl key for Segment 
Copy. See "Setting Mouse Actions" on page 83 to change the assignment. 

To copy a section of video or audio to a new position in the Timeline using drag-and-drop:

STEPS

1. Select the section you want using the Mark and Park method. If you want to move a single 
clip, you do not need to use Mark and Park.

2. Place the mouse in the middle of the section you wish to move. A 
double-ended arrow displays to the right of the mouse pointer. 

3. Press the Ctrl key (Windows) or the Cmd key (Mac OS X) and then drag the 
clip to the required point in the timeline. 

4. Before dropping the selected material onto the timeline, do one of the following: 

• To overwrite material (Replace), release the Shift key before releasing the mouse button. 

• To insert the section without overwriting material in the timeline, hold down the Shift 
key. 

The tooltip next to the mouse pointer displays ‘Insert’ when the Shift key is held down, and 
‘Replace’ when it is released. 

5. When the mouse button is released, the section snaps to the nearest cut point, mark, cue or 
timeline marker. 

2 3 1
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Inserting or Replacing Clips

You can insert or replace clips in to the Timeline using drag-and-drop.

STEPS

1. In the Content Manager, open a bin containing your clips, in tile or list view. 

2. Select the clip you want to add to the timeline by clicking on it, and dragging it to where you 
want on your edit timeline. To select more than one clip, while holding down the Shift key, 
click on the clips you want to select. 

You can also select multiple clips by Ctrl+clicking (Windows) or Cmd+clicking (Mac OS X). 

3. Dropping the selected clip on the timeline replaces the existing clip with your new selection. 

4. Holding down the Shift key before dropping on the timeline inserts or adds the clips to the 
existing list of clips. The text on the dragged clip(s) change from Replace to Insert.

2

1
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Changing Playback Speed

To change the playback speed of a clip or segment: 

STEPS

1. In the timeline view, right-click on the clip you want to change and, from the menu that 
opens, select Segment commands > Speed. 

2. The Change Segment Speed dialog box opens. 

3. Select the required playback speed from the Speed drop down list, - or type the playback 
speed you require directly into the box: 

4. Select the playback method as follows: 

If you select a speed higher than 100% and do not select Resize, you will have blank video and 
audio at one or both ends of the clip. 

5. Click Do It. 

Resize: Change the clip duration to be in proportion with the change in 
playback speed 

Keep start frame: Keep the existing clip length, starting with the first frame 

Keep end frame: Keep the existing clip length, but end with the last frame 

Keep current frame: Keep existing clip length, and centre on the current frame - make 
sure you move the timeline marker to the required position 
beforehand 

5

1

3

4

2
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Chapter 6: Audio

This chapter describes the basics of audio editing and audio mixing. 

Sound clips and sequences in Lightworks behave similarly to their video counterparts. They display 
in viewers and in the Content Manager in the same way, except that the video area contains the 
label ‘Sound’ on a black background. You can also create subclips from them and mark them for 
editing. 

The Sound clips also contains a Timeline feature that allows you to select/deselect tracks, changing 
track audio, and showing the clips waveform. For example:

See the following topics:

• "Adding and Removing Audio Tracks" on page 101

• "Audio Waveforms and Levels" on page 104

• "Replacing Sound with Atmos" on page 110

• "Voice Overs" on page 111

• "Using the Audio Mixer" on page 112

• "Audio Effects" on page 112

Most of the editing procedures in this Chapter use the Mark and Park function. See "Mark and Park" 
on page 52. 

Adding and Removing Audio Tracks

You can add audio tracks to your sequence, for voice overs or to add instrumental tracks to music 
projects. You can have up to eight audio tracks. See the following topics: 

• "Adding Audio Tracks" on page 102

• "Renaming Tracks" on page 102
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• "Deleting Tracks" on page 103

• "Turning Audio Tracks Off and On" on page 103

Adding Audio Tracks

To add new audio tracks: 

STEPS

1. Right-click on the audio track ahead of where you want insert the new track. 

2. From the menu that opens, select Sequence Commands > Tracks > Add audio. 

3. The new track is inserted ahead of the audio track you selected, and the track numbers are 
renumbered in sequence: A1, A2, A3, and so on. 

Renaming Tracks

You can change the name displayed against each track in the Timeline window. Note that the track 
labels in the sequence viewer remain unchanged. To rename tracks: 

STEPS

1. Right-click on the track you want to rename. 

2. From the menu that opens, click on Track Commands > Rename. 

3. A dialog box opens asking you to enter a new name. 

4. Type a new name in the text box and then click Do It. 

5. The track displays its new name. 



TP-00387-01 103

Adding and Removing Audio Tracks

Deleting Tracks

To delete tracks: 

STEPS

1. Do one of the following: 

a) Right-click in the Sequence viewer. 

b) Right-click in the Timeline for your sequence. 

c) Right-click on the Sequence tile in the Content Manager bin. 

2. From the menu that opens, select Delete tracks. 

3. A dialog box opens, displaying a list of tracks to delete. 

4. Click to select or deselect the tracks you want to delete and click the OK button. 

NOTE: Multiple V tracks can be deleted at one time. To do so, right-click on the timeline, 
select Tracks->Delete and select each track to be deleted. When finished, click OK.

5. The tracks are deleted. No warning message displays after you click OK. 

Turning Audio Tracks Off and On

It is often useful to mute audio tracks that could be distracting, for example all voice over tracks 
except for the audience’s native language. 

STEPS

1. Click on the track number to mute audio from that track. The track number dims to indicate 
that audio is muted. 

2. Click again on the same track to re-enable audio from that track. The track number brightens 
to indicate that audio is enabled again. 
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Audio Waveforms and Levels

See the following topics: 

• "Displaying Audio Waveforms" on page 104

• "Displaying Audio Levels" on page 105

• "Boosting or Lowering Audio Levels" on page 106

• "Using Nodes to Set Audio Levels" on page 107

• "Removing Audio Nodes" on page 107

• "Deleting Selected Audio Nodes" on page 108

• "Deleting Individual Audio Nodes" on page 108

• "Copying Audio Nodes" on page 108

• "Audio Fade-In and Fade-Out" on page 109

Displaying Audio Waveforms

You can hide or display audio waveforms on audio tracks, and you can choose Pre or Post Level 
waveforms. Pre Levels refer to the original level of the audio clips, and Post Levels refer to 
adjustments you subsequently make to audio levels.

STEPS

1. Make sure the Edit or Audio tab is selected. 

2. Right-click on any track in the timeline and, from the menu that opens, select Timeline 
Commands > Settings. 

3. The Timeline Settings dialog box opens 
with the Appearance tab selected. 

4. Under Audio > Show waveforms, select 
No, Pre Levels or Post Levels from the drop 
down list. 

5. If you selected Pre Levels or Post Levels, 
Audio waveforms display in the audio 
tracks. 

6. To see the waveforms more clearly, resize the Timeline. See "Navigating the Timeline" on 
page 77.
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Audio Waveforms and Levels

Displaying Audio Levels

To display audio levels on the timeline: 

STEPS

1. Make sure the Edit or Audio tab is selected. 

2. Right-click on any track in the timeline and, from the menu that opens, select Timeline 
Commands > Settings. 

3. The Timeline Settings dialog box opens on the Appearance tab. 

4. Under Audio, click on the ‘Show levels’ box to toggle the audio levels off and on. 

Changing the Waveform Contrast

To change the contrast of the timeline waveforms: 

STEPS

1. Make sure the Edit or Audio tab is selected. 

2. Right-click on any track in the timeline and, from the menu that opens, select Timeline 
Commands > Settings. 

3. The Timeline Settings dialog box opens on the Appearance tab. 

4. Select the contrast level you require from the Waveform contrast drop down list. The 
options are Low, Medium and High. 
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Boosting or Lowering Audio Levels

Audio levels settings apply only to individual clips within a sequence, or cut point to cut point. 

From the Audio Tab

To boost or lower the audio level of a clip from the Audio tab: 

STEPS

1. Select the Audio tab and then park the timeline marker anywhere in the clip. 

2. Hover your mouse over the white level marker on the audio track you want to adjust until 
the cursor displays a double-ended arrow. 

3. Hold down the left mouse button and drag the line up or down until you achieve the 
required audio level. 

4. Repeat steps 2 and 3 for each audio track you wish to adjust. 

From the Edit Tab

To boost or lower the audio level of a clip from the Edit tab: 

STEPS

1. Select the Edit tab and then park the timeline marker anywhere in the clip. 

2. Press and hold the Shift key, and then hover your mouse over the white level marker on the 
audio track you want to adjust until the cursor displays a double-ended arrow. 

3. Continuing holding the Shift key down, and then hold down the left mouse button and drag 
the line up or down until you achieve the required audio level. 

4. Repeat steps 2 and 3 for each audio track you wish to adjust. 
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Using Nodes to Set Audio Levels

You can set nodes on the audio tracks and use them to adjust audio levels as described below: 

STEPS

1. Make sure the Audio tab is selected. 

2. On the selected audio track, click on the white line at the point where you want the change 
in audio level to start. This creates the first node, which displays as a square when you hover 
the mouse over the white line. 

3. On the selected audio track, click on the white line at the point where you want the change 
in audio level to finish. This creates the second node. 

4. Press and hold down the mouse button over the second node, and drag it up or down to the 
required audio level. 

5. Repeat steps 3 and 4 to add more node points and to set their audio levels. 

Removing Audio Nodes

To remove all audio nodes from a clip: 

STEPS

1. Right-click on the track containing the nodes you want to remove and, from the menu that 
opens, select one of the following items: 

• Reset segment levels (removes nodes from the current segment only) 

• Reset track levels (resets all segments for the audio track you clicked) 

2. All nodes from the clip are removed. 

53,42
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Deleting Selected Audio Nodes

To delete selected audio nodes from a clip: 

STEPS

1. Hold down the left mouse key and trace a rectangle around the node or nodes you want to 
delete. 

2. The nodes you select are highlighted in yellow. 

3. Right-click in the track and, from the menu that opens, select ‘Delete selected levels’. 

4. The selected nodes are removed. 

Deleting Individual Audio Nodes

To delete individual audio nodes, hold down the Ctrl key and then click on the node you want to 
delete. 

Copying Audio Nodes

You can make changes to the audio levels made in one clip and apply the settings to another clip 
by copying the nodes. Audio levels are copied over while the audio content remains unchanged in 
the target clip. 

STEPS

1. While holding down the Alt key, click and hold the middle of the clip that contains the audio 
levels you want to copy. 

2. Drag the section to the destination clip in the sequence timeline. 

3. Release the mouse button.
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Audio Fade-In and Fade-Out

You can easily create an audio fade in or fade out on a clip, as follows: 

STEPS

1. Make sure the Audio tab is selected. 

2. In the timeline, position your mouse over the audio track you want to apply a fade in or fade 
out. 

3. A small triangle displays at the top left (A) and top right (B) corners of the track. 

4. Do one of the following: 

• To create a fade in, position your mouse over the triangle at the top left corner of the 
audio clip (A) until the cursor changes to a double-ended arrow. 

• To create a fade out, position your mouse over the triangle at the top right corner of the 
audio clip (B) until the cursor changes to a double-ended arrow. 

5. Hold down the left mouse button and drag the triangle out to the desired position. 

6. The duration of the fade, in frame displays in the track, while the slope of the triangle 
indicates the rate of audio fade in or fade out. 

7. Release the mouse button when you have the required duration of fade in or fade out. 

2

46
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Replacing Sound with Atmos

Atmos, also known as atmosphere, ambience, background or wild track, is a soundtrack for a given 
location or space. Atmos can consist of music, wind, rain, running water, traffic, machinery, and so 
on. It is recorded separately, without dialog, and inserted later into the main soundtrack of your 
project. 

STEPS

1. Make sure the Edit tab is selected. 

2. In the sequence timeline, deselect the video track, and select only the audio tracks you want 
to change. 

3. Select a section in the sequence viewer using the Mark and Park method.

4. Select the Atmos audio file you require from the Content Manager, and Mark and Park the 
section you want to use (A). 

5. Do one of the following: 

a) Press the Replace shortcut key. 

b) Drag and drop the Atmos tile onto the sequence timeline. 

6. The marked tracks are replaced by the audio from the Atmos file. 

14

62 3

A

5b

Default Shortcut:

b = Replace 
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Voice Overs

To add a voice over to your media: 

STEPS

1. Make sure the Edit tab is selected. 

2. Load the sequence into the viewer. 

3. Move the timeline marker to where you want to start your voice over. 

You may find it helpful to mute the sound on all of the audio tracks when making your recording. 

4. Click on the Microphone icon below the viewer to open the Record dialog box. If you have 
not already done so, set the recording options described below: 

a) Select the microphone you want to use from the Device drop down list. Select from 
Internal Microphone, External Microphone or another device displayed in the list. 

Lightworks can only ‘see’ the microphone if it is enabled at the operating system level. 

b) Sound levels display on a bar below the Device drop down list. 

c) Select the track you want to record your voice over from the Track drop down list. 

d) Select the pre-roll time for your voice over by selecting a value from the Preroll drop 
down list, or type a value of your own. 

5. Click Record. The Record button changes to the End button. 

6. When the status label changes to ‘Recording’, start speaking into the microphone. 

7. To stop recording, click the End button. 

8. Your Voice Over displays in the designated track. 

1

3

4

4c
4d

4a
4b
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Using the Audio Mixer

The Audio Mixer allows you to control and mix all the audio tracks in your project. You can set the 
levels and spatial positioning of each track, left and right. The mixer panel can be found on the 
Audio tab. 

STEPS

1. Click on the Audio tab. The Audio Mixer displays in the top right area of the desktop. 

2. The Audio Mixer displays all the available audio tracks, each with its own sound level 
indicator.

3. The track for the mixer output is labeled LR. 

4. To adjust the sound level for each track, slide the adjacent (blue) volume control up or down. 
Click on the track to reset it to its default level. 

5. To adjust the overall sound level, slide the LR volume control up or down. Click on the LR 
track to reset it to its default level. 

6. Click the track indicator to alternatively enable or disable its output. 

7. To monitor the output of one track and mute the other tracks, click on the Solo button for 
the track you want to hear. The Solo button illuminates to indicate that it is selected. 

8. To change the spatial positioning of the track right or left, drag the balance control pointer 
clockwise or counter-clockwise.

Audio Effects

You can apply various audio filters and crossfades to whole clips and marked sections in your 
sequences. See the following topics: 

• "Applying an Effect to a Marked Section or Current Clip" on page 113

• "Applying an Effect to Matching Clips" on page 114

8

6

4
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• "Audio Effect Options" on page 115

Applying an Effect to a Marked Section or Current Clip

To apply an audio effect to a marked section or the current clip: 

STEPS

1. Load the sequence containing the clip you want to edit. Make sure the Audio tab is selected. 

2. If you want to edit only part of a clip or sequence, highlight the section using Mark and Park. 

3. Click the Add Effect (+) tab. 

4. Select the effect you want to apply from the Components list. 

5. Click the Settings tab, and configure the settings you want (see separate headed sections for 
instructions relevant to the effect). 

6. If you marked a section for editing in step 2, select ‘Marked Section’ from the Target region 
drop down list - otherwise select ‘Current Clip’. 

7. Click the Apply effect button. 

8. The chosen effect is applied to the targeted media. 

15
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Applying an Effect to Matching Clips

To apply an audio effect to matching clips: 

STEPS

1. Carry out steps 1, 3 and 4 of "Applying an Effect to a Marked Section or Current Clip" on 
page 113. 

2. Select Matching Clips from the Target region drop down list. 

3. The Criteria field is revealed below the Target region drop list. 

4. Build the criteria that matches the clips you require from the Attribute, Match and Pattern 
drop down lists and text box. For example Name equals ‘Gendarmes’ or Comments contains 
‘outdoor’. 

The Attribute drop down list contains items such as Name, Take, Scene and Comments. The 
Match method drop down list provides equals, contains, doesn’t equal, doesn’t contain and 
doesn’t contain as matching options, while the Pattern text box accepts any combination of 
alphanumeric characters. 
For example, you could select Name equals ‘Gendarmes’ or Comments contains ‘outdoor’. 

5. Click the Apply effect button. 

6. The chosen effect is applied to the targeted media. 
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Audio Effect Options

The following audio effects are available: 

• "Crossfade" on page 115

• "Equalisation (EQ)" on page 115

• "EQ Presets" on page 116

Crossfade

Provides a smooth transition from the outgoing audio tracks to the incoming audio tracks. There 
are no settings for this transition. 

Equalisation (EQ)

An effect control which boosts or reduces the energy of audio over prescribed frequency ranges. 
Each EQ effect has five sub-bands which can be used in combination to create complex 
equalization profiles. 

STEPS

1. The effect opens on the Band 1 tab. 

2. Select the filter you require from the Filter Type drop down list. The options are: 

• Low pass 

• High pass 

• Band pass (constant skirt)

• Band pass (constant peak) 

• Notch 

• Peaking EQ 

• Low shelf 

• High shelf 

3. A profile of the selected filter displays in the graph area. 

3

2
4
5
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4. Type the frequency threshold (e.g. cut-off frequency for low/high pass filters, centre 
frequency for notch filters) in the Frequency (Hz) text box. Alternatively, drag the orange bar 
under the box to the setting you require. 

Alternatively, drag the orange bar under the box to the setting you require. 

5. Type the required Q-Factor value in the corresponding text box. Q-Factor is the quality or 
‘sharpness’ of the filter envelope. 

Alternatively, drag the orange bar under the box to the setting you require. 

6. Optional: Repeat steps 2 to 5 to apply further filters as required in the Band 2, Band 3, Band 4 
and Band 5 tabs. 

7. You can review the difference a filter makes to the overall effect by toggling OFF or ON the 
LED for each Band. 

EQ Presets

The following presets are available to deploy common equalization requirements such as 
removing mains hum, wind noise and so on. Each preset resides in Band 1, leaving the other bands 
empty, allowing you to set further effects. 

50Hz Hum Removal: A notch filter to remove 50Hz mains hum 

60Hz Hum Removal: A notch filter to remove 60Hz mains hum

Treble Boost: Lift or boost signals above 2 kHz 

Increase VO Presence: Gentle lift to mid band frequencies to give extra presence 

LoFi EQ: Simulates a small speaker 

Loudness Curve: Lifts low end and high end frequencies with a slight drop mid band. 
Gives the listener better audible spectrum response at low volume 
levels. 

Low End Booster: Boosts bass frequencies 

Mic Wind Reduction: High pass filter to help reduce wind noise in field recordings 

Mix Master EQ: Global master mix EQ 

Plosive Reduction (PQ): Reduce low frequency effect of popping B’s and P’s in vocal 
recordings 

Reduce Female 
Sibilance (5-7 kHz): 

Controls S’ and T’s. Boost first then sweep EQ frequency from 5-7 kHz 
to identify a problem sibilance in a female vocal recording. Then use 
‘Cut’ to preference. 

Reduce Male Sibilance 
(4-6 kHz): 

Controls S’ and T’s. Boost first then sweep EQ frequency from 4-6 kHz 
to identify a problem sibilance in a male vocal recording. Then use 
‘Cut’ to preference. 

Reduce Soundtrack 
Presence: 

Apply a slight reduction in the vocal audio range to help a voice over 
to sit better over a musical soundtrack. 
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The Project Card allows you to review details about your project, and to change various output 
settings. See the following topics: 

• "Opening the Project Card" on page 117

• "Details Tab" on page 118

• "Video Tab" on page 118

• "Audio Tab" on page 122

• "Film Tab" on page 123

• "Media Tab" on page 124

• "Tasks Tab" on page 126

Opening the Project Card

To review or update information in your project: 

STEPS

1. Click on the Project tab at the top left corner of the screen. 

2. The Project Card opens. The following tabs display across the top of the card: 

• Details 

• Video 

• Audio 

• Film 

• Media 

• Tasks 

3. You can review and update the Project tabs as described in the following sections. 

4. To close the Project Card, click on the Project tab again, or click outside the Card. 
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Details Tab

The Details tab displays general information about your project. 

STEPS

1. If the Details panel is not visible, click on the Details tab to reveal it. 

2. To rename the Project, double-click on the Project name, type the new project name directly 
into the text box, and press Enter. The new name displays at the top of the Project Card and 
in the associated project tile of the Project Browser. 

3. The Frame rate field displays the frame rate for the project and is read-only. 

4. The Creation date field displays the date and time when the project was created. The field is 
read-only. 

5. The location of the Project folder displays below the Creation date. Click on the location 
name to open a file manager in the Project folder. 

6. You can type notes about the Project directly into the Notes text box. 

Video Tab

You can scale video in real time to play out video in any compatible format, regardless of the source 
material format. You can also select letterboxing and aspect ratio options. 

Video options are divided into tabs. See the following topics: 

• "Output Tab" on page 119

• "Letterbox Tab" on page 120

• "R3D Tab" on page 121

• "Stereo 3D Tab" on page 122
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Output Tab

Use the Output tab to review and update general playback options: 

STEPS

1. If the Output tab is not visible, click on the Video tab to reveal it. 

2. Select the format you require from the Format drop down list.

3. The Full SD Frames field is active only when the Output format field is set to a standard 
definition format. 

4. Select a GPU precision level, 8-bit or 10-bit. 

5. Select the required media quality: 

6. Select the Aspect Ratio Conversions you require, according to the following table: 

Source material with 4:3 and 16:9 aspect ratios can be contained together in the 
same project or sequence. 

Windows: 8-bit, 16-bit, 16-bit Floating point or 32-bit Floating point

Mac and Linux: 8-bit, 16-bit or 16-bit Floating point

Automatic: Sets the playback quality for you 

Highest available: Select when viewing full screen or in a large viewer 

Lowest available: Selects proxy files when available. Choose this option if playback is 
jerky or not smooth. See "Creating Proxies" on page 144. 

Aspect Ratio Conversion Full Frame Full Zoom Partial Zoom

Displaying narrow as wide
(4:3 as 16:9):

The entire image displays 
with black bands on each 
side.

The 4:3 image is enlarged so it fills the 
width of the 16:9 frame. The top and 
bottom of the 4:3 image are cut off. 

A medium 
enlargement.Displaying wide as narrow

(16:9 as 4:3):
The entire image displays 
with letterboxing at top 
and bottom.

The 16:9 image is enlarged so it fills 
the height of the 4:3 frame. The left 
and right sides of the 16:9 image are 
cut off.
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7. Select whether to apply VFR correction. VFR stands for Variable Frame Rate, a video 
compression technique that allows the frame rate of footage to change during playback. 
Most phones and cameras shoot variable frame rate media. You can choose from the 
following options:

• Yes - Corrects video and audio synchronisation for variable frame rate media, for example 
footage recorded from mobile phones.

• No - Does not apply any correction for variable frame rate media - audio will be out of 
sync with video, for example can be used for time lapse footage where the audio sync is 
not required.

8. Select whether to load the default Look Up Table (LUT) or load your own LUT into a location 
when using Color Effects. 

• To enable the LUT, click the LED icon. The LED changes to green to indicate that it is 
enabled. 

• To disable the LUT, click the LED icon again. 

For more information about LUTs, see "Look Up Tables" on page 184. 

Letterbox Tab

Use the Letterbox function to crop your video material: 

STEPS

1. Open the clip, subclip or Edit you want to crop. 

2. With the Video tab open, click on Letterbox. 

3. The currently selected clip displays in the main viewer in the Letterbox panel.

4. Type the number of pixels you wish to crop from the top and bottom of the video frame into 
the Top and Bottom text boxes respectively. 
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5. You can also set the number of pixels to crop by clicking and dragging the mouse from the 
top or bottom video frame.

6. Alternatively, click on ‘From picture’. The picture cropping is calculated for you. 

7. Click on Apply to apply the changes you made. 

8. Tick the Affect output monitor(s) box to apply cropping to connected monitors. 

R3D Tab

To set R3D options for your project, see "RED (R3D)" on page 212. 

BRaw Tab

To set Blackmagic decode options, select the BRaw tab and set the Decode Quality resolution and 
Decode Using source. 
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Stereo 3D Tab

These output settings are available only to users of Lightworks Pro. 

To set stereoscopic 3D playback options: 

STEPS

1. With the Video tab open, click on Stereo 3D. 

2. For each field (Viewers, Tiles, and Output monitors) select the option you require from the 
drop down list. 

3. If your system has an SDI I/O card, a ‘Left-Right Dual Stream’ option displays in the drop 
down list for Output Monitors. When selected, it sends the left eye output through SDI 1 and 
the right eye output through SDI 2. 

Audio Tab

The Audio tab allows you to select the soft-cut duration and audio monitor delay. 

STEPS

1. The audio rate displays as a read-only option. 
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2. Select a soft-cut duration (clip audio cross fade) in milliseconds (ms) from the drop down list. 

3. Select a delay for the audio monitor from the drop down list. This delays the audio so that it 
plays in sync with the hardware output monitor. You will require a hardware I/O device from 
Matrox, AJA or Blackmagic to use this feature. 

Film Tab

You can select film options for projects you have set to 24 fps. 

STEPS

1. Open Project Settings and click the Film tab. 

2. Select the camera film speed from the drop down list. 

3. The ‘Play viewers at’ option is usually set according on project creation. You can change it 
for 24fps projects only.

4. Select the sync film-set audio from the drop down list. 
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Media Tab

You can specify any media location for your Material and Sound folders, and you can add as many 
media locations as you want. This is very useful if you need to manage media on a project per 
project basis. 

Creating, Selecting and Removing Import Destinations

To create, select or remove an import destination, see "Import Destination" on page 203 for further 
information. 

Checking Free Disk Space

To check the amount of free space on your media location and drives: 

STEPS

1. Open a Project Card, and click on the Media tab. 

2. Click on the Locations tab if it is not already selected. 

3. The amount of free disk space for each media location displays in the Locations tab.
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Proxies Tab

To review or update proxy creation settings: 

STEPS

1. With the Media tab open, click on Proxies. 

2. Select the compression method from the Compression drop down list. 

3. Select the resolution from the Size drop down list. 

4. Select the media quality from the Quality drop down list. 

Transcoding Tab

To review or update the transcoding on import settings, complete the following steps. For more 
information about transcoding, see “Importing Clips into a Project” on page 27.

STEPS

1. With the Media tab open, click on Transcoding. 

2. For SD Media: 

a) Select the required file format from the File type drop down list. 

b) Select the compression method from the Compression drop down list. 

3. For HD Media: 

a) Select the required file format from the File type drop down list. 

b) Select the compression method from the Compression drop down list. 
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4. For UHD Media: 

a) Select the required file format from the File type drop down list. 

b) Select the compression method from the Compression drop down list. 

Tasks Tab

To review active and recent tasks such as importing and exporting media: 

STEPS

1. Click the Tasks tab. 

2. To review active tasks, click the Active sub tab. 

3. To cancel active tasks, click the red X button and choosing to stop all background tasks or 
just the one. 

4. You cannot exit a project while background tasks are in progress. 

5. To review recent tasks, click on the Recent tab. 
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This chapter covers generic features for bins and describes how you can use them to manage 
projects. See the following topics: 

• "Working with Bins" on page 127

• "Working with Groups" on page 131

• "Tile View" on page 133

• "List View" on page 134

• "Merging Common Content Only" on page 138

• "Multicam Bins" on page 139

• "Creating Proxies" on page 144

For general information on creating and using bins, see "Creating an Empty Bin" on page 31. 

Working with Bins

Bins are used to organize and display your clips and sequences. You can move and copy clips to 
other bins, and change the way bins display clips. You can also group bins by placing them in 
another bin. 

It is possible for a clip to be in more than one bin at the same time. You can use this feature to help 
organize your material more flexibly. Be aware that seeing a clip in more than one place on the 
screen does not mean there is more than one copy of the clip on the hard disk.

See the following topics: 

• "Creating an Empty Bin" on page 31 

• "Copying Clips to Bins" on page 32 

• "Creating a Bin with Clips" on page 32 

• "Renaming Bins" on page 128

• "Moving Clips between Bins" on page 128

• "Changing a Bin’s Appearance" on page 129

• “Saving Bins to Text Files” on page 130

• "Deleting Bins" on page 130
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Renaming Bins

To rename a bin: 

STEPS

1. Click on the bin name entry in the Content List panel. 

2. Type a new name for the bin and then press Enter.

Moving Clips between Bins

To move one or clips: 

STEPS

1. Open the bin containing the clip or clips you want to move. 

2. Click on the clip you wish to move. To select multiple clips, hold down the Shift or Ctrl key, 
and then click on each clip you want to move. 

Mac OS X users should use the Cmd key instead of the Ctrl key.

3. The cursor changes to show you how many clips you have selected. 

4. Release the Shift, Ctrl or Cmd key, and drag the selected clips onto the intended bin. 

1,2
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Changing a Bin’s Appearance

You can change the appearance of a bin in a number of ways: 

STEPS

1. Click the View button to toggle between List and Tile views. 

2. Click on the right or bottom edge or corner of the bin and drag it to the size you want. 

If you make a bin smaller, you may be unable to see all of the columns and fields on the 
screen at the same time. Use the scroll bars A and B to show items outside the viewing area 
of the bin. 

3. Click on a Bin name to display its contents in the main viewing area. 

A
2

B

1

3
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Saving Bins to Text Files

To save a bin to a text file:

STEPS

1. Right-click on the bin you want to save and, from the menu that opens, select Save to text 
file..

2. A message box displays, asking you to give the bin a name, and the location in which to save 
it. You can set CSV, JSON or XML as the target format.

Deleting Bins

To delete a bin: 

STEPS

1. Right-click on the bin you want to delete and, from the menu that opens, select Delete. 

2. To select multiple bins, hold down the shift or Ctrl key (Cmd key for Mac OS X) while clicking 
on the bins you want to delete and, from the menu that opens, select ‘Delete selected bin(s)’. 

3. A message box displays, asking you to select the items you want to delete: 

4. Select the items you want to delete. Click Yes to confirm the deletion, or click No to cancel 
the operation. 

5. If you selected Yes, the selected options are deleted. 

• Bin: Only the bin is deleted. Any clips or sequences contained in the bin 
are not deleted 

• Logs: All logs (clips, subclips, sequences) contained in the bin are deleted. 
Any media created by Create link will not be deleted 

If you select Logs, Media is selected automatically, to prevent 
orphaned media. 

• Hi-Res or 
Proxy: 

Deletes all media referenced by clips contained in the bin. It does 
not, however, delete the logs for each clip 
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Working with Groups

Groups are a collection of bins and other groups. They display in the Content List, and can also be 
identified by an amber marker that can be clicked to expand or collapse items contained in group. 

A group has the following properties: 

• Groups can be minimized to save space or left open to show content in the Content Manager 

• Bins can be dropped into single or multiple Groups 

• Groups can be placed in other groups 

See the following topics: 

• "Creating a New Group" on page 131

• "Renaming a Group" on page 131

• "Adding Bins and Groups to a Group" on page 132

• "Removing Bins from a Group" on page 132

• "Removing (Ungrouping) Groups" on page 132

• "Sorting Bins and Groups" on page 132

Creating a New Group

To create a new group: 

STEPS

1. Do one of the following: 

• Right-click in the Content List panel and select Make > Empty group. 

• Select multiple bins by Shift or Ctrl-clicking them, then right-click. From the menu that 
opens, select ‘Make Group’. 

2. A new group is created. 

Renaming a Group

To rename a group: 

STEPS

1. In the Contents List, double-click on the group’s name and then type the new name. 

2. Press Enter. 
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Adding Bins and Groups to a Group

To place a bin or a group inside another group: 

STEPS

1. Click on the bin or group, and drag it onto the group you want to move it to. 

To select multiple bins and groups, hold down the Shift or Ctrl key (Cmd key for Mac OS X) 
while clicking. 

2. When the destination group is highlighted, release the mouse 
button. 

3. The selected bins and groups display inside the Group. 

Removing Bins from a Group

To remove bins from a group: 

STEPS

1. Click on the bin you want to remove and drag it out of the group into an empty space in the 
Content List panel. 

To select multiple bins, hold down the Shift or Ctrl key (Cmd key for Mac OS X) while clicking. 

2. The bin displays in the Content List panel but is no longer part of a group. 

Removing (Ungrouping) Groups

To remove a group from the Content List panel: 

STEPS

1. Right click on the group you wish to remove and, from the menu that opens, select Ungroup. 

2. The group is removed from the Content List panel, and all bins within the group display as 
independent bins. 

Sorting Bins and Groups

You can sort the order of bins and groups by date, name and type: 

STEPS

1. Right-click in the Contents List area of the Content Manager and, from the menu that opens, 
select Ordering > Sort by. 

2. From the sub menu that opens, select Date, Name or Type. 

3. Bins and groups are sorted into the order you specified. 
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Tile View

See the following topics: 

• "Sorting Tiles" on page 133

• "Changing the Thumbnail Size in Tile View" on page 133

Sorting Tiles

To change the order in which tiles are displayed: 

STEPS

1. Select Tile View in 
the Content 
Manager. 

2. Right-click on a tile 
and, from the menu 
that opens, select 
View Commands > 
Sort By. 

3.  Select the sort 
option you require 
from the drop 
down list that 
opens.

Changing the Thumbnail Size in Tile View

In Tile View, while holding down the Ctrl key, move your mouse over an area of the bin and scroll 
with the mouse wheel to change the thumbnail size. Changing the size of thumbnails in Tile View 
does not affect the size of thumbnails in List View. 

Alternatively, do the following: 

STEPS

1. Set the Content Manager to Tile View. 

2. Right-click on a tile and, from the menu that opens, select Tile Size > Small, Medium or Large. 

3. The size of thumbnails is set to the size you selected.

3

2
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List View

When in List View you can see metadata about each clip, such as tape name, clip name and creation 
date. You can select the columns that you see in List View and save it as a default view. See the 
following topics:

• "Sorting the List View" on page 134

• "Changing Thumbnail Size in List View" on page 135

• "Displaying Bin Columns" on page 135

• "Customizing the List View" on page 136

• "Changing the Order of Fields" on page 136

• "Saving a View" on page 137

• "Deleting a View" on page 137

Sorting the List View

You can sort the List View alphanumerically by Name, Tape, Comments, or by any other visible field 
column: 

STEPS

1. In List View, click on the column you want to sort on. 

2. The List items are sorted on the column you selected. 

3. To reverse the list order, click again on the same column. 
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Changing Thumbnail Size in List View

In List View, while holding down the Ctrl key, move your mouse over an area of the bin and scroll 
with the mouse wheel to change the thumbnail size. Changing the size of thumbnails in List View 
does not affect the size of thumbnails in Tile View. 

Alternatively, do the following: 

STEPS

1. Set the Content Manager to List View. 

2. From the menu that displays, select View Commands > Thumb Size > Extra Small, Small, 
Medium, Large or Extra Large.

3. The size of thumbnails is set to the size you selected.

Displaying Bin Columns

You can display bins and the items in them in different ways. You can store several views within a 
project and customize them with all or only some of the fields in the bin. Views can help you 
organize the bin information. 

STEPS

1. Click the bin icon until List View displays. 

2. Right-click in the Columns area and, from the menu that opens, select View Commands > 
Columns. 

3. From the options panel that opens, select one of the following views: 

4. Click a column heading to sort the List View on that column. Click again to reverse the sort 
order. 

• Default The default view for the project, set in the Views window 

• Customise User-defined Layout. See "Customizing the List View" on page 136. 
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Customizing the List View

Bins produced by searches use the default view for the project, if you have set one. If you have not 
set a view, bins open with the default column headings. To customize a bin view: 

STEPS

1. Right-click in the Columns area, and select Customise from the Columns menu options. See 
"Displaying Bin Columns" on page 135. 

2. The Columns window opens, listing all available 
fields. A tick displays against the fields already 
enabled in the List View. 

3. Click the Load button. 

4. The Column layout dialog box opens. 

5. Select the template you require: 

• Default 

• Custom

‘Custom’ displays if you have changed and used a 
select set of column headers without saving. 

6. Click OK to close the Column layout box. 

7. To refine your list of displayed columns, use your 
mouse to tick the fields you require, or untick the 
fields you do not require.

8. (Option) Select the Set as Default option. The current selection of fields is stored as default. 
The next time you generate a bin, it uses the default view. 

9. Click Use to save your selection and close the Bin Views window. 

Changing the Order of Fields

To change the order of column fields:

STEPS

1. Right-click in the List View and, from the menu that opens, select Customise from the 
Columns menu options. See "Displaying Bin Columns" on page 135. 

2. Click the name of the column field you want to move and drag it up or down the list.

3. Repeat Step 2 for each field until list is in the order you want.

4. (Option) Select the Set as Default option. The current selection of fields is stored as default. 
The next time you generate a bin, it uses the default view. 

5. Click Use to save your selection and close the Bin Views window.
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Saving a View

To save a view: 

STEPS

1. Create a custom Bin View as described in "Customizing the List View" on page 136. 

2. Click Save in the Bin Views window. A Save as dialog box opens. 

3. Type a name for the view, and then click Do It.

4. The named view is saved and added to the list displayed when you open the Columns list on 
the bin menu. 

Deleting a View

To delete a view: 

STEPS

1. In the Columns window, click the Delete button. 

2. The Delete Column layout dialog box opens. 

3. Click on the view you want to remove, and then click OK. 

4. A message box opens, asking you to confirm you want to delete the view. Click Yes to delet, 
or No t cancel the deletion. 

Merging Content from Multiple Bins

You can create new bins which combine some or all of the content from two or more existing bins. 
The mix of content can be combined as follows: 

• Union - see "Merging all Content" on page 138

• Intersection - see "Merging Common Content Only" on page 138

• Difference - see "Merging Unique Content Only" on page 139

You can rename the bins generated to something more meaningful to you. See "Renaming Bins" 
on page 128. 
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Merging all Content

You can merge the contents of two or more bins into a new bin, leaving the contents of the source 
bins unchanged. Do the following: 

STEPS

1. While holding down the Shift or Ctrl key (Cmd key for Mac OS X) click on the source bins you 
wish to merge. 

2. Release the Shift or Ctrl key (Cmd key for Mac OS X) and right-click on your selection. 

3. From the menu that opens, select Selection > Make > Bin (union).

4. A new bin called Union #1 is created, containing the media from the selected bins. If there 
is already a bin called Union #1, the next available number is used. 

5. The tagged records from the selected bins are added to the destination bin.

Merging Common Content Only

You can select content that it is common to two or more bins and place them into a new bin, 
leaving the contents of the source bins unchanged. Do the following: 

STEPS

1. While holding down the Shift or Ctrl key (Cmd key for Mac OS X) click the source bins you 
wish to merge. 

2. Release the Shift or Ctrl key (Cmd key for Mac OS X) and right-click on your selection. 

3. From the menu that opens, select Selection > Make > Bin (intersection).

4. A new bin called Intersection #1 is created, containing the media that is common to the 
selected source bins. If there is already a bin called Intersection #1, the next available 
number is used. 



TP-00387-01 139

Multicam Bins

Merging Unique Content Only

You can select content from two bins that is not common to each other and put them into a new 
bin. The contents of the source bins remain unchanged. 

STEPS

1. While holding down the Shift or Ctrl key (Cmd key for Mac OS X) click the source bins you 
wish to merge. 

2. Release the Shift or Ctrl key (Cmd key for Mac OS X) and right-click on your selection. 

3. From the menu that opens, select Selection > Make > Bin (difference).

4. A new bin called Difference #1 is created, containing all the media that is unique to each 
selected bin. If there is already a bin called Difference #1, the next available number is 
used. 

Multicam Bins

The Multicam Bin feature lets you lock together multiple sources (clips, subclips, or edits) so they 
play in synchronization. For example, you can use a Multicam Bin to set up multi-camera events for 
Live Editing (see "Live Editing" on page 70). All sources do not have to have the same timecode, as 
synchronization can be by timecode or by a selected sync point (frame).

When you place a tile in a Multicam Bin, it immediately becomes synced with all other tiles in the 
group. It is only the individual tile that is synced, not the original clip or edit. The same clip can 
appear in many different Multicam Bins, represented by separate tiles that are all synced by 
different methods and at different points. 

Even though the same clip can appear can appear on the screen in more than one 
place, there is only one copy of the material on disk. Deleting a clip contained in 
any Multicam Bin deletes every other instance of that clip, for example, other 
bins, edits and subclips

See the following topics: 

• "Creating a New Multicam Bin" on page 140

• "Using Multicam Bins" on page 141

• "Adding Sources to a Multicam Bin" on page 142

• "Removing Sources from a Multicam Bin" on page 142

• "Changing the Current Frame" on page 142

• "Selecting a Sync Method" on page 143

• "Combining Sync Methods" on page 144
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Creating a New Multicam Bin

When you create a Multicam Bin, the first four tiles to be added are automatically assigned to video 
outputs 1 to 4 in order and to the Console Cut buttons 1 to 4. The video output also determines 
which Console Cut button the viewer is represented by in Live Editing (see "Live Editing" on 
page 70). 

To create a new Multicam Bin: 

STEPS

1. In the Content Manager, open a bin containing the clips you want to sync. 

2. Shift+click or Ctrl+click to select the clips you want to sync. 

3. Right-click on the selected clips and, from the menu that opens, select Make > Multicam Bin. 

4. When the ‘Create a Multicam Bin’ dialog box opens, type a name for your Multicam Bin in 
the Name text box. 

5. Choose a ‘Sync by’ option (Timecode or Current Frame) from the drop down list. 

6. Choose the tile size (Small, Medium or Large) from the drop down list. 

7. Click Do it. 

8. Your new Multicam Bin displays in the Content List. 

9. The new Multicam Bin opens, displaying your clips as tiles. See "Using Multicam Bins" on 
page 141. 

As an alternative, you can open a ‘Create Multicam Bin’ dialog box by pressing a keyboard shortcut 
that you have assigned in Lightworks user settings. 

1 2 3

8

4
5
6

7
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Using Multicam Bins

Multicam Bins are listed in the Content List panel of the Content Manager: 

STEPS

1. Multicam Bins are listed in the Content List panel, below Bins, and are identified by a green 
square bullet point next to their name. Click on the Multicam label to view the Bin contents. 

2. Each clip displays as a tile in the Multicam Bin. 

3. To play a tile: 

a) Use the Lightworks Console playback controls. 

b) Use the playback shortcut keys. 

4. To resize the tiles, right-click inside the Multicam Bin and, from the 
menu that opens, select View Commands > Tile size, and then select 
Small, Medium or Large from the drop down list. 

5. To enable independent playback of tiles, right-click in the Multicam 
bin and, from the menu that opens, select Multicam Commands > Concurrent players > No. 

To resume synchronized playback, select Multicam Commands > Concurrent players > Yes. 

6. Further options and functions are available in Historic Lightworks. See"Using Multicam Bins" 
on page 272. 

2 3

1

Default Shortcuts:

j = Play Backwards 
k = Pause
l = Play Forwards
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Adding Sources to a Multicam Bin

You can subsequently add a clip, subclip, or edit as a tile to a Multicam Bin. You can add a single 
tile or a bin of tiles. If there are three tiles or less already in the bin, the first new items added will 
be assigned to the unused Console Cut buttons (see "Live Editing" on page 70). 

To add sources to an existing Multicam Bin: 

STEPS

1. Make sure you have already selected a sync method as described in "Selecting a Sync 
Method" on page 143.

2. Display the clip, subclip, or edit as a tile.

3. Drag the tile onto a Multicam Bin label in the Contents List. Select multiple clips by holding 
down the Shift or Ctrl key. 

4. All the tiles are added to the Multicam Bin and are synced by the method you selected. 

Removing Sources from a Multicam Bin

To remove a source from a Multicam Bin: 

STEPS

1. In the Multicam bin, position your mouse over the clip you want to remove. Click on the 
cross that displays in the top right corner of the clip. 

2. To remove multiple clips at the same time, hold down the Shift or Ctrl key while selecting 
clips for removal. 

3. A message box opens, asking you to confirm you want the clip removed from the Multicam 
bin. 

4. Click Yes. the clip is removed from the bin. 

Changing the Current Frame

You can change the current frame of any clip after you have placed it in a Multicam Bin. The 
procedure is as follows: 

STEPS

1. In the Multicam Bin, right-click on the tile you want to change.

2. Scrub through the tile to locate the new current frame. 

3. As you scrub through the tile, its name label color alternates between green and red. 

4. When you have located the new current frame, right-click on the tile and, from the menu 
that opens, select ‘Allow lock adjustments’ > No. 

5. The Tile name color reverts to green-only, indicating the new current frame is set.
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Selecting a Sync Method

You can sync with timecode or with the current frame. You can also combine methods, see 
"Combining Sync Methods" on page 144. To select a sync method: 

STEPS

1. Right-click in the Multicam Bin and, from the menu that opens, select Multicam Commands 
> Sync By. 

2. Select one of the following options from the Sync By drop down list: 

• Current frame

• Primary T/C (timecode) 

• 24 frame medium 

• Orig(inal) Audio T/C 

• Ink Code 

• Camera T/C 

• Film Keycode 

3. If you selected Current frame, tiles are synced together by the frame each clip is parked on 
when you placed it in the Multicam Bin. 

4. If you selected Timecode, select one of the options from the Sync tracks drop down list, as 
follows: 

V The timecode is taken from the video channel of the master clip. This is the 
default.

A1 The timecode is taken from the first audio channel of the master clip

A2 The timecode is taken from the second audio channel of the master clip.
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Combining Sync Methods

You can combine the two sync methods if, for example, all clips do not share the same timecode. 
The following procedure describes a situation where clips A and B have matching timecodes and 
clips C and D do not. 

STEPS

1. In the Multicam Bin, hold down the Shift or Ctrl key and then right-click on the tiles you want 
to change (for example, C and D). 

2. From the menu that opens, select Multicam Commands > Allow lock adjustments > Yes’. 

3. In the Multicam Commands area, select a sync method for clips C and D from the Sync By 
drop down list for the selected clips. 

4. Change the start frame positions for clips C and D. Do not make any changes to clips A or B. 

5. Right-click the clips C and D again, and from the menu that opens, select Multicam 
Commands > Allow lock adjustments > No. 

6. All the clips will now be in sync even though two clips have two different sync methods. 

Creating Proxies

If you have media files that use high CPU processing or large amounts of memory, you may find 
they do not playback smoothly on your system. You can improve the playback response of your 
media if you create proxy versions of your files instead. See “Proxies Tab” on page 125 for more 
information on changing the settings for your proxy media.

STEPS

1. Right-click on a clip or a bin of clips. 

2. From the menu that opens, select Media -> Make proxies. 
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3. The Task tab of the Project Card opens to display the progress of Proxy file generation. When 
all proxies are created, the Project Card closes.

4. You can set Lightworks to play these proxy versions instead of your original high resolution 
files from the playback media quality setting on the Output subtab of the Video tab on the 
Project tab. See “Output Tab” on page 119 where you can change the playback quality 
setting.



146 TP-00387-01

Chapter 8: Bins and Groups



TP-00387-01 147

Chapter 9: Transitions

You can add various transitions to your sequences, including fades, dissolves and wipes. You can 
use these to convey a tone or mood, suggest the passage of time, or separate parts of a story. 

See the following topics: 

• "Adding and Changing Transitions" on page 147

• "Transition Types" on page 151

Adding and Changing Transitions

See the following topics: 

• "Adding Simple Transitions" on page 148

• "Adding Audio Transitions" on page 149

• "Changing a Video Transition" on page 149

• "Configuring a Transition" on page 150
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Adding Simple Transitions

To add a simple transition: 

STEPS

1. Make sure the Edit or VFX tab is selected. 

2. Right-click on the cut where you want your transition. 

3. From the menu that opens, select Transitions > Position, and choose where you want the 
transition to start and finish from the drop down list. The options are: 

4. Select the number of frames you want for your transition to take effect from the Length drop 
down list. 

5. Click on Add, and select one of the Transition options described on page 151. 

6. The transition is applied to your sequence. 

If the outgoing or incoming clip is too short, the transition will not be created. In this case, an error 
message is generated. 

1

4

2 3

5

6

Centered Here: Applies the effect centered at the park position. 

From Here: Applies the effect forward from the park position. 

To Here: Applies the effect backward from the park position. 
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Adding Audio Transitions

To add an audio transition which has the same duration as the video transition: 

STEPS

1. Make sure the Edit or VFX tab is selected. 

2. Right-click on the cut where you want to add your transition. 

3. From the menu that opens, select Transitions > Add ‘Crossfade’. 

4. The Crossfade transition is applied to the audio tracks. 

Changing a Video Transition

To change an existing video transition: 

STEPS

1. In the timeline, right-click on the video transition you want to change. 

2. From the menu that opens, select ‘Replace with..’ and then select the transition you want 
from the submenu. 

1

2

3

4
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Configuring a Transition

Each transition has its own configuration dialog box which displays all the parameters available for 
that effect. To configure a transition: 

STEPS

1. Do one of the following: 

a) In the Edit tab, right-click on the transition and, from the menu that opens, select 
Transitions > Settings. 

b) In the VFX tab, make sure the Settings tab is selected. 

2. A Configuration panel opens on the left hand side with the Settings tab open. 

3. If an effect view is collapsed, click on the side arrow to expand it. 

4. Make the changes you require, following the instructions for the relevant transition listed 
under "Transition Types" on page 151. 

5. If the timeline marker is parked within the effect, changes display immediately in the 
Sequence viewer and on the output monitor. 

6. Click on the green button to toggle the transition ON and OFF. The button displays green 
when the transition is enabled. 

7. To remove or reset an effect, click on the Cogs icon. From the menu that opens: 

• Click on Reset to revert all settings to their default values. 

• Click on Remove to delete the transition from the timeline. 

3

2

51b 67

1a
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Transition Types

The following transition types are available: 

• "Blend" on page 151

• "Dissolve" on page 152

• "Luma Wipe" on page 152

• "Masked Blend" on page 153

• "Push" on page 153

• "Squeeze" on page 154

• "Wipe" on page 154

Blend

Creates a blend between clips. 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. The rate of Blend can be adjusted by sliding the Opacity slider left or right. 
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Dissolve

Simulates a film-type dissolve. 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. The rate of Dissolve can be adjusted by sliding the Progress slider left or right. 

Luma Wipe

The Luma Wipe effect is a transition between images based on their luminance, and can be 
adjusted as follows: 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. Set the Luma source - Foreground or Background - from the Luma source drop down list. 

3. Click on the Border menu to expand it. 

• Size: Controls the border size of the wipe. 

• First color: Sets the first color of the wipe. 

• Second color: Sets the second color of the wipe. 

4. Move the Softness slider left or right to adjust the sharpness of the of the wipe. 

2
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5. Move the Progress slider left or right to alter the rate at which the wipe occurs. 

6. Tick the Invert box to reverse the direction of the wipe. 

Masked Blend

Creates a masked blend between clips. 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. Select the blend method from the Method drop down list. 

3. The rate of Blend can be adjusted by sliding the Opacity slider left or right. 

Push

The transition between two elements made by one element pushing another off the screen. The 
Push effect can be adjusted as follows: 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. Set the direction of the push (left, right, up or down) you require from the Type drop down 
list. 

3. Move the Progress slider left or right to alter the rate at which the push effect occurs. 
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Squeeze

The transition between two elements made by one element entering the screen while squeezing 
down the other. It can be adjusted as follows: 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. Set the direction of the squeeze (left, right, up or down) you require from the Type drop 
down list. 

3. Move the Progress slider left or right to alter the rate at which the squeeze effect occurs. 

Wipe

Wipes the screen, transitioning between outgoing and incoming elements. The Wipe effect can be 
adjusted as follows: 

STEPS

1. Open the transition’s Configuration panel as described in "Configuring a Transition" on 
page 150. 

2. Set the wipe pattern you require from the Wipe drop down list. To assist you, each item in 
the list has a preview of the wipe action. 

3. Move the Softness slider left or right to adjust the sharpness of the leading edge of the wipe. 

4. Move the Progress slider left or right to alter the rate at which the wipe effect occurs. 

5. Tick the Reverse direction box to reverse the direction of the wipe - for example, a wipe that 
previously wiped from left to right wipes from right to left. 

6. Click on Repeats menu to expand it. 

• Across: Controls the horizontal position of the wipe effect. 

• Down: Controls the vertical position of the wipe effect. 
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7. Click on the Border menu to expand it. 

• Size: Controls the border size between the two sides of the wipe. 

• First color: Sets the first color of the wipe border. 

• Second color: Sets the second color of the wipe border. 

8. Click on the Position menu to expand it. 

• Horizontal Position: Change the horizontal position of the wipe border. 

• Vertical Position: Change the vertical position of the wipe border. 
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A wide range of visual effects are available, including Chromakey, Mirror, Titling and Picture in 
Picture effects. See the following topics: 

• "Adding an Effect from the Timeline" on page 158

• "Adding an Effect using the Add Button" on page 159

• "Configuring an Effect" on page 160

• "Color Effects" on page 161

• "Digital Video Effects (DVE)" on page 167

• "Key Effects" on page 173

• "Matte Effects" on page 176

• "Mix Effects" on page 178

• "Title Effects" on page 178

• "Look Up Tables" on page 184

• "Keyframes" on page 188
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Adding an Effect from the Timeline

To add an effect from the timeline menu: 

STEPS

1. Make sure the VFX tab is selected. 

2. Use Mark and Park to highlight where you want to add your effect. See 
"Mark and Park" on page 52. 

3. Right-click on timeline and, from the menu that opens, select Effects 
> Add, and choose the effect you want from the sub menu. 

4. The effect is inserted into the timeline. 

5. Configure your effect as described on "Configuring an Effect" on page 160. 

42a

13

2c2b

Default Shortcuts:

i = Mark / Mark In 
o = Mark Out 
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Adding an Effect using the Add Button

To add an effect using the Add button: 

STEPS

1. Make sure the VFX tab is selected. 

2. Use Mark and Park to highlight where you want to add your effect. See 
"Mark and Park" on page 52. 

3. Click the Add Effect button ‘+’. 

4. Select the Effects category containing the effect you want from the 
drop down list. 

5. Click to select the effect you want from the Category panel. 

6. Select what you want the effect applied to from the drop down list. 

7. Click the Apply effect button. 

8. The effect is inserted into the timeline. 

9. Configure your effect as described on "Configuring an Effect" on page 160. 

82b

15 3 4

7 6 2a 2c

Default Shortcuts:

i = Mark / Mark In 
o = Mark Out 
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Configuring an Effect

Each effect has its own configuration dialog box which displays all the parameters available to it. 
To configure an effect: 

STEPS

1. Do one of the following: 

a) With the Edit or VFX tab open, right-click on the effect and, from the menu that opens, 
select Effects > Settings. 

b) With the VFX tab open, position the timeline marker over the effect and then click on 
the Settings tab. 

2. A Configuration panel opens on the left hand side of the VFX tab.

3. If an effect view is collapsed, click on the side arrow to expand it. 

4. Make the changes you require, following the instructions for the relevant effect, as 
described in the following sections: 

• "Digital Video Effects (DVE)" on page 167

• "Key Effects" on page 173

• "Title Effects" on page 178

5. If the sequence is parked within the effect, changes display immediately in the Sequence 
viewer and on the output monitor. 

6. Click on the green button to toggle the effect ON and OFF. The button displays green when 
the effect is enabled. 

7. To remove or reset an effect, click on the Cogs icon. From the menu that opens: 

• Click Reset to revert all the settings to their default values. 

• Click Remove to delete the effect from the timeline. 

1a

3

2

1b 6 57
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Color Effects

This chapter describes the use of color correction, selective correction, and color effects. See the 
following topics: 

• "Color Tint" on page 161

• "Greyscale" on page 161

• "Negative" on page 162

• "Two-Tone" on page 162

• "Tri-Tone" on page 162

• "Color Temperature" on page 163

• "Color Correction" on page 163

• "Selective Correction" on page 167

• "3D LUT" on page 167

Color Tint

Tints the whole image in one color.

• Tint Color: To change the color from the default, click the color box and use the scales or the 
dropper to create the required color. 

• Amount: Increases or decreases the amount of tint. 

Greyscale

Adjusts the greyscale within an image.

• Channel Weights: Lets you make colors lighter or darker by adjusting the Red, Green, Blue 
scales within the effect. 

• Channel Contrasts: Increases or decreases the amount of contrast by adjusting the Red, Green, 
Blue scales. 
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Negative

Changes the image color to a negative state.

• Level: Adjusts the level of the greyscale. 

• Softness: Adjusts the hardness or softness of the image.

Two-Tone

Allows you to adapt two colors (dark and light).

• Threshold: The higher the percentage, the more the image takes on the color in the dark color 
box. 

• Dark Color 

• Light Color 

Tri-Tone

Allows you to adapt three colors (dark, mid, and light). The threshold features let you enhance the 
chosen colors manually. 

• Threshold One: The higher the percentage, the more the image takes on the color in the dark 
color box.

• Threshold Two: The higher the percentage, the more the image takes on the color in the mid 
color - the lower the percentage, the more it takes on the light color. 

• Dark Color 

• Mid Color 

• Light Color 
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Color Temperature

Adjusts the colors of the video to make them appear warmer or cooler. 

• Temperature: Move the slider to increase or decrease the color temperature of the video 
image. 

Color Correction

See the following topics: 

• "Setting Tonal Ranges" on page 163

• "Color Balance" on page 164

• "RGB Settings" on page 165

• "HSV Settings" on page 166

• "Curves" on page 166

Setting Tonal Ranges

The Main color tab displays by default when you select Color Correction. This section allows you to 
adjust the following parameters: 

STEPS

1. Click the arrow to alternately maximize and minimize the Color Correction panel. 

2.  Click on the Main tab if not already selected. 

Shadows Controls color shades in the color spectrum using the tint hue, tint amount, and 
brightness parameters. 

Mid-tone Controls the mid-tones you want in the spectrum. 

Highlights Modifies the brighter colors in the images 

3

4
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3. Click on the Luminance icon to adjust the luminance for Shadows. 

a) The Luminance edit panel opens. 

b) Click on the graph line to add keyframes as 
required. 

c) Drag each keyframe with the mouse to set the 
required response. 

d) To delete a keyframe, select with the mouse and 
then click the Delete button. 

4. Adjust the hue by dragging the marker on the 
respective color wheel. 

Alternatively, type in the hue value and percentage directly into the text boxes below the 
color wheel. 

5. Adjust the brightness by dragging the slider to the required setting. Alternatively, adjust by 
typing a value directly into the text box below the slider. The higher the gain, the more 
distorted the image becomes as it takes on a grainy, pixelated quality. 

6. Move the relevant slider let or right to decrease or increase Color Saturation, Gamma, 
Contrast, Brightness and Gain. 

7. Repeat steps 3 to 6 for Midtones and Highlights.

Color Balance

The Balance tab allows you to choose three colors to edit. The defaults are black, white, and grey. 

STEPS

1. Click on the Balance tab to select Color Balance. 

2. Click the keyframe button to toggle keyframes for the corresponding color. 

3. Click the color palette to open the color palette for the corresponding color. 

1 2 3 5 4
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4. The color palette opens. Do one of the following: 

• Drag the sliders marked Red (R), Green (G) and Blue (B) to select the color you require, or 
type values directly into the R, G and B text boxes. 

• Drag the pointer on the color wheel to the color you require. 

• Type values directly into the H, S, V text boxes for the Hue, Saturation and Value levels you 
require. 

• Drag the Value slider to select the level you require. 

5. Select in turn, the black, grey and white dropper tool, and drag onto the area on the screen 
which is the same color as you want for your selection. This optimizes the color balance for 
the recorded image. 

RGB Settings

 The RGB tab adjusts red, green, and blue channels individually. Each of the options helps to create 
different effects on the colors in the image: Gamma, contrast, brightness and gain.

STEPS

1. Click on the RGB tab. 

2. The RGB options display. If you cannot see all of the display, drag the top or bottom frame 
edge to resize the dialog box, use the scroll bar to reveal the remaining screen content. 

3. Adjust the Red, Green and Blue sliders as required for each parameter. 

4. If you want to change the Red, Green and Blue values over time, that is, over the duration of 
the clip, click the keyframe button to toggle keyframes ON or OFF for the corresponding 
parameter. See "Keyframes" on page 188 for further information about using 
keyframes. 

1

2
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HSV Settings

This tab adjusts the Hue, Saturation and Value (HSV) settings. 

STEPS

1. Click on the HSV tab. 

2. Adjust the Hue, Saturation and Value sliders as required for each parameter. 

3. If you want to change the Hue, Saturation and Values over time, that is, over the duration of 
the clip, click the keyframe button to toggle keyframes ON or OFF for the corresponding 
parameter. See "Keyframes" on page 188 for further information about using 
keyframes. 

Curves

The Curves tab allows you to set keyframes for RGB and Luminance profiles. 

STEPS

1. To display the Curves parameter options, click the Curves tab. 

2. To change the parameter values over time, that is, over the duration of the clip, click the 
keyframe button to toggle keyframes ON or OFF for the corresponding parameter. 

3. Click on the graph line to add keyframes as required. Drag each keyframe with the mouse to 
set the required response. See "Keyframes" on page 188 for further information about 
using keyframes. 

12 3
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Selective Correction

Similar to Color Correction but allows you change up to four different colors at once. 

Make changes to Balance, Tonal Ranges, RGB, HSV and Curves, as described in "Color Correction" 
on page 163. 

3D LUT

Applies a Look Up Table (LUT) effect to the  image. 

• LUT: Select the LUT effect you require from the drop down list. 

• Amount: Use the slider to adjust the level of the effect. 

For more information about Look Up Tables (LUTs) see "Look Up Tables" on page 184. 

Digital Video Effects (DVE)

The DVE category contains a range of picture effects, all of which derive from the basic 
Picture-in-Picture and DVE effects. To add a second picture to these effects, you need to add a 
second video track to the timeline. 

• "2D DVE" on page 168

• "3D DVE" on page 169

• "Cine Crop 1" on page 170

• "Flip" on page 170

• "Flop" on page 170

• "Picture In Picture Presets" on page 171

• "Split Screen" on page 172

• "Split Screen with Background (+bg)" on page 173
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2D DVE

The 2D DVE effect allows you to move the image in any position you want. 

STEPS

1. Click on the Position menu to expand its contents. 

• Drag slider X to position the image horizontally on the screen. 

• Drag slider Y to position the image vertically on the screen. 

2. Click on the Scale menu to expand its contents. 

• Drag the Master slider to resize the image. 

• Drag slider X to stretch or squeeze the image horizontally. 

• Drag slider Y to stretch or squeeze the image vertically. 

3. Click on the on the Crop menu to expand its contents. Drag the named sliders to crop the 
Left, Right, Top and Bottom sides of the image. 

4. Click on the Shadow menu to expand its contents. 

• Drag the Transparency slider to change the transparency of the shadow. 

• Drag the X Offset slider Y to offset the shadow horizontally. 

• Drag the Y-Offset slider Z to offset the shadow vertically. 

5. Drag the Edge Softness slider left or right to adjust the sharpness or softness of the image 
edge. 

6. Drag the Opacity slider left or right to change the opacity of the image. 



TP-00387-01 169

Digital Video Effects (DVE)

3D DVE

The 3D DVE effect allows you to move the image in any position you want. 

STEPS

1. Click on the Rotation menu to expand its contents. 

• Using your mouse, rotate the X clock face control to rotate the image round the 
horizontal axis. 

• Rotate the Y clock face control to rotate the image round the vertical axis. 

• Rotate the Z clock face control to rotate the screen image. 

The text box immediately to the left of each clock displays the amount of rotation in 
degrees. You can also type a value directly into the box to set the rotation. 

2. Click on the Position menu to expand its contents. 

• Drag slider X to position the image horizontally on the screen. 

• Drag slider Y to position the image vertically on the screen. 

• Drag slider Z to zoom in or out. 

3. Click on the Pivot menu to expand its contents. 

• Drag slider X to move the image horizontally on the screen. 

• Drag slider Y to move the image vertically on the screen. 

4. Click on the on the Crop menu to expand its contents. Drag the named sliders to crop the 
Left, Right, Top and Bottom sides of the image. 

5. Click on the Shadow menu to expand its contents. 

• Drag the Distance slider to change the size of the shadow. 

• Drag the X Offset slider Y to offset the shadow horizontally. 

• Drag the Y-Offset slider Z to offset the shadow vertically. 
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6. Drag the Edge Softness slider left or right to adjust the sharpness or softness of the image 
edge. 

7. Drag the Opacity slider left or right to change the opacity of the image. 

Cine Crop 1

The Cine Crop 1 effect allows you to move the image in any position you want. The adjustments 
are the same as described in "2D DVE" on page 168. 

Flip

This feature flips the screen image on the horizontal axis. There are no settings for this feature. 

Flop

This feature creates a mirror image, that is, it flips the screen image on the vertical axis. There are 
no settings for this feature. 
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Picture In Picture Presets

The following Picture in Picture options have the same controls as described in "3D DVE" on 
page 169: 

The following presets are available: 

Angle Left Angle Right (pictured)

Bottom Left Bottom Centre Bottom Right

Mid Left Mid Centre Mid Right

Top Left Top Centre Top Right
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Split Screen

Displays two images side by side. 

STEPS

1. Under Right Picture, click on the Position menu to expand its contents. 

• Drag slider X to position the image horizontally on the screen. 

• Drag slider Y to position the image vertically on the screen. 

2. Click on the Scale menu to expand its contents. 

• Drag the Master slider to resize the image. 

• Drag slider X to stretch or squeeze the image horizontally. 

3. Click on the on the Crop menu to expand its contents. Drag the named sliders to crop the 
Left, Right, Top and Bottom sides of the image. 

4. Click on the Shadow menu to expand its contents. 

• Drag the Transparency slider to change the transparency of the shadow. 

• Drag the X Offset slider Y to offset the shadow horizontally. 

• Drag the Y-Offset slider Z to offset the shadow vertically. 

5. Drag the Opacity slider left or right to change the opacity of the image. 

6. Repeat the previous steps for the Left Picture. 
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Split Screen with Background (+bg)

This option is the same as Split Screen, but with the option to set a two-color background. 

STEPS

1. Adjust the settings for the Right and Left Pictures as described in "Split Screen" on page 172. 

2. Under background, click on the Color One menu to expand its contents. 

• Select the color you require by clicking on the color palette tab or by using the color 
picker. 

• Drag the Extent slider to adjust the level of the first color. 

3. Repeat step 2 for Color Two. 

Video Auto Rotate

Video Auto Rotate option has been added to the Video->Output tab of the project card. This allows 
mobile phone footage to be rotated automatically based on the clip metadata to the correct 
orientation. This feature is on by default but can be disabled by un-checking the option. 

NOTE:  If the rotated media is progressive and an interlaced output format has been selected, 
then the auto rotation may not function as expected. To avoid this, it is recommend that 
Auto Rotate Videos be disabled and that you rotate the video manually using the 3D DVE 
effect. Refer to the 3D DVE section to do so.

Key Effects

The following key effects are available: 
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• "Chromakey" on page 174

• "Lumakey" on page 174

• "Color Mask" on page 175

• "Image Key" on page 176

• "Bluescreen and Greenscreen" on page 176

Chromakey

Layers two images or video streams together based on color hues (chroma range).

STEPS

1. Click on the eyedropper tool, drag it on to a point on the screen that is the same color you 
want to change, and click again to select the color. 

2. When you hover your mouse over the Hue, Saturation or Luminance bar, the mouse cursor 
changes to a double-arrow. This lets you drag the selected bar left or right to adjust its 
setting. 

3. Any changes you make to Hue, Saturation and Luminance display in the Viewer. 

4. Tick the Reveal box to display which on-screen elements you have selected. 

5. Tick the Invert box to display which on-screen elements have not been selected.

Lumakey

Sets the brightness level, so that all of the brighter or darker pixels from the image are turned off, 
making them transparent. The image or video behind the top layer show through the transparent 
sections. 

32
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STEPS

1. Drag the Tolerance slider left or right to adjust the brightness or transparency. Alternatively, 
type a percentage value in to the text box to the right of the slider. 

2. Drag the Edge softness slider left or right to sharpen or soften the image edges. 
Alternatively, type a percentage value in to the text box to the right of the slider. 

3. Tick the Invert box to invert the screen colors. 

4. Any changes you make to the settings display in the Viewer. 

Color Mask

Takes any color you select and applies changes you make to Hue, Saturation and Luminance to all 
instances of that color in the viewer. You can connect other effects and apply them to the regions 
that match that color. For example, you can blur only the green areas of an image, you apply the 
color mask, choose green, and then apply a blur. 

STEPS

1. Click on the eyedropper tool, drag it on to a point on the screen that is the same color you 
want to change, and click again to select the color. 

2. When you hover your mouse over the Hue, Saturation or Luminance bar, the mouse cursor 
changes to a double-arrow. This lets you drag the selected bar left or right to adjust its 
setting. 

3. Any changes you make to Hue, Saturation and Luminance display in the Viewer. 

1 42 3
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4. Tick the Reveal box to display which on-screen elements you have selected. 

5. Tick the Invert box to display which on-screen elements have not been selected.

Image Key

Lets you insert an image into the frame on top of the other image, which allows images to run 
alongside each other and lets you place inserts where you want them. 

Bluescreen and Greenscreen

When you add either of these effects, the Chromakey dialog box opens. Removes color from the 
front image to reveal the image behind it.

Matte Effects

See the following topics: 

• "Color Bars" on page 176

• "Color Matte" on page 176

• "Color Gradient" on page 177

• "Corner Gradient" on page 177

• "Simple 2D Shape" on page 177

• "Image" on page 178

Color Bars

Adds vertical color bars. 

Standard: Select 75% or 100% brightness 

Color Matte

Places a color over the top of the image. 

Color: Select the overlay color from the Color Palette or Color Picker tools.
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Color Gradient

Places a color gradient over the underlying image. 

Type: Select the gradient type from the drop down list. 

Color One/Color Two: Select colors for color one and color two. 

Color: Select the overlay color from the Color Palette or Color Picker tools. 

Extent: Drag the slider to regulate color extent. The smaller the extent, the more the image 
underneath shows through. 

Corner Gradient

Creates a color matte with a gradient to and from each corner. 

Colors: Select the overlay color for each corner from the Color Palette or Color Picker tools. 

Bounds: Drag the slider to adjust the offset of each edge from the image frame. 

Simple 2D Shape

Creates a rectangular or oval shape with foreground and background colors. 

Shape: Select Rectangle or Ellipse from the drop down list. 

Use the sliders to set: 
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• Position: X (horizontal) and Y (vertical) positions 

• Width 

• Height

• Softness 

• Foreground 

• Background 

Image

Places a user defined image over the screen. 

Image: Click on the triangle to open a file manager. Navigate to, and select the image you want to 
use. 

Position: Select the X, Y co-ordinates of the image.

Scale: Set the linear scale (Master) or set X and Y scales separately. 

Crop: Use the sliders to crop left, right, top and bottom edges of the image. 

Mix Effects

See the descriptions for Blend, Dissolve, Wipe, and Luna Wipe in "Chapter 9: Transitions" on 
page 147. 

Title Effects

There are three types of Title Effects: 

See the following topics: 

• "Setting Title Text and Font Properties" on page 179

• "Setting Title Text Color" on page 180

Crawling Titles: Titles that crawl horizontally across the screen 

Rolling Titles: Titles that roll down or up the screen

Static Titles: Static titles that are in a fixed position on screen 
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• "Setting Title Position and Movement" on page 181

• "Title Shadow" on page 182

• "Title Text Outline" on page 183

• "Effects (Static Titles only)" on page 184

Setting Title Text and Font Properties

To set the font, size and positioning of your title or caption: 

STEPS

1. Type the title or caption you require in the upper panel. 

You can enter multiple lines of text to: 

• display multi-line text in Static and Rolling Titles. 

• display separate messages or headlines that scroll horizontally in Crawling Titles. 

2. Any changes you make to the text display in the viewer in real time. 

3. Click on the Font tab if it is not already selected. 

4. Select the font you want from the Typeface drop down list. The fonts listed are those 
installed on your workstation. 

5. To select Bold and/or Italics styling, tick the named boxes. 

6. Drag the Size slider left or right to resize the text as required. 

7. Drag the Opacity slider left or right to adjust the opacity / transparency of the displayed text. 

3
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Setting Title Text Color

To set the color properties of your title text: 

STEPS

1. Click the Face tab to access the settings for the title color. 

2. Select the color style you require by clicking one of the following tabs: 

If you select Flat Color, only one color setting is available - Color Two is disabled. 

3. Click the box for Color One to open the Color palette. 

a) The color selector dialog box opens. 

b) Select the color you require using the RGB sliders, the color wheel, or the HSV text boxes 
and slider. 

4. Alternatively, click on the color picker and drag the mouse onto the section of screen that 
matches the color you want. Click again to select the color. 

5. Repeat steps 3 and 4 for the second color, using the color box or picker for Color Two. 

Flat Color: Set a single color for your text 

Vertical Gradient: Set a vertical gradient based on two colors 

Sheen: Create a reflective or sheen effect using two colors 

1
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Title Effects

Setting Title Position and Movement

To set the screen position of your title text: 

STEPS

1. Click the Position tab to access the settings for the title text positioning. 

2. Static Titles only: Click the Position side tab to reveal the controls for vertical (X), horizontal 
(Y) text offset. 

3. Static Titles only: Adjust the X and Y sliders to set the required vertical and horizontal 
positions for your title. Alternatively, type a percentage value in the text field to the right of 
the sliders. 

4. Rolling and Crawling Titles only: Adjust the Position and Progress sliders to set the required 
starting positions of titles. Alternatively, type a percentage value in the text field to the right 
of the sliders. 

5. Static and Rolling Titles only: Adjust the Leading slider to set the line spacing for titles that 
span across two lines or more, or type a percentage value in the text field to the right of the 
slider. 

6. Static and Rolling Titles only: Set the alignment for your title from the Anchor point drop 
down list. The options are Left, Center and Right. 

7. Crawling Titles only: Adjust the Spacing slider to set the horizontal spacing between 
messages, or type a percentage value in the text field to the right of the slider. 
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Title Shadow

To set properties for shadows on titles: 

STEPS

1. Click the Shadow tab. 

2. To enable the shadow effect, tick the Enabled box. 

3. To set the shadow color: 

a) Click the Color box. 

b) The color selector dialog box opens. 

c) Select the color you require using the RGB sliders, the color wheel, or the HSV text boxes 
and slider. 

d) Alternatively, click on the color picker and drag the mouse onto the section of screen 
that matches the color you want. Click again to select the color. 

4. Slide the vertical offset (X) to set the required vertical position for your shadow. 
Alternatively, type a percentage value in the text field to the right of the slider. 

5. Slide the horizontal offset (Y) to set the required horizontal position for your shadow. 
Alternatively, type a percentage value in the text field to the right of the slider. 

6. Adjust the Softness slider left or right to set the sharpness (left) or softness level (right) of 
your shadow. Alternatively, type a percentage value in the text field to the right of the slider. 

1
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Title Text Outline

To set the Outline properties for your titles: 

STEPS

1. Click the Outline tab. 

2. To enable outlining on your title text, tick the Enabled box. 

3. To set the outline color: 

a) Click the Color box. 

b) The color selector dialog box opens. 

c) Select the color you require using the RGB sliders, the color wheel, or the HSV text boxes 
and slider. 

d) Alternatively, click on the color picker and drag the mouse onto the section of screen 
that matches the color you want. Click again to select the color. 

4. Adjust the Size slider left or right to set the size (thickness) of the outline. Alternatively, type 
a percentage value in the text field to the right of the slider. 

1
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Effects (Static Titles only)

The Effects tab allows you to set how your title starts and ends. Rolling and Crawling Titles do not 
have an Effect tab. 

STEPS

1. Click the Effects tab. 

2. From the In drop down list, select how you want the title to start. The options are: 

• No effect 

• Fade (text fades in) 

• Typewriter (text appears one character at a time) 

3. From the Out drop down list, select how you want the title to end. The options are:

• No effect 

• Fade (text fades out) 

Look Up Tables

Look Up Table (LUT) files allow you to apply professional looking color grading to your media using 
just a single LUT file. You can also import LUT files from most color grading applications. 

Due to Licensing restrictions, a single LUT file is supplied. However, many more LUT files are 
available on the internet for download, either free or for a nominal charge. 

See the following topics: 

• "Applying a Global LUT" on page 185

• "Importing LUT Files from the Project Card" on page 186

• "Importing LUT Files from the Timeline" on page 187

1
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Look Up Tables

Applying a Global LUT

You can set a global LUT for your project in the Project Card. All the clips and edits in your project 
will have the same LUT applied to them. Global LUT settings are best used with footage shot from 
the same camera to maintain a consistent look. 

STEPS

1. Open the Project Card and click on the Video tab. 

2. Click on the pointer for the Viewing LUT drop down list. 

3. A list of available LUTs opens. Click to select the LUT you require. 

4. The Viewing LUT button changes to green, indicating that the currently selected Global LUT 
is active. 

5. To change the Global LUT, repeat steps 1 to 3. 

6. To disable Global LUTs, click the Viewing LUT button again. The button changes to grey. 
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Importing LUT Files from the Project Card

The following LUT file formats are supported: 3dl, cube, davlut, look, and mga. LUT files 
cannot be exported in YouTube, Vimeo or DVD export options. 

To import LUT files: 

STEPS

1. Open the Project Card, click on the Video tab (A), click the drop down list pointer (B) and 
then click Browse (C). 

2. The File Manager opens. Navigate to the folder where your LUT files are stored. 

3. Click on a single file to select it, or hold down the Shift or Ctrl (Cmd on OS X) key to select 
multiple files. You can also select folder icons. 

4. Click OK. The selected LUT files are added to drop down list, and are available in the Global 
LUT and Single source LUT lists. 

B

C
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Importing LUT Files from the Timeline

To import LUT files from the Timeline: 

STEPS

1. Select the VFX tab, right-click in a video track and, from the menu that opens, select Effects 
> Add > Color > 3D LUT. 

2. When the 3D LUT effect panel opens, click on the drop down menu. 

3. A list of LUT items displays. Click on the Browse button. 

4. The File Manager opens. Navigate to the folder where your LUT files are stored. 

5. Click on a single file to select it, or hold down the Shift or Ctrl (Cmd on OS X) key to select 
multiple files. You can also select folder icons. 

6. Click OK. The selected LUT files are added to drop down list, and are available in the Global 
LUT and Single source LUT lists. 

3
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Exporting LUTs

You can include LUTs when exporting your work to a flattened file, by enabling the ‘Use project 
viewing LUT’ box on the Export panel. This option is not available on the YouTube, Vimeo or DVD 
export options. See "Exporting a Clip, Subclip, or Sequence" on page 216. 

Keyframes

See the following topics: 

• "Keyframes" on page 188 

• "About Keyframes" on page 188 

• "Working with Keyframes" on page 189 

• "Adjusting Keyframes" on page 190 

• "Saving Effects Templates" on page 191 

• "Disabling and Enabling Keyframes" on page 192 

About Keyframes

Most effect parameters are keyframeable. Keyframes allow you to specify the value for an effect 
parameter at any point in time within an effect. This allows properties of the effect to be varied as 
the effect progresses through time. The system by default interpolates between the values set at 
each keyframe, resulting in a smooth transition between adjacent key frames. 

The keyframe buttons for most parameters are deselected by default. In this mode, 
adjustments to a parameter are applied for the duration of the effect. 

The Progress parameter is present on all effect configuration dialog boxes. You can use the 
Progress slider to control the progress of an effect through time. For example, it sets, the position 
of a wipe at a particular time. Unlike other parameters, Progress for most effects defaults to being 
Keyframeable. Initially, it has two Keyframes: 

• one at the start of the effect where its value is 0% 

• one at the end where its value is 100% 

By adding keyframes to the Progress parameter, the effect can be made to assume different 
positions at different times. For example, the wipe can be made to stop, reverse and then continue 
to the end. As with other parameters, keyframes for Progress can be turned off. In this case, the 
effect assumes the value set on the progress slider for the duration of the effect. In this state the 
effect is static. This is useful for creating a static wipe, for example.
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Working with Keyframes

The following example shows how keyframes are added and adjusted in the Luma Wipe effect: 

STEPS

1. Click on the Graph button at the top of the Configuration dialog box to toggle between 
Configuration and Keyframe views. 

2. When the Graph view is open, all the keyframes display within the current effect, showing 
how their values vary over time. 

3. A timeline indicator displays the current playing position within the effect. 

4. To add a keyframe: 

a) Move the timeline marker to the required position on the timeline. 

b) Click the Add (+) button in the keyframes area. 

5. To zoom in or out of the graph view, click Zoom In (+) or Zoom Out (-). 

6. To move the timeline indicator, drag the pointer with the mouse. 

7. Each keyframe has a marker on the graph line. To select a keyframe: 

a) Hover the mouse over the keyframe marker. 

b) When the mouse cursor changes to a cross, click to select the keyframe. To select 
multiple keyframes, press Ctrl+click (Ctrl+Cmd for Mac OS) on the required keyframes. 
To select all keyframes, right-click on a keyframe and then click Select all. 

8. To jump to a keyframe, click the Previous (<) or Next (>) button. Alternatively, assign 
keyboard shortcuts to do this.

9. Keyframes also display in the status bar. When a keyframe is selected, it is highlighted in 
yellow. 

10. To remove the selected keyframe, click the Remove (-) button. Add, Remove, Previous and 
Next controls are replicated at the bottom left corner ‘A’.

Add, Remove, Previous and Next controls are replicated at the bottom left corner ‘A’.
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Adjusting Keyframes

To adjust the value and position of keyframes: 

STEPS

1. To change the value of a keyframe, click the keyframe and drag it vertically to the value you 
want. 

2. The effect at the current time updates in the Sequence viewer and in the Keyframes area. 

3. To change the position of a keyframe, click the keyframe and drag it horizontally to the 
position you want. 

To move multiple keyframes, do one of the following: 

• Ctrl+click (Ctrl+Cmd on Mac) on the keyframes you want and then drag them as a group. 

• Hold down the left mouse button and draw a rectangle around the keyframes you want 
to select. 

• To select all keyframes, right-click on a keyframe and then click Select all. 

4. To toggle the effect ON or OFF, click the Bypass button. The effect toggles ON and OFF in the 
Sequence viewer. 

5. (Option) Change the type of interpolation - Smooth or Linear - by clicking anywhere in the 
dialog box while holding down the SHIFT key. The type of interpolation toggles between: 

a) Smooth

b) Linear

6. To toggle the interpolation between two keyframes only, click anywhere in the dialog box 
while holding down the Ctrl key (Cmd key on Mac). 

5a

41,3

5b
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Saving Effects Templates

You can save an Effect and its parameters in a template for use later without recreating the effect 
from scratch. 

STEPS

1. Right-click directly outside on Effect panel and, from the menu that opens, select ‘Save as 
template’. 

2. The Template dialog box opens. 

3. Type a name for your effect. Choose a name that best explains what the saved effect will do. 

4. Select a Category type from the drop down list. 

5. Select a Subcategory type from the drop down list. 

6. Tick the ‘Add to favorites’ box if you want the newly saved effect to display in the Favorites 
area of your effects list. This is useful if you use the effect frequently, allowing it to be 
accessed quickly from contextual menus. 

7. Add a description in the text box that will help you to remember the details of what the 
saved effect achieves. 

8. Click Do It. 

9. Your template is saved to the Add Effects list box. If you ticked the ‘Add to favorites’ box, the 
template displays when you select Favorites from the Category drop down list. 

1a
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Disabling and Enabling Keyframes

Keyframes are enabled by default. To enable or disable keyframes: 

STEPS

1. Make sure the Edit tab is selected. 

2. Right-click in one of the Timeline tracks. 

3. From the menu that opens, click on Timeline Commands > Settings. 

4. The Timeline Settings panel opens, with the Appearance tab selected. 

5. From the Keyframes drop down list, select: 

Yes: To enable keyframes 

No: To disable keyframes 

Automatic: Let Lightworks decide 
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The Video Routing Panel is designed to manage your multi-track effects compositions. It is a node 
based system allowing you to build up blocks and set the flow of your effects through each stage 
of your project. See the following topics: 

• "Using the Video Routing Panel" on page 193

• "Working with Nodes" on page 194

• "Adding a Basic Effect" on page 194

• "Creating a Split Screen Effect" on page 196

Using the Video Routing Panel

To use the Video Routing Panel, you must have the Edit and Timeline viewers for your project open. 

STEPS

1. Make sure you have the VFX tab selected. 

2. Click on the Routing tab. The Video Routing panel displays. 

3. The nodes and blocks display in the main panel. 

4. To change the direction of flow of the nodes, right-click in the panel and, from the menu that 
opens, select Orientation > ‘Left to right’ or Orientation > ‘Bottom to top’. 

5. To readjust the nodes in the main panel, right-click in the panel and, from the menu that 
opens, select Tidy. 

12
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6. Use the horizontal (A) and vertical (B) scroll bars to move the Video Routing panel to reveal 
Nodes that beyond the edges of the panel frame. 

7. To zoom in and out, hover your mouse over the edge of a scroll bar until the cursor changes 
to a double-ended arrow, then click and drag to zoom. 

Working with Nodes

You can manage nodes as follows: 

STEPS

1. Each node displays a thumbnail of the original clip. 

2. The name of the original clip displays in the title bar. 

3. To delete an effect node, right-click on the node and, from the menu that opens, select 
Remove. 

4. While holding down the left button anywhere in the panel, drag your mouse to position all 
the nodes on the display at once. 

5. To move effect node pairs, for example the split screen node pairs: 

a) Click drag with the mouse to move one node independently of the other. 

b) Hold down the shift key while click dragging to move both nodes at once. 

6. To swap inputs on node, right-click on the node and, from the menu that opens, select ‘Cycle 
inputs’. 

Adding a Basic Effect

See the following topics: 

• "Adding an Effect to a Node" on page 195

• "Swapping an Effect" on page 196
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Adding an Effect to a Node

The procedure described below describes adding a blur effect to a Node. This procedure is the 
same for most effects, although the settings for each effect vary significantly. 

The Blur effect can be applied to text as well as graphics. 

STEPS

1. Select the VFX tab and then select the Stylize menu. 

2. Using the mouse, drag the Blur effect over the Routing tab. 

3. When the Video Routing panel opens, release the mouse button to drop the Blur node into 
the middle of the panel. 

4. Drag the mouse to create a link from the output of the first node to the input of the Blur 
effect. 

5. Do one of the following: 

• Right-click on the Blur node and, from the menu that opens, select Settings. 

• Click on the Settings tab. 

6. The Blur Settings dialog box opens. 

7. Move the slider to the left to decrease the amount of blur, or to the right to increase blur. 
Changes you make are updated immediately in the media viewer. 

3,52
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Swapping an Effect

You can change out one Effect for another in one operation without deleting the old effect first: 

STEPS

1. Select the new Effect and drag it over the Routing tab.

2. When the Video Routing panel opens, position the new node onto the node you want to 
replace, and then tap the right mouse button to ‘drop’ in the new Effect. 

3. The old Effect is removed and is replaced by the new Effect. All the connections are 
maintained. 

Creating a Split Screen

See the following topics: 

• "Creating a Split Screen Effect" on page 196

• "Adding a Color Tint" on page 198

• "Creating a Split Screen Effect with Background" on page 199

• "Adding Titles" on page 200

• "Adding a Wipe Transition" on page 201

Creating a Split Screen Effect

To add a Split Screen effect: 

STEPS

1. Make sure you have two video tracks enabled in the Sequence viewer, populated with the 
clips you want in your Split Screen effect. 

2. From the DVE menu, drag the Split Screen effect with your mouse over the Routing tab. 

3. When the Video Routing panel opens, release the mouse button to drop the Split Screen 
node into the middle of the panel. 

4. The Left Picture and Right Picture nodes pair display in the Video Routing panel. 
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5. Drag the mouse to link the connector of the first node to the Foreground (Fg) connector of 
the Right Picture node. 

6. Drag the mouse to link the connector of the second node to the Foreground (Fg) connector 
of the Left Picture node. 

7. Do one of the following: 

• Right-click on the Left Picture or Right Picture node and, from the menu that opens, 
select Settings. 

• Click on the Settings tab. 

8. The Settings panel opens. 

9. If the clips do not display side by side in the Sequence Viewer, make sure the Left and Right 
Picture effects are enabled, that is, both indicators are green. 

3,4
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Adding a Color Tint

To add a color tint to a node: 

STEPS

1. From the Effects drop down list, select Colour. 

2. The Color options display in the main panel. Click on the color effect you want and drag it 
on to the Routing tab. 

3. When the Video Routing panel opens, position the effect over the clip you want to apply the 
effect to, and release the mouse button. 

4. The tint node is inserted between the clip and the Picture node. 

5. The color tint displays on the affected clip in the Edit viewer. 

6. Do one of the following: 

• Right-click on the tint node and, from the menu that opens, select Settings. 

• Click on the Settings tab. 

7. When the Settings panel opens, make any changes you want to the effect, as described in 
"Chapter 10: Effects" on page 157. 

2 3 41 6
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Creating a Split Screen Effect with Background

You can add a background image to the Split Screen effect as follows: 

STEPS

1. Make sure you have two video tracks enabled in the Sequence viewer, populated with the 
clips you want in your Split Screen effect. 

2. From the DVE menu, drag the ‘Split Screen+bg’ effect with your mouse over the Routing tab. 

3. When the Video Routing panel opens, release the mouse button to drop the ‘Split 
Screen+bg’ node into the panel. 

4. The Left Picture, Right Picture and Background nodes display in the Video Routing panel. 

5. Drag the mouse to link the connector of the first node to the Foreground (Fg) connector of 
the Right Picture node. 

6. Drag the mouse to link the connector of the second node to the Foreground (Fg) connector 
of the Left Picture node. 

7. The Sequence viewer displays the background image behind the two Split Screen images. 

8. Do one of the following: 

• Right-click on the Background node and, from the menu that opens, select Settings. 

• Click on the Settings tab. 

9. The Settings panel displays. 

10. Edit the Background node settings as described in "Split Screen with Background (+bg)" on 
page 173. 

9
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Adding Titles

To add a title to your project, you need to add a Titles Effect and feed it with your video output to 
a Blend Option: 

STEPS

1. From the Categories drop down list, select Mix. The Mix options display in the panel. Click 
on the mix you require, for example, Blend, and drag it on to the Routing tab. 

2. When the Video Routing panel opens, position the Blend effect inside the Video Routing 
panel and release the mouse button. 

3. From the Categories drop down list, select Text. The Titles options display in the panel. 

4. Click on the title effect you want and drag it on to the Routing tab. 

5. When the Video Routing panel opens, position the selected effect inside the Video Routing 
panel and release the mouse button. 

6. Connect the output of the Titles node to the Foreground (Fg) input of the Blend Effect. 

7. Connect the output of the Right Picture node to the Background (Bg) input of the Blend 
Effect. The default caption ‘Sample text’ displays in your edit. 

8. To change the appearance or blending of the title text, right-click the Titles or Blend nodes 
and, from the menu that opens, select Settings. The Effects panel opens. See "Title Effects" 
on page 178. 

34 6 75
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Adding a Wipe Transition

In this example we are transitioning from the Split Screen effect to a single screen using the Wipe 
effect. 

STEPS

1. From the Categories drop down list, select Mix. The Mix options display in the panel. Click 
on Wipe and drag it on to the Routing tab. 

2. When the Video Routing panel opens, position the Wipe effect inside the panel and release 
the mouse button. 

3. Connect the output from your project to one input of the Wipe effect. 

4. On the node you want to transition to, connect its output to the other input of the Wipe 
effect. In this example we are reusing a node from the Split Screen example. 

5. Play the project and check that the video wipes from the first clip to the second clip in the 
correct sequence. To change the playing order, right-click on the Wipe node and select 
‘Cycle inputs’ from the menu. 

6. Click on the Graphs tab. When the Keyframes panel for the effect opens, click on the graph 
icon. 

7. The Keyframes panel displays. 

8. Adjust the Progress line to change the rate at which the wipe changes. See "Adjusting 
Keyframes" on page 190. 

9. Click on the Settings tab to open the Wipe settings dialog box. Adjust the wipe settings as 
described in . 

4
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This chapter describes the methods for importing media, supported file types and formats. 

You can import media from your local folders and network drives. The media you import should 
have frame rate that is compatible with your project. (Clips with incompatible frame rates may be 
playable in a new project set to the same frame rate as that clip.) 

See the following topics: 

• "Importing Clips into a Project" on page 27

• "Import Destination" on page 203

• "Supported Import Formats" on page 205

• "Audio Files in 30 fps and 24 fps Projects" on page 214

Import Destination

In order to import media to your project, you must have a media drive to hold all the relevant data. 
By default, Lightworks creates and uses the following locations for all media imports: 

If you have upgraded from an earlier version, Lightworks may be using the default location that 
was set in that version of Lightworks. 

If you do not want to use the destination folder set by Lightworks, or you want to organize your 
media imports into separate folders, you can create alternative destination folders and choose 
which one you want to use when you import media. 

The Content Manager opens to reveal newly imported media in the Recent or Search Filter, a user 
defined option. 

See the following topics: 

• "Creating an Import Destination" on page 204

• "Removing an Import Destination" on page 204

• "Selecting an Import Destination" on page 205

Windows: C:\Users\Public\Documents\Lightworks\Media

Linux:  /home/USER ACCOUNT/lightworks/media

Mac OS X:  /Users/USER ACCOUNT/Lightworks/Media
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Creating an Import Destination

To create an alternative import destination: 

STEPS

1. Open the project card and select the Media tab. 

2. When the Media panel opens, click the Locations tab. 

3. Click the Add button. 

4. The Add Folder Location browser opens. 

5. Navigate to the location you want to use. If you need to create a sub folder, click the ‘Create 
New folder’ button, type the folder name and click OK.

6. When you have selected your new destination folder, click the OK button. A Material and 
Sound folder is created in the specified location. 

7. The new destination displays in the Media Locations panel of the project card. 

Removing an Import Destination

When you remove an import destination, you will no longer be able to see media files stored in that 
location. However, the media stored at those locations will not be deleted, nor will any logs 
referenced to it. If you add a location that was previously deleted, any media in that location will 
be available to use again. 

To remove an import destination: 

STEPS

1. Open the project card and select the Media tab. 

2. Click on the media location to select it for deletion. 

3. Click the Remove button. A message box displays, warning you that you are about to 
remove a media location. 

4. Click Yes to remove the entry from the Project card, or No to cancel. 

2
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Selecting an Import Destination

To change the Import destination on import: 

STEPS

1. Right-click on a clip or clips that you want to import. 

2. The Import Commands dialog box opens. 

3. Select Destination > Media Location. 

4. From the drop down list that opens, select the media location you require. If you select Auto, 
Lightworks chooses the location with the most free space available. 

Supported Import Formats

You can import the formats and types of files described in the following list: 

• “Preliminary Support for Blackmagic RAW Files” on page 206

• "Stereoscopic Media" on page 206

• "Single Images" on page 208

• "Image Sequences and DPX Sequences" on page 209

• "AVI, AVCintra, MOV, MXF, MPEG, MTS, M2T and M2TS Video" on page 209

• MXF P2 and XDCAM in SD and HD formats

• Avid DNxHD. For further information, refer to the Lightworks Shop 
(www.lightworks.com/shop). 

• QuickTime. You can import QuickTime files encoded with the Apple ProRes codec. The 
Quicktime Player must be installed (Windows 32-bit only).

• "Advanced Authoring Format (AAF) and XML Import" on page 210

• "Avid Log Exchange (ALE) Files" on page 211 

• "Open Media Framework (OMF) Files" on page 212

• "RED (R3D)" on page 212

• "WAV Files" on page 213

• "Audio Files in 30 fps and 24 fps Projects" on page 214 

• CinemaDNG files 

• Edit Decision Lists (EDL)

2
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For a complete list of supported formats, see http://www.lwks.com/techspecs

Preliminary Support for Blackmagic RAW Files

In Lightworks 14.5 it is possible to import these new types of files. On Linux installs these file types 
should work by default but on Windows and Mac systems you will need to have installed Resolve 
15.x and then copy the files mentioned below. 

• On Windows: Open a command prompt with administrator rights and type regsvr32 
“C:\Program Files\Blackmagic Design\DaVinci 
Resolve\BlackmagicRawAPI.dll

• On Mac: Show the Resolve.app package contents and copy the BlackmagicRawAPI.framework 
to /Library/Frameworks

Stereoscopic Media

You can import stereoscopic media if it is named correctly. All stereoscopic media must be of the 
same duration and contain the words ‘left’ or ‘right’ in the otherwise identical filename in the same 
position, for example, clip001left.mxf and clip001right.mxf. Lightworks imports pairs of 
files as a single synced file.

For information about selecting stereoscopic 3D options, see "Stereo 3D Tab" on page 122. 

To import stereoscopic media:

STEPS

1. Make sure the pair of files you want to import has identical filenames with the exception of 
“left” or “right” in the same position in the filename.
For example, clip001left.mxf and clip001right.mxf will import successfully. A pair 
named clip001left.mxf and rightclip001.mxf will not import successfully.

2. Make sure the pair of files have identical durations. A pair with different durations will not 
import successfully. 

3. Navigate to the folder containing the pair of files you want to import. Lightworks displays 
these file pairs as a single file, with the identifier ‘(L/R)’ appended to the file name. 

4. The pair are synced into a single file and displayed in the Recent filter of the Content 
Manager. 
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5. Flexible project layout only: 

a) The video track column displays L-R instead of V1, confirming that Lightworks 
successfully synced the two cameras and created a V track from the pair of files. 

b) Open the shot in the Timeline. A single V track displays that contains V1 L and V1 R. 
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Single Images

Importing a single image (BMP, JPG, PNG, TGA, and so on) produces a clip with a single frame in the 
project. The original aspect ratio of the image is maintained. You can add black borders to the top 
or sides of the image to make it fit a standard viewer for the current resolution. Images larger than 
the standard current resolution are reduced to fit a standard viewer.

Setting Image Duration

To set the playing time of a still image: 

STEPS

1. Select the image you want to import, and then right-click on the Import button. 

2. From the menu that opens, click on ‘Stills Duration (seconds). 

3. Select the duration you require from the drop down list. 

Still Images over Background Video

You can key still images over background video, via the Image Key feature of the effects tool. Unlike 
image import, image key does not convert the files to a piece of video, but is referenced in its 
original state. This allows graphics files with an alpha track to be keyed over a video background. 
It also gives the user more control over which part of the image is seen, and where it is to be placed 
within the viewer. 

1
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Image Sequences and DPX Sequences

In the same way that you can import single frames, you can simultaneously import a sequence of 
images, including Digital Picture Exchange (DPX) to form a single clip in Lightworks. 

STEPS

1. Right-click on the Import button and, from the menu that opens, make sure the Video > 
‘Detect image-sequences’ option is enabled. 

2. Select the multiple clips you require for your image sequence, and click the Import button. 

AVI, AVCintra, MOV, MXF, MPEG, MTS, M2T and M2TS Video

The following video file formats can be imported: 

• AVI 

• AVCintra 

• MOV

• MXF

• MPG, MPEG, MTS, M2T and M2TS

Windows 32-bit only: You should ensure that QuickTime v7, or later, is installed on your system 
before importing files. This allows a wider range of formats to be imported, and allows Quicktime 
Movie export. For more information on downloading QuickTime, refer to www.apple.com. 

MXF Import

Sometimes when importing an MXF file, the file is split into a number of separate chunks. 
Lightworks can import all these separate chunks and merge them into one file. To merge the 
chunks into one file: 

STEPS

1. Right-click on the Import button and, from the menu that opens, make sure the Video > 
‘Detect split MXF files’ option is enabled. 

2. If the setting is disabled, each MXF chunk will be imported as a separate file. 
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Advanced Authoring Format (AAF) and XML Import

Lightworks supports AAF / XML files from many applications including Avid, Resolve, and Protools. 
When you import an AAF, the frame rate of the AAF must match the frame rate of the project. 

XML files generated from Final Cut Pro 7 are also supported. These can be imported as long as they 
adhere to the XML version 5 protocol. Versions 4 and earlier cannot be imported. 

AAF files with embedded audio information can also be imported. This information is extracted 
from the AAF and a new media file created on the media drive. If the AAF contains media locators 
to a location that is available, Lightworks imports this media automatically using the locators 
specified in the AAF. You must make sure that the ‘Search for media’ option is set to Simple or 
Thorough. 

If the media locators exist but the location is not available, for example, a network path no longer 
exists, Lightworks still imports the edit and creates empty dummy clips that cannot be relinked as 
there is no media link file. In this scenario there are two options available: 

1) Manually import all the media into the same project as the AAF / XML and on the edit 
settings menu select Find >Clips to fill edit and relink the media this way. 

2) If you have access to all the media that the AAF / XML file references, then you can move the 
file into the same location and import it. Lightworks attempts to import the media located 
in the same folder as the AAF / XML, and fill the edit with this media. 

To import AAF / XML files: 

STEPS

1. Right-click on the Import button. 

2. From the menu that opens, locate AAF/XML Options > Search for media. 

• Select No if you do not want relink media. 

• Select Simple to look in the AAF/XML folder to find media, or use the media locators in 
the AAF if the path exists. 

• Select Thorough to look in the AAF/XML folder to find media along with all child folders 
in the tree. 
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Avid Log Exchange (ALE) Files

ALE (Avid Log Exchange) files from post production houses or Avid editing systems can be 
imported. All the media is imported with the ALE and the data contained in the ALE is added to the 
imported media. 

You cannot import an ALE file unless its corresponding media resides in the same folder 
location. 

In order for the ALE import to succeed, the media must match the data supplied in the ALE. The 
four parameters used are: Reel ID, Start Timecode, Name and Duration. The import process looks 
at this data in the ALE then proceeds to find a file with the matching metadata in the same location 
as the ALE. If the ALE track information differs from the number of tracks available in the media, the 
import will also fail. 

The Import Tool has media matching and track matching settings to overcome these issues as 
described below: 

STEPS

1. Right-click on the Import button. 

2. From the menu that opens, select ALE Options > Media-matching tolerance. Set the option 
you require from the drop down list: 

3. Repeat step 1 and, from the menu that opens, select ALE Options > Track-matching 
tolerance. Set the option you require from the drop down list: 

Strict: Matches are based on all of the following parameters: Name, Reel, Start TC, 
and Duration (to within 1 frame).

Semi-Strict: Matches any two of the original parameters, plus Duration

Not Strict: Matches any one of the original parameters, plus Duration 

Strict: Start Timecode, Duration, Name and Reel ID between the ALE and the 
available media are matched 

Semi-Strict: Start Timecode, Duration - and Name or Reel - between the ALE and the 
available media are matched 

Not Strict: Start Timecode and Duration between the ALE and the available media are 
matched 
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Open Media Framework (OMF) Files

The sound and edit-decision parts of the Open Media Framework (OMF) standard are supported. 
Any picture material contained in the OMF file is discarded on import.

OMF files with more than 16 audio tracks cannot be imported.

When you import OMF files, the audio sample rate of the file must match the audio sample rate of 
the project. 

Also consider the following:

• Composition information and media data. Although OMF interchange files allow applications 
to store the media in separate files from the composition information, media files must be 
embedded into the OMF file (and not stored in an external file) when importing.

• OMF edit rate. When you import an OMF file, the edit rate of the file must match the edit rate 
of the project. For example, if you are working in a 25fr project, the OMF edit rate must be 25.

• Source track mapping for OMF assigns imported material. When the OMF source material is 
imported, the first referenced audio track is assigned to A1, the second to A2, and so on. This 
happens even if the audio tracks were A3 and A4 on the original source tape. This does not 
affect the imported material as it is used in the imported composition (the edit). 

If you want to re-digitize the audio from the original tapes using the imported information 
from the OMF composition, you need to manually confirm that the correct audio tracks are 
being recorded. This can be done by patching the source device so that audio tracks are all 
recorded as A1, A2. 

The extra track mapping data is contained within the OMF format, but this information is not used 
by Lightworks to create the audio material. 

RED (R3D)

You can import RED files into Lightworks. See the following topics: 

• "About RED Files" on page 212

• "Importing R3D Files" on page 213

About RED Files

You can import RED R3D natively. You can choose full resolution or one of the standard reduced 
resolution modes (½, ¼) to change the decode quality of the imported R3D file. Currently R3D files 
with aspect ratios of 4:3 or 16:9 are supported. No R3D export is available.

There are some performance considerations when you use RED R3D files with your system. 
Depending on the workflow and formats required, older systems might require a hardware 
upgrade. 

Working natively with sequences of R3D files is very demanding on disk storage, CPU, and 
graphics card performance, particularly at higher resolutions. 

For file-based operations, a conform (render) to DPX is also possible. However you must provide 
adequate storage capacity and performance.
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Importing R3D Files

To import R3D files:

STEPS

1. Select the R3D file or files you want to import and click the Import button. 

2. The file imports. Click on the Project name at the top-left corner of the workspace.

3. The Project panel opens. Click on the Video tab if it is not selected. 

4. Click on the drop down list to the right of the RED decode quality field, and select the 
required resolution from the list. 

5. Set the source for R3D decode settings from the Decode Using drop down box. If you select 
‘Project Settings’, the following settings are enabled: 

a) Kelvin 

b) Tint 

c) Exposure

d) Saturation

e) Contrast

f) Brightness 

Review and adjust the settings as necessary. 

6. Click Apply. 

7. The R3D file opens and plays at the resolution you selected. 

8. If your workstation performance allows it, you can select a higher resolution when the edit 
is ready for playout. 

WAV Files

WAV files containing up to 16 tracks can be imported. Any WAV files conforming to the RIFF 
standard and using PCM audio encoding can be imported. This includes uncompressed Broadcast 
Wave Format (BWF) files.
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Audio Files in 30 fps and 24 fps Projects

You may find audio files run at the incorrect speed in 30 fps or 24 fps projects. The default setting 
for 24 fps projects is ‘picture at 24 fps’ but that the audio may run in sync with 23.98 or 25 fps 
projects, likewise 30 fps audio can be synced to 23.97 fps. 

Prior to import, you should always check the pre-ingest setting in the Audio only media menu as 
follows: 

STEPS

1. Navigate to the drive and folder containing the files you wish to import, and right-click on 
the Import button. 

2. From the menu that opens, select Audio-only mode > Pre-ingest sync. 

3. From the Pre-ingest sync drop down list, select the frame rate you require. 

4. Proceed to import your files as described in the previous sections. 
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For procedures about exporting media, and for information about supported file types and 
formats, see the following topics: 

• "Export Formats" on page 215

• "Exporting a Clip, Subclip, or Sequence" on page 216

• "Export Format Options" on page 217

Export Formats

You can export edits, clips, and material to any local, removable, or network drive recognized by 
the operating system. 

Only YouTube and Lightworks Archive export options are supported in Lightworks Free. 

A Lightworks Pro license is required to use other export options, this can be purchased from 
the Lightworks Shop (www.lwks.com/shop). 

Supported export formats are listed below: 

Media Files Camera Formats Interchange Targets Backup

AVI AVCHD AAF Blu-ray Lightworks Archive

H264 / MP4 P2 AVC-Intra EDL DVD

Image Sequence RP2027 AVC-Intra Film Cutting List Vimeo (H.264/MP4)

MOV XAVC-Intra OMF YouTube (H.264/MP4)

MPEG-4 † XDCAM EX Reaper 

MXF XDCAM HD XML 

QuickTime †

WAV

WebM

WMV

† QuickTime player required on Windows 32-bit only
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Exporting a Clip, Subclip, or Sequence

To export a clip, subclip, or sequence: 

STEPS

1. Right-click on a clip, subclip, sequence, sequence viewer or timeline and, from the menu 
that opens, select Export. 

2. Select the export format you require from one of the sub-menu headings, User Presets, 
Targets, Backup, Interchange, Media files, or Camera formats. 

The range of export formats available to you varies according to the version of Lightworks (Free 
or Pro) that you have. 

3. The Export options dialog box for the selected format opens. 

4. Complete the settings you require and then click Start. 

2
2

1

1
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Export Format Options

See the following topics: 

• "Uploading to Vimeo or YouTube" on page 217

• "Media Files" on page 218

• "Lightworks Archives" on page 219

• "Exporting AAF Files" on page 220

• "Blu-Ray and DVD Export" on page 222

Uploading to Vimeo or YouTube

A connection to the internet and a valid Vimeo user account are required. 

Lightworks Free allows a maximum resolution of 720p. 

To upload your media directly to Vimeo: 

STEPS

1. From the Format drop down list, select Vimeo - which is listed under ‘Targets’. 

2. Select the frame rate you require from the Frame rate drop down list. 

3. Select the definition you require from the Size drop down list. 

4. Select what you want to upload from the Region drop down list. Choose from Marked 
section, Whole sequence or Ignore leading/trailing black. 

5. If you are uploading your media directly to Vimeo.com/youtube.com:

a) Enable the ‘Upload to Vimeo.com/youtube.com’ box.

b) Click the Log In button. Your web browser loads the Vimeo/YouTube log in page.

c) In your web browser, log into Vimeo/YouTube with your user name and password.

d) Once logged in, your Vimeo/YouTube user name displays in the Export panel.

6. Optional: Type any tag words you want associated with your media. 

7. Optional: Select the destination drive and folder where local copies of the exported media 
are to be saved.

8
9

5a, 6a

1
2
3
4

5b

10

5d
7
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8. Optional: Type a name for the exported file. 

9. Click Start. 

a) The Project Card opens, displaying the progress of the export in the Tasks tab. 

b) Click on the image thumbnail to view the export task in a larger window. 

c) When the export has completed, a report displays in a Tasks Log window. 

Media Files

This section describes the export parameters for the following media file formats: AVI, H264 / MP4, 
Image Sequence, MOV, MPEG-4, MXF, QuickTime, WAV, WebM and WMV. Note that QuickTime 
player is required for MPEG4 and QuickTime on Windows 32-bit systems. 

STEPS

1. From the drop down list, select one of the formats listed under ‘Media files’. 

2. Select the video size and frame rate you require from the Size/rate drop down list. 

3. If the Compression type drop down list is visible, select the compression type you require 
from the list. 

4. Set the audio option you require from the Audio location drop down list: 

5. Check the Use marked section box if you want to export just the marked section on the 
timeline, rather than the whole edit. 

6. (Option) Select the destination drive for the exported media.

7. (Option) Type a name for the exported file.

8. Click Start. The Project Card opens, displaying progress of your export in the Tasks tab. 

9. Click on the image thumbnail to view the export task in a larger window. 

10. When the export has completed, a report displays in a Tasks Log window. 

If you have enabled the project wide LUT setting on the video tab of the project card, 
see “Video Tab” on page 118, another export option appears on the export panel.

 This option is the ‘Use project viewing LUT’ checkbox. When ticked, it will export the 
file with the enabled project LUT, when unticked, the project LUT will be ignored. 

If you have not enabled the project wide LUT then the option will not appear. This is only relevant 
for file based media exports, for example, it will not be present for interchange backup options.
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Lightworks Archives

You can export whole projects, the contents of whole bins, or single clips (logs and/or material), 
subclips or edits, from Lightworks. You can export in the Lightworks format for backup purposes 
or for reimport into other Lightworks systems.

Lightworks-format exports are not interchangeable with any other applications or systems. 

Exporting in Lightworks format creates an ARCHIVE folder with a name derived from the name of 
the backed-up object. 

STEPS

1. Ensure ‘Lightworks archive’ is selected from the Format drop down list. 

2. Option: Tick the box ‘Include local media’ to include local media files in your archive. 

3. Option: Tick the box ‘Include linked media’ to include linked media in your archive. 

4. If a Lightworks archive already exists, select one of the options from the ‘If archive exists’ 
drop down list: 

• Update. Adds any new clips or edits to the currently saved archive.

• Overwrite. Overwrites the saved archive with the new version.

• Create New. Saves the backup as a new file, with a .1 suffix in the filename.

5. (Option) Select the destination drive for the exported media.

6. (Option) Type a name for the exported file.

7. Click Start. 

a) The Project Card opens, displaying progress of your export in the Tasks tab. 

b) Click on the image thumbnail to view the export task in a larger window. 

c) When the export has completed, a report displays in a Tasks Log window. 
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Exporting AAF Files

A Lightworks Pro license is required. 

AAF (Advanced Authoring Format) is a file format that allows sound and edit decision data to be 
exchanged between applications and systems. If you are exporting to Protools, see 
"Recommended Settings for Protools" on page 221. 

STEPS

1. Ensure ‘AAF’ is selected from the Format drop down list. 

2. From the Target drop down list, select the application you are exporting to. 

3. Select the audio format settings as follows: 

a) Select WAV or AIFC from the Embedded audio drop down list. 

b) Select the conversion sample rate from the drop down list.

If the destination system cannot handle mixed sample rates, select Force 32 kHz, Force 
44.1 kHz or Force 48 kHz. 

When exporting to targets that are not Lightworks, select Force 48kHz. 

Otherwise, select Keep original. 

c) Set the sample size from the drop down list. The options are 16 bit or 24 bit. 

d) Select the Audio clip handle time, in seconds, from the drop down list. This consolidates 
the audio media with extra media not used in the edit, which is very useful when 
sending an AAF file to Protools. 

The options are: 0, 1, 2, 4, 6, 8, 10, 15 or 20. 

4. Depending on the features the target application supports, tick to select or untick to 
deselect the following options: 

a) Remove audio clip gain - this removes clip sound information from edits 

b) Remove track sound levels 

c) Flatten sequence - this removes sub-edit information 
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5. Select the destination drive and folder for the exported media. 

6. Type a name for the exported file. If this field is left blank, a filename derived from the Edit 
name will be generated. 

7. Click Start. 

a) The Project Card opens, displaying the progress of your export in the Tasks tab. 

b) Click on the image thumbnail to view the export task in a larger window. 

c) When the export has completed, a report displays in a Tasks Log window. 

Recommended Settings for Protools 

The following settings are recommended when exporting to Protools: 

Target: Protools 24/25/30

Embedded Audio: WAV

Sample rate: Force 48 kHz

Sample size: 16 bit

Audio clip handle (secs): User defined

Flatten edit 
(remove sub-edits): 

Selected
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Blu-Ray and DVD Export

To export to Blu-Ray or DVD: 

STEPS

1. Select Blu-Ray or DVD, as required, from the Targets section of the Format drop down list: 

2. Select the required video size and frame rate from the Size/rate drop down list. 

3. Blu-Ray only: If the Compression type drop down list is visible, select the compression type 
you require from the list. 

4. Blu-Ray only: Select the audio source you require from the Audio tracks drop down list. 

5. Blu-Ray only: If you selected an audio option other than ‘None’, further options display: 

a) Sample size: Select the sampling size you require form the drop down list. 

b) Audio location: Select whether you want audio Embedded in the video or saved as 
separate WAV files. 

6. Check the Use marked section box if you want to export just the marked section on the 
timeline, rather than the whole edit. 

7. (Option) Select the destination for the exported media. Note that you can specify a local 
drive and folder if you want to copy the media to a DVD or Blu-Ray drive at a later time. 

8. (Option) Type a name for the exported file.

9. Click Start. 

a) The Project Card opens and displays the progress of your export in the Tasks tab. 

b) Click on the image thumbnail to view the export task in a larger window. 

c) When the export has completed, a report displays in a Tasks Log window. 
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Lightworks allows you to browse the following online libraries and resources: 

• "Amazing Music Tracks" on page 223

• "Audio Network" on page 225

• "Pond5" on page 230

Amazing Music Tracks

Amazing Music Tracks is a global music group company which has commissioned and recorded 
over 100,000 music tracks for use by television, film and multimedia corporations. 

You can browse the entire selection of music directly from within Lightworks, stream MP3 audio 
files directly over sequences, add search criteria that best suits your requirements, then register or 
sign in to purchase directly. 
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Searching for Amazing Music Tracks

To search for music tracks: 

STEPS

1. Type your search criteria into the Search field, for example, artist, title, music style, into the 
text box and click Search. Music tracks matching your search input display. Artist, download 
price and descriptions display against each track. For example:

2. Use the side scroll bar and buttons at the bottom to page through 
longer track lists. 

3. Double-click on a track or use the playback shortcut keys to listen to 
a preview. The preview plays in sync with the Sequence viewer from 
wherever the timeline marker was parked. 

4. If you want to purchase a track, highlight it and then click ‘Import’ to 
add it to your cart. To select multiple tracks, hold down the Shift or 
Ctrl keys while clicking. 

5. You are taken to your shopping cart - see "Audio Network Cart and 
Checkout" on page 227. 

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 
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Audio Network

Audio Network is a global music group company which has commissioned and recorded over 
100,000 music tracks for use by television, film and multimedia corporations. 

You can browse the entire selection of Audio Network music directly from within Lightworks, 
stream MP3 audio files directly over sequences, add search criteria that best suits your 
requirements, then register or sign in to purchase directly. 

See the following topics: 

• "Searching for Music Tracks" on page 226

• "Audio Network Cart and Checkout" on page 227

• "Setting Audio Network Account Options" on page 228

• "Changing Synced Sequence Previews" on page 229

• "Changing the Waveform Thumbnail Size" on page 229
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Searching for Music Tracks

To search for music tracks: 

STEPS

1. Click on the Log or Edit tab and then on the Audio Network sub-tab. 

2. Type your search criteria, for example, artist, title, music style, into the text box and click 
Search. Music tracks matching your search input display. Artist, download price and 
descriptions display against each track. For example:
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3. Use the side scroll bar and buttons at the bottom to page through 
longer track lists. 

4. Double-click on a track or use the playback shortcut keys to listen to 
a preview. The preview plays in sync with the Sequence viewer from 
wherever the timeline marker was parked. 

5. If you want to purchase a track, highlight it and then click ‘Import’ to 
add it to your cart. To select multiple tracks, hold down the Shift or 
Ctrl keys while clicking. 

6. You are taken to your shopping cart - see "Audio Network Cart and 
Checkout" on page 227. 

Audio Network Cart and Checkout

Before proceeding to the checkout, you can review your selection in the shopping cart. 

STEPS

1. The shopping cart displays the music tracks you have selected for purchase. Artist, 
download price and descriptions display against each track in the same format as in 
"Searching for Music Tracks" on page 226. 

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 

1 23
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2. Double-click on a track to preview it, or use the Playback shortcut 
keys. 

3. If you want to return to the store to review other items, click on the 
Library tab. 

4. When you are satisfied with your selected purchases and want to 
proceed to the checkout, click the Checkout button. 

5. The Sign In dialog box opens. Type your Audio Network user name 
and password, and then click Do It. 

6. If you do not have an account, create one by clicking the Register tab 
and completing the form presented to you. 

Setting Audio Network Account Options

To change the settings for your Audio Network account: 

STEPS

1. Right-click in the Audio Network area of the screen. 

2. The Import Command dialog box opens, with options for your account listed under Audio 
Network. 

3. Select how you intend to use downloaded media (Professional, Television, Commercial, and 
so on) from the Usage drop down list. Prices vary according to how the media will be used. 
For further information, go to www.audionetwork.com. 

4. Select the currency you want to use from the Currency drop down list. On-screen prices are 
converted to the currency you selected. 

5. If you have not signed in to Audio Network and want to make a purchase, click on ‘Sign in...’.

6. Enable the ‘Automatically download new purchases’ box to use your purchased items 
straight away. 

7. To close the Import Command dialog box, click the Close button (‘X’) at the top right hand 
corner. 

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 



TP-00387-01 229

Audio Network

Changing Synced Sequence Previews

To change Synced Sequence Preview options: 

STEPS

1. Right-click in the Audio Network area of the screen. 

2. The Import Command dialog box opens, with options for synced sequences listed under 
Synced Sequence Preview. 

3. Tick the Synced Sequence Preview box to enable the synced preview function. 

4. To disable audio from Lightworks sequences during previews, uncheck the ‘Include 
sequence audio’ box. 

5. Select the clip audio level from the Clip Preview Level drop down list. 

Changing the Waveform Thumbnail Size

To change the size of the Waveform thumbnails: 

STEPS

1. Right-click in the Audio Network area of the screen. The Import Command dialog box opens. 

2. Under Appearance, select Small, Medium, Large or Extra Large from the Appearance drop 
down list. 
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Pond5

You can browse, purchase and download royalty-free videos from Pond5, from within your 
Lightworks projects. Pond5 has reputedly the world's largest collection of royalty-free stock 
footage. See the following topics: 

• "Searching for Video Clips" on page 230

• "Pond5 Cart and Checkout" on page 231

• "Search Options" on page 232

• "Thumbnail Size" on page 232

Searching for Video Clips

To search for video clips: 

STEPS

1. Click on the Log or Edit tab and then on the Pond5 sub-tab. 

2. Type your search criteria, for example, keywords, video format, into the text box and click 
Search. 

3. Video tracks matching your search input display, together with description, video format, 
frame rate and price. 

4. Use the side scroll bar and buttons at the bottom to page through longer media lists. 

5. Click on a clip to select it. 

2
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6. Drag the scrub bar with your mouse to play through the clip, or use 
the playback shortcut keys. 

7. Double-click on a track to play a larger preview in the media player. 

8. Pond5 clips carry a watermark until you have purchased them. 

9. If you want to purchase a track, click to highlight it and then click 
‘Add to cart’. To select multiple tracks, hold down the Shift or Ctrl 
keys while clicking. 

10. You are taken to your cart. If you want to go back to review or purchase further tracks, click 
the Navigation buttons to return to the Library. 

Pond5 Cart and Checkout

Before proceeding to the checkout, you can review your selection in the shopping cart. 

STEPS

1. The shopping cart displays the media you have selected for purchase. 

2. If you want to return to the store to review other items, click on the Library tab. 

3. When you are satisfied with your selected purchases and want to proceed to the checkout, 
click the Checkout button. 

4. The Sign In dialog box opens. Type your Pond5 user name and password, and then click Do 
It. 

5. If you do not have an account, create one by clicking the Register tab and completing the 
form presented to you. 

Default Shortcuts:

j = Reverse Play 
k = Pause 
l = Play 

12
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Search Options

You can refine your searches to include maximum price, video size and minimum clip length. 

STEPS

1. Right-click in the left half of the screen (in the Pond5 panel). The Import Commands menu 
opens.

2. To set a maximum price for each item, select Pond5 > Maximum price, and select the option 
you require from the drop down list. 

3. To set a minimum size for each clip, select Pond5 > Minimum size, and select the option you 
require from the drop down list. 

4. To set a minimum length for each clip, select Pond5 > Minimum length, and select the 
option you require from the drop down list. 

5. If you have not signed in to Pond5 and want to make a purchase, click on ‘Sign in...’.

6. Enable the ‘Automatically download new purchases’ box to use your purchased items 
straight away. 

7. Close the menu by clicking the Close button (‘X’) at the top-right corner. 

Thumbnail Size

To change the size of thumbnails in Pond5: 

STEPS

1. Right-click in the left half of the screen (in the Pond5 panel). The Import Commands menu 
opens.

2. To set the size for thumbnails in your search results, select Pond5 > Appearance > Thumb 
size, and select the size you require from the drop down list. 
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The System Settings and User Preferences menus allow you to customize the appearance of 
Lightworks, apply system tests, review and change your Lightworks license, and create keyboard 
shortcuts and macros.

See the following topics:

• "Systems Settings Menu" on page 233

• "Appearance" on page 234

• "Language Localization" on page 236

• "Using Multiple Monitors" on page 239

• "Hardware Tests" on page 239

• "Keyboard Shortcuts" on page 240

• "Macros" on page 246

• "Lightworks Keyboard" on page 249

To review or change your licensing options, please refer to the Lightworks Installation and 
Activation Guide. 

Systems Settings Menu

The System Settings menu allows you to change the desktop appearance, set the language of 
screen prompts (localization) and perform hardware tests. 

STEPS

1. In the Projects Browser, click on the System 
Settings button at the bottom left corner of 
the screen. 

2. The System Settings menu opens. 

1

2
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Appearance

See the following topics: 

• "Changing Lightworks Appearance" on page 234

• "Save Preset" on page 235

• "Loading a Preset or Restoring Factory Defaults" on page 235

Changing Lightworks Appearance

To change the appearance of Lightworks, including changing text fonts, size and colors: 

STEPS

1. Open the System Settings menu and select User Interface > Appearance. 

2. The User Interface Appearance dialog box opens. 

3. To change the size of text, do one of the following: 

a) Move the slider to the right to increase text size, or to the left to decrease text size. The 
panel to the right shows the result of your adjustments before you commit to change 
your settings. 

b) Tick the ‘Calculate automatically’ box to automatically adjust the size of the entire UI, 
including text. 

4. To change the color of elements such as the window background, text, headings, selections, 
etc. do the following: 

a) Click on the colored box to the right of the program item you want to change.

b) A color palette opens. 

4b

4c
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c) Select the color you require by adjusting the Red, Green, Blue (RGB) sliders. 

d) Alternatively, use the color picker to choose the color. 

e) Adjust the Hue, Saturation and Value (HSV) by typing directly into the named text box. 

f) Click outside the color palette to return to the User Interface Appearance dialog box.

5. Move the slider left or right to decrease or increase the brightness level. 

6. Select the font you require from the Typeface drop down list. 

7. Select the wallpaper you require from the drop down list. The options are: 

• Current wallpaper file

• None

• Choose - selecting this option opens a file navigator. 

The panel to the right of the dialog box displays the wallpaper image you selected.

8. Tick the Auto colorize box if you want  to change the color of the background image to the 
same color you have chosen for the UI. 

9. Click the Use new settings button to save your settings. 

Save Preset

You can save the appearance settings you make as presets, allowing you to switch between the 
default and your personal presets. Do the following: 

STEPS

1. Click on the Cogs icon in the User Interface Appearance dialog box. 

2. From the menu that opens, click on ‘Save settings as new preset’. 

3. A Save Preset dialog box opens. 

4. Type the name for your preset and then click Do It. 

5. The preset is saved and is added to the User Interface Appearance 
menu. 

Loading a Preset or Restoring Factory Defaults

Do the following: 

STEPS

1. Click on the Cogs icon in the User Interface Appearance dialog box. 

2. From the menu that opens, click on the Preset you wish to use, or 
click on Restore Factory Defaults to load the default Lightworks theme. 
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Language Localization

You can change the localization of Lightworks text (Wordings) to make it suitable for your 
language and location. If a localization file does not exist for your region, you can create your own 
file by translating the default English template or another localization file. 

• "Importing a Localization File" on page 236

• "Creating a Localization File" on page 236

• "Exporting a Localization File" on page 238

• "Reverting to Default Localization" on page 238

Importing a Localization File

To import an existing language / localization file: 

STEPS

1. Open the System Settings menu and select User Interface > Wording. 

2. When the Wordings dialog box opens, click on the Cogs icon in the title bar. 

3. From the menu that opens, click on Import Wordings. The Import Wordings dialog box 
opens. 

4. Navigate to the folder where your localization files reside. Localization files have the file 
extension .LwWords.

5. Select the file you want and then click Ok. 

Creating a Localization File

If a localization file for your language or region is not available, you can create your own if you have 
the appropriate language translation skills. 

If your translation exceeds the length of the original caption text, part of your translated 
caption may not display in the space provided. 
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STEPS

1. Open the System Settings menu and select User Interface > Wording. 

2. The Wordings dialog box opens, displaying caption text in the language of the last 
localization file to be loaded. (If the localization in Lightworks has never been changed, this 
will be the default English template.) 

3. Use the currently loaded localization, or load a localization that is easy for you to translate. 
See "Importing a Localization File" on page 236. 

4. Type over each numbered caption or text line with the translation appropriate to your 
language and / or region. Try to keep your translated text as short as possible in order for 
your translation to display correctly. 

5. Any changes you make to the dialog box are applied immediately to Lightworks. However, 
we recommend that you save your work at regular intervals to a file created for your 
localization project. See "Exporting a Localization File" on page 238. 
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Exporting a Localization File

When you have applied your localization, you can save it as a file for backup purposes or 
distribution to other users. 

STEPS

1. Click on the Cogs icon in the Wordings dialog box. 

2. From the menu that opens, click on Export Wordings. The Export Wordings dialog box 
opens. 

3. Type a name for your localization file and then click OK. 

4. A message box displays confirming that a localization file has been created. 

Reverting to Default Localization

If you want to return to the default localization, or you have made a mistake in your localization 
project and want to start again, do the following: 

STEPS

1. Click on the Cogs icon in the Wordings dialog box. 

2. From the menu that opens, click on Revert to default wordings. If the menu option is 
disabled, you are already using the default localization - you do not have to proceed further. 

3. A message box displays, warning that any changes to your current localization will be lost 
unless you have already saved them in an export file. 

4. Click Yes to load the default localization, or No to cancel the operation. 
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Using Multiple Monitors

If you have only one monitor, the full screen display uses that monitor, obscuring the user 
interface. If you have dual monitors, only the extended display is used for full screen display, 
allowing to view the user interface and full playback screens at the same time. It is recommended 
that both displays are of the same resolution. 

STEPS

1. OS X or macOS systems only: In Finder, open System Preferences > Mission Control, and 
untick ‘Displays have separate spaces’. 

2. Open the System Settings menu and select User Interface > Full Screen Preview. 

3. Select the monitor you want to use for full screen playback from the drop down list. 

Hardware Tests

See the following topics: 

• "Running Hardware Output Tests" on page 239

• "GPU Tests" on page 240

Running Hardware Output Tests

You can test the hardware connected to your media outputs by generating a video test pattern 
and sending various audio waveforms. 

STEPS

1. Open the System Settings menu and select Hardware > Output Tests. 

2. The Hardware Output Tests dialog box opens and a 
signal sounds. 

3. On each of the audio channel pairs (1/2 and 3/4) 
select the options you require:

• Waveform: sine or sweep

• Frequency: 100Hz, 440Hz, 900Hz, 1kHz or 10kHz

• Level: Type a level in dBFS (decibels relative to full 
scale) directly into the text box or select one of 
the options from the drop down list. 

• Pattern: Constant Tone, GLITS or SIT. 
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GPU Tests

To test your system Graphical Processor Unit (GPU): 

STEPS

1. Open the System Settings menu and select Hardware > GPU Tests. 

2. The GPU Tests message box opens. 

3. A series of tests are performed on your system and the results of each test are displayed in 
the GPU Test message box. 

4. If any of these tests show as 0 fps then your graphics card is not suitable to run Lightworks, 
or your graphics card driver needs updating. 

Keyboard Shortcuts

You can assign keys or combinations of keys for tasks you do often in Lightworks. If you use a 
physical keyboard suited to your language or region, you can import the appropriate preferences 
for that keyboard. Lightworks also has keyboard profiles for users who are more familiar with Avid 
or Final Cut Pro applications that can be used instead. 

See the following topics:

• "Assigning a Keyboard Shortcut" on page 241

• "Importing Keyboard Shortcuts" on page 242

• "Exporting Keyboard Shortcuts" on page 242

• "Default Keyboard Shortcuts" on page 244

• "Reset Keyboard Shortcuts" on page 243

• "Create HTML Report" on page 243
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Assigning a Keyboard Shortcut

To assign a key or combination of keys to a function: 

STEPS

1. Open the System Settings menu and select User Interface > Key Assignments. 

2. The Key Assignments dialog box opens. 

3. Select the function you want to change from the main panel. 

If you cannot find the function you want, type its name in to the text box ‘A’ and click the 
Search button. 

4. Click the ‘Assign Key’ button. 

5. The Choose Key dialog box opens. 

6. Press a key, or key combination, on the keyboard or one of the eight User keys on the 
Lightworks Console. 

7. If the key is unassigned, click on Add Key.

8. The selected key or key combination is assigned to the function. 

7

8

3 25 4

9
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Importing Keyboard Shortcuts

To import keyboard shortcuts from an external file: 

STEPS

1. Do one of the following: 

• In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the 
menu that opens, click ‘Load’.

• Right-click in the Key Assignments dialog box and, from the menu that opens, click 
‘Load’.

2. The Import Preferences dialog box opens. 

3. Navigate to the folder where the preferences file you want resides. Lightworks ships with 
preference files for Avid and Final Cut Pro, which can be found in the Preferences folder: 

4. Click OK. The keyboard shortcuts are imported. 

Exporting Keyboard Shortcuts

To export keyboard shortcuts: 

STEPS

1. On the Preferences dialog box, click the Export button. The Export Preferences dialog box 
opens. 

2. Do one of the following:

• Navigate to the location you want to export the file to.

• Click Places, and then navigate to the location you want. 

3. Click OK. Your keyboard shortcuts file is exported to the required location. 

Windows 7, 8 C:\Users\Public\Dcuments\Lightworks\Preferences

Linux /usr/share/lightworks/Preferences

Mac OS X Located in the Lightworks bundle: 
/Lightworks.app/Contents/Resources/Preferences
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Reset Keyboard Shortcuts

To reset keyboard shortcuts: 

STEPS

1. Do one of the following: 

• In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the 
menu that opens, click ‘Reset all’.

• Right-click in the Key Assignments dialog box and, from the menu that opens, click ‘Reset 
all’.

2. All keyboard shortcuts are reset to the default template. 

Create HTML Report

You can export the current keyboard assignments as follows: 

STEPS

1. Do one of the following: 

• In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the 
menu that opens, select ‘Create HTML Report’.

• Right-click in the Key Assignments window and, from the menu that opens, select ‘Create 
HTML Report’.

2. An HTML page listing the current key assignments opens in your web browser. The listing 
does not include Macros that you have created. 
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Default Keyboard Shortcuts

Console Actions

Backtime \ ` Remove z

Cue Marker “ Remove Cue Marker #

Delete x Replace b

Delete (2) Delete Reverse Nudge ,

End ; Reverse Nudge (2) Left arrow

Right s

Forward Nudge .

Forward Nudge (2) Right arrow Start h

Stop k

Join Tab Swap [

Switch Esc

Left a

Trim In w

Mark i Trim Last Out q

Mark segment end } Trim Next In r

Trim Out e

Redo Alt+

Redo (2) Ctrl+Y Undo `

Redo (3) Command+Y Undo (2) Ctrl+Z

Redo (4) Shift+Command+Z Undo (3) Command+Z

Unmark p
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Global Commands

Add tracks Backspace Query Nudge Backwards - (numpad)

Audio Crossfades F10 Query Nudge Forwards + (numpad)

Audio Mixer Insert

Next Audio Node Up Arrow

Batch Import Shift+F1 Next Keyframe Ctrl+Up arrow

Nudge 10 frames backward m

Clipboard Insert Ctrl+V Nudge 10 frames forward /

Clipboard Insert (2) Command+V

Clipboard Insert (3) f Query Nudge Backwards - (numpad)

Clipboard Replace g Query Nudge Forwards + (numpad)

Clipboard Source d

Configure current effect F6 Rooms End

Copy to clipboard Ctrl+C

Copy to clipboard (2) Command+C Simple Wipes & Dissolves F8

Copy track Alt+k Slide clip t

Copy track (2) Alt+˚ Slip clip y

Cue Markers F11 Swap track Alt+s

Cut to clipboard Ctrl+X Swap track (2) Alt+β
Cut to clipboard (2) Command+X Switch to audio view F4

Switch to editing view F2

Effects Creation Panel F9 Switch to logging view F1

Empty cut c Switch to video effects view F3

Enable Locked Playing Alt+3

Enable Locked Playing (2) Command+3 Toggle A1 3

Enable Single Playing Alt+1 Toggle A2 4

Enable Single Playing (2) Command+1 Toggle A3 5

Enable Twin Playing Alt+2 Toggle A4 6

Enable Twin Playing (2) Command+2 Toggle A5) 7

Exit Application Alt+x Toggle A6 8

Exit Application (2) Command+X Toggle A7) 9

Exit Application (3) Alt+~ Toggle A8 0

Toggle A9 Hold a, tap 9

Fit to fill Alt+v

Fit to fill (2) Tick Toggle Full Screen playback F12

Import F1 Toggle play Space

Insert & next (preserve track sync) v Toggle status window Ctrl+B

Lightworks Forum PgDn Toggle V1 1

Toggle V2 2

Mark clip ] Toggle V3 Hold v Tap 3

Mark Out o Toggle V4 Hold v Tap 4

Move cut u Toggle V5 Hold v Tap 5

Move track Alt+m Toggle V6 Hold v Tap 6

Move track (2) Alt+M Toggle V7 Hold v Tap 7

Toggle V8 Hold v Tap 8

Next Audio Node Up arrow

Next keyframe Ctrl+Up arrow Video analysis PgUp

Video routing F7

Play faster backwards j

Play faster forwards l Zoom in =

Pop out original n Zoom out -

Preview Alt+Space

Previous Audio Node Down arrow

Previous keyframe Ctrl+Down arrow

Project details Home
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Macros

If you want to group together a sequence of key functions and launch them from a single 
keystroke, you can create a Macro to do this. 

For example, you can create a Macro to trim the In Point of a clip to the current timeline indicator 
position. The macro would consist of the following steps: 

• Clear all marks on the timeline (Unmark) 

• Mark the current playing position (Mark) 

• Go to the previous cut point (Left) 

• Delete marked section and close the gap (Delete) 

You then assign a keystroke or keystroke combination to start the Macro. Every time you pressed 
the keystroke combination, the Macro would initiate the functions you defined trimming the In 
Point of the current clip to the current timeline indicator position. 

See the following topics: 

• "Creating a Macro" on page 247 

• "Editing a Macro" on page 248 

• "Deleting a Macro" on page 248 
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Creating a Macro

To create a macro: 

STEPS

1. Do one of the following: 

• In the Key Assignments dialog box, click on the Cogs icon and, from the menu that opens, 
select ‘Create a macro’. 

• Right-click in the Key Assignments window and, from the menu that opens, select ‘Create 
a macro’. 

2. The ‘Create A Macro’ dialog box opens. 

3. Add a title and description. 

4. Click the Add button. 

5. The Add Command(s) dialog box opens: 

a) Click to select the commands you want in your macro, for example, Unmark, Mark, Left 
and Delete. 

b) Click OK to close the Add Command(s) box. The selected commands load into the 
Create a Macro dialog box. 

6. Using the mouse, drag the commands into the order you require. 

7. To remove a command, highlight it with the mouse and then click Remove. 

8. Click the Create button. Your macro is added to the Key Assignments window. 

9. In the Key Assignments window, click on your macro to highlight it and click the ‘Assign Key’ 
button. 

532

4

5a

5b

6

8 7
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10. The Choose Key dialog box opens. 

a) Press a key, or key combination, on the 
keyboard or one of the eight User keys on the 
Lightworks Console. 

b) If the key is already assigned to a function, that 
function displays in the Choose Key dialog box. 
If you do not want to keep the original key 
assignment, try another key combination.

c) When you have decided on your key 
assignment, click on ‘Add key’. 

d) The selected key or key combination is assigned 
to the function. 

Editing a Macro

To edit an existing Macro: 

STEPS

1. Do one of the following: 

• Click on the Settings menu (Cogs icon) and select ‘Create a macro’. 

• In the Key Assignments window, right-click on the Macro you want to edit and, from the 
menu that opens, select Edit macro. 

2. The Edit window for the selected Macro opens. 

3. Make any changes you require, as described in steps 3 to 8 of "Creating a Macro" on 
page 247. 

Deleting a Macro

To delete a Macro: 

STEPS

1. Do one of the following: 

• Click on the Settings menu (Cogs icon) and select ‘Create a macro’. 

• In the Key Assignments window, right-click on the Macro you want to delete and, from 
the menu that opens, select Destroy macro. 

2. A message box opens, asking you to confirm the deletion. 

3. Click the Yes button to delete the Macro, or No to cancel. 
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Lightworks Keyboard

Lightworks Keyboard

Lightworks Keyboard: 1 of 2
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Lightworks Keyboard: 2 of 2
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Appendix A: Lightworks Console

The Lightworks Console can be used to play video and audio, and to control many of Lightworks’ 
editing functions. 

The console has keys for the more common editing functions and a flat bed-style paddle to 
facilitate post production operations. A free USB port is required to connect the Lightworks 
Console. Power for the Lightworks Console is provided by the USB port of the host system. 

Consoles may be ordered from the Lightworks web site: www.lwks.com. 

See the following topics: 

• "Installing the Console" on page 251

• "Controls and Indicators" on page 252

• "Console Editing Buttons" on page 253

• "Console Button Combinations" on page 254

• "Assigning User Defined Buttons" on page 255

A set of video tutorials explaining how to operate the Lightworks Console can be viewed at 
www.lwks.com/the-console 

Installing the Console

A free USB port is required to connect the Lightworks Console. Power for the Lightworks Console 
is provided from the USB port of the host system.

STEPS

1. Connect a ‘B’-type USB cable between your computer and the USB connector on the rear of 
the Lightworks Console. 

2. Install the Console drivers appropriate to the operating system you are using, and as 
directed by the instructions supplied with the Lightworks Console. 

3. Restart your computer. 

4. The Lightworks Console is ready for use. 
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Controls and Indicators 

The Lightworks Console controls and indicators are as follows: 

Jog ON / OFF 
Button

Editing Buttons

LeversPlay Forward / 
Play Backward 

User Buttons

Trim Buttons

Jog Wheel

Stop Button

Control Function

Play Buttons The Play Forward and Play Backward buttons play material forward or backward at normal play 
speed. Pressing a second time doubles the speed. Press again to return to normal speed. 

To nudge one frame forward or backward, hold down the Stop button and press one of the Play 
buttons. To play frame by frame (at approximately 10 percent normal speed), continue to hold 
the Stop button and press the Play button.

Stop Button Stops playback instantly.

Console Lever Lets you play the clip forward or backward at any speed between 0 percent and approximately 
1000 percent of normal play speed. Dual levers offer positions for left-handed and 
right-handed users. 

The levers include notches at play speed forward and backward. For accurate timing, use the 
buttons instead.

Sync sound is maintained from 0 to 6 times play speed - above this, sound is muted.

Jog Wheel Lets you play material slowly in forward or reverse, particularly when audio scrubbing. The Jog 
Wheel is enabled by doing one of the following:

• Press the Jog On/Off button.

• Move the jog wheel sharply (gentle movement is not effective).

Editing Buttons See "Console Editing Buttons" on page 253.
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Console Editing Buttons

Console Editing Buttons

The following table describes the console editing buttons. 

MARK UNMARK SWAP CUE

JUMP 
BACK

JUMP 
F’WARD

TRIM 
LEFT

TRIM 
RIGHT

USER 1

USER 3

USER 2

USER 4

REPLACE

INSERT

REMOVE

DELETE

Edit Button Description

Mark Marks the current frame of a clip or cut, used to insert, replace, move, or delete the portion 
between the mark and the current frame. The marked portion is represented by a blue 
marker on the View Indicator Strip and Timeline.

Unmark Removes the mark from the active tile or viewer.

Swap Swaps the position of the current frame (red diamond) and the marked frame (blue 
diamond).

Cue Creates a green cue point at the current frame. The cue point is permanent until deleted by 
pressing Stop+Cue. Jump to cue points with the Jump buttons.

Jump Back /
Jump Forward

Move the current frame from event to event, forward or backward. An event is a cut, 
dissolve, or wipe; a cue point or audio node; the blue mark; the first or last frame of an edit 
or clip. 

The Jump button sets the current frame to the first frame after the cut and jumps to events 
on all selected tracks.

Trim Left, 
Trim Right

Allows cut points to be unjoined without using the mouse. Multiple cut points can be 
unjoined at the same time.

User 1 - 4 User defined buttons. You can program these buttons to perform a command listed in the 
Key Assignments list in Lightworks. See "Assigning User Defined Buttons" on page 255. 

Replace Inserts all the selected source frames into the edit overwriting the original material.

Remove Lifts the selected part of the edit, leaving black behind. The reverse of the Replace button.

Insert Inserts all the selected source frames into the edit, without overwriting anything else.

Delete Cuts out the selected part of the edit and closes the gap. The reverse of the Insert button
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Console Button Combinations

You can combine console buttons with the Stop button for additional operations. To use the 
button combinations, press the required edit button while holding down the Stop button. See the 
following table. 

MARK 
ALL

JOIN SWITCH
DELETE 

CUE

START END
UNJOIN 

LEFT
UNJOIN 
RIGHT

USER 5

USER 7

USER 6

USER 8

BACK 
TIME

FILL

UNDO

REDO

STOP +

Edit Buttons Description

Stop+Play Forward Nudges the material forward one frame.

Stop+Play Backward Nudges the material backward one frame.

Stop+Jump Back Jumps to the start of the active clip or edit.

Stop+Jump Forward Jumps to the end of the active clip or edit.

Stop+Replace Backward Replace (for making back-timed edits). See "Backward Replace from Out Point in 
Source" on page 65.

Stop+Insert Performs an insert and leaves the current frame at the end of the inserted clip. This is useful 
when you assemble clips into an edit.

Stop+Delete Performs a Redo on the currently selected edit.

Stop+Remove Performs an Undo on the currently selected edit.

Stop+Unmark Same as the Join/Unjoin button on the Timeline. Joins and unjoins cuts for trimming. See 
"Reopening Edits" on page 93.

Stop+Cue Deletes a cue. Park on a frame before you press Stop+Cue.

Stop+Swap Switches activity between the Record viewer and the current source.

Stop+Mark Places a mark at the end of the clip currently parked on, that is, selects the remainder of the 
current clip.

Stop+Trim buttons Unjoins either the previous clip (left button) or the following clip (right button) for 
trimming. For more information, see "Chapter 5: Timeline Editing" on page 77.

Stop+User 1-4 Provides extra user defined buttons (User 5 to User 8). See "Assigning User Defined 
Buttons" on page 255. 
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Assigning User Defined Buttons

You can assign Macros to user defined keys. For instructions on creating and editing 
Macros, see "Macros" on page 246.

To assign a function or Macro to a user defined key: 

STEPS

1. Open the User Preferences dialog box as described in "Keyboard Shortcuts" on page 240. 

2. Click the Change / View key assignments button. The Key Assignments window opens. 

3. Select the command, to which you want to assign to a Console key, from the displayed list. 
Commands listed under the ‘Console Actions’ category already have Console keys assigned 
to them, so it is not necessary to assign a second key. 

4. Click the ‘Assign key’ button. The Choose Key dialog box opens. 

5. On the Console, press the User button you want to assign to the command. The code for the 
selected User button displays in the Choose Key dialog box. 

6. Click the ‘Add key’ button. 

7. Click the Choose key dialog box closes and the new key assignment displays in the Key 
Assignments dialog box. 

8. If a command has more than one key or button assigned to it, duplicate entries are created, 
for example, Batch Import (2), Batch Import (3), etc. 

3

2

4 6

7

5
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Flexible Project Layout

If you prefer the Flexible Lightworks layout, or want to display extra viewers in multicam views, you 
can switch to the Flexible Projects layout. In Flexible layout, the Projects Browser appearance is 
unchanged, but opened projects display like earlier versions of Lightworks, with legacy features 
such as floating windows, Toolbar, Project Rooms and the Sharking feature. 

To open Lightworks in Flexible Project layout mode: 

STEPS

1. In the Project Browser, click on the Cogs 
icon and, from the menu that opens, select 
User Interface > Project layout > Flexible. 

2. When you open a project, the desktop 
opens to the Flexible layout. See "Desktop 
Features" on page 258. 

3. To return to standard view, click on the Cogs 
icon in the Project Browser and, from the 
menu that opens, select Project layout > 
Fixed. 

See the following topics: 

• "Desktop Features" on page 258

• "Working with Rooms" on page 260

• "Playback" on page 262

• "Tear-Off Bins and Groups" on page 268

• "Editing Multiple Sources" on page 271

• "Live Editing with Multiple Viewers" on page 273

• "Recording" on page 275

1,3
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Desktop Features

See the following topics: 

• "Project View" on page 258

• "The Toolbar" on page 259

• "Sharking" on page 259

• "Source Viewer" on page 260

Project View

The project workspace is laid out as follows: 

1) Project Menu - allows you to review and update your project settings 

2) Rooms Menu - allows you to divide your project into separate areas 

3) Viewer - provides playback and review functions

4) Content Manager 

5) Shrink button - minimizes the Lightworks application to the task bar 

6) Close button - shuts down the Lightworks application

7) Import Panel - navigation tool for finding and importing video clips from your system 

8) Shark Tool (Red = Pro version, Grey = Free version) 

9) Toolbar - provides shortcuts to major Lightworks functions 

10) Exit Project - exits the Project Browser and return to the Lobby

10

9

8

6

7
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The Toolbar

The Toolbar provides access to several tools you use during your recording and editing process. It 
is open by default in Project View. 

Sharking

A shark displays in the bottom left corner of the Project View. It is colored red 
in Lightworks Pro and colored grey in the Free version. 

You can use the shark to hide windows while working on your project, and later 
use the shark to recover those windows. This is known as ‘sharking’. The shark 
also displays helpful tips during major tasks. 

The shark must be picked up with the right mouse button (held down) then 
click over items to remove them. Clicking the shark empties items that were 
closed. 

Record
Opens the Record tool for recording new clips 

Import
Opens the Select Files to Import dialog box 

Edit
Opens the viewer and timeline for a new edit 

Content Manager
Opens and closes the Content Manager tool 

Search
Opens the Search tool 

Playout
Opens the Playout Tool for playing an edit to tape 

Export
Opens the Export tool 

Editor Preferences
Opens the Editor Preferences dialog box
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Source Viewer

Viewers and Timelines are displayed as separate windows. You can open as many Viewer and 
Timeline windows as you like. 

STEPS

1. To lock the screen position of the viewer, click on the Pin icon. The icon changes to a 
flattened shape, indicating the viewer is locked. To unlock, click the icon again. 

2. To return the clip to a tile view in the Content manager, click the Flatten button. 

3. To read the filecard (Metadata), click the filecard icon. 

4. Click the Timeline button to open the timeline. 

5. Click the ‘pop out’ icon to open the image as a new tile on the desktop. 

6. Click the Subclip button to create a new subclip. 

7. Video and audio tracks display at the bottom right corner of the viewer. Stereoscopic video 
tracks are labeled ‘LR’ instead of V1. Click on a track to alternately disable and enable the 
track. 

Working with Rooms

Rooms are used to play and edit material. A room is the arrangement of project components and 
can belong to only one project. However, a project can have more than one room. For example, 
you could create one room called Editor and another room called Assistant.

You can have several rooms that belong to the same project. You can delete and recreate rooms 
without affecting any of the work in the project. 

See the following topics: 

• "Creating a New Room" on page 261

• "Using an Existing Room" on page 261

• "Deleting a Room" on page 262

1

3

4

5

6

2

7
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Working with Rooms

Creating a New Room

You can also create a new room from within an existing project. This can be useful if you are 
working on several episodes from one project, so each episode can be on the screen in its own 
room. All of your media and edits are accessible in the new room, you will not lose any media. 

To create a new room from within a project: 

STEPS

1. With an open project, click on the Room drop down list. 

2. A submenu opens, displaying existing room(s) in the project and a blank new room labeled 
New Room. 

3. Click on New Room. 

4. You enter the new room. The project name and an arbitrarily assigned room number appear 
in the upper left corner. 

5. Click the room name, type the name you want, and then press Enter to save the name.

Using an Existing Room

To use an existing room: 

STEPS

1. Click on the Room drop down list and, from the menu that opens, select the room you 
require. 

2. You enter the room. All the screen objects that were in the room when you last used it are 
displayed.

1

2

3

4
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Deleting a Room

You cannot delete a room that you are currently using. To delete a room: 

STEPS

1. In your project, click on the Room drop down list. 

2. Mouse over the image for the room you want to delete. 

3. A cross displays. Click the cross to delete the selected room. 

Playback

See the following topics: 

• "Playing a Tile" on page 262

• "Playing in a Viewer" on page 263

• "Playback Control Options" on page 265

Playing a Tile

When playing a tile in the Content Manager, you can also use the Global playback buttons, see 
"Playback Control Options" on page 265. 

1

3

2

4
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Playing in a Viewer

You can play material in a viewer. You can also link tiles to viewers, and you can change the label 
display and the viewer size. See the following topics:

• "Opening a Tile in a Viewer" on page 263

• "Playback in a Viewer" on page 264

• "Resizing the Viewer" on page 264

• "Linking Tiles to Viewers" on page 265

Opening a Tile in a Viewer

To open a tile in a viewer: 

STEPS

1. Do one of the following: 

• Hover the mouse over the tile and click on the Viewer icon (a) when it appears. 

• Double-click on the tile. 

2. The selected clip opens in a Viewer. 

3. The name of the clip displays at the top of the viewer.

4. The right and left ends of the timeline represent the start and end of the clip. 

5. To open another clip in a separate Viewer, click on the clip’s Viewer icon (a) as described in 
step 1. You can have as many Viewers on screen as you want. 

6. To open another clip in the same Viewer, double click on the tile you want to open. 

a

3

4

2
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Playback in a Viewer

To play a tile in a viewer:

STEPS

1. Open a tile in a viewer. See "Opening a Tile in a Viewer" on page 263.

2. Click in the picture area. The border brightens, indicating that the viewer is active. 

3. Play the material by doing one of the following:

• Use the Lightworks Console playback buttons, the lever, or the jog wheel.

• Use the keyboard shortcuts, l (lowercase L) for play, spacebar for play / stop.

• The playback controls on the viewer. 

• The on-screen playback controls. See page 265. 

To change where the playback controls display, see "Playback Control Options" on 
page 265. 

4. To move through the material, click the red frame marker in the Indicator strip and drag it 
where you want.

5. To jump to a new point, click on the Indicator strip at the timecode position you want to 
jump to.

6. To lock the viewer on the screen, click the Pin button in the upper right corner. To unlock the 
viewer, click the Pin button again. 

7. To shrink the viewer back to a tile, click the Shrink button. 

8. To close the viewer, click the Close button. Clicking the Close button does not delete the clip, 
it only removes the viewer being displayed. The clip remains in your project, and can be 
accessed from the bin in the Content Manager.

Resizing the Viewer

Click on any edge of the viewer and drag to resize it. The pixel size of the viewer displays over the 
video at the top left corner as you resize the viewer.

6 7 8

4 5



TP-00387-01 265

Playback

Linking Tiles to Viewers

You can link tiles to viewers. This preserves the tile’s mark and park information, as well as In and 
Out points. Do the following:

STEPS

1. Right-click the Content Manager icon in the 
Toolbar. 

2. From the menu that opens, select ‘Link Bin Tiles to Viewers’ and then select Yes.

Playback Control Options

You can display an on-screen version of the Lightworks console at the bottom of the workspace. 
The on-screen console allows you to play and edit video clips as if you were using the Lightworks 
console. 

To choose to where to display Lightworks’ playback controls: 

STEPS

1. Click the User Preferences icon in the Toolbar. 

2. The Preferences dialog box opens. 

3. Under ‘User Interface’, select the option you 
require from the Playback controls drop down list. 
The options are: 

• On each viewer - Playback and edit controls 
display in all open source and sequence 
viewers. See "Playback in a Viewer" on 
page 264. 

• Global - Playback controls are fixed at the base 
of the Lightworks screen - as shown in the 
example above. 

• None - Playback controls do not display on the 
Viewers or Lightworks screen. 

Back to previous cut

Back one frame

Play / Pause †

Forward one frame

Go to next cut

Delete item

Remove item

Insert item

Replace item

Set In Point       Set Out Point       Clear Points

† Clicking while holding down Shift key plays media in reverse
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Importing

See the following topics: 

• "Import Destinations" on page 266

• "Using the Import Tool" on page 266

• "Import using Drag and Drop" on page 267

• "Using the Batch Import Tool" on page 267

Import Destinations

You set import destination for Historic Lightworks using the procedure described in "Import 
Destination" on page 203. 

Using the Import Tool

To import a file or a group of files:

STEPS

1. Click the Import icon on the toolbar. 

2. The Select Files to Import dialog box opens. 

3. Click on Places at the top-left corner of the dialog box. From the menu that opens, navigate 
to the directory containing the files you wish to import. 

4. The Select Files to Import dialog box displays the Name, Format, Rate, Size and Date of each 
clip. Make sure the frame rate of the file is compatible with the project frame rate. 

If the frame rate is of a clip is not compatible with your project, it displays in red. You will be 
unable to import the clip into your project. 
Clips with incompatible frame rates may be playable in a new project set to the same frame rate 
as the clip. 

3

4
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5. Click Import. A message box opens, reporting the progress of the import process. 

6. The message box closes and the imported clips display in the Recent or Search filter ready 
of the Content Manager. 

7. You can select where to place your imported files and if you want to transcode them to a 
new compression format. 

Import using Drag and Drop

By default, any valid media files dragged and dropped into an empty bin is imported automatically. 
Disabling Drag and Drop allows you to use the batch Import Tool. 

To disable drag-and-drop, Right click the Import icon and, from the menu that 
opens, set ‘Start import on drag/drop’ to No. 

Using the Batch Import Tool

Before using Batch Import, ensure that drag and drop is disabled in Lightworks, see "Import using 
Drag and Drop" on page 267. To use batch import: 

STEPS

1. Right-click the Import icon on the toolbar and, from the menu that 
opens, select ‘Batch Import’. 

2. The Batch Import dialog box opens. 

3. Click on the Add Files button.

4. The Select Files to Import dialog box opens.

5. Click on Places at the top-left corner of the dialog box and navigate to the directory 
containing the files you want to import. 

3

7

6
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6. To remove files from the Batch Import dialog box, select the file(s) you want to be removed, 
and then click on Remove.

If the frame rate is of a clip is not compatible with your project, it displays in red. You will be 
unable to import the clip into your project. Clips with incompatible frame rates may be playable 
in a new project set to the same frame rate as the clip. 

7. To start Batch Import, click Start. Click Import. An Import message box reports progress as 
the files are imported. 

8. When the import finishes, a bin called Imports opens, containing your imported files. The 
Import dialog box closes.

Tear-Off Bins and Groups

You can tear off Bins and Groups from the main Content Manager, create Rack views of Bins and 
create new versions. See the following topics: 

• "Tearing Off Bins" on page 268

• "Tearing Off Groups" on page 269

• "Using Tear-Off Bins and Groups" on page 270

Tearing Off Bins

To tear off a bin: 

STEPS

1. Click on a bin entry in the Content List and drag the bin off the Content Manager window. 

2. Click the ‘Enlarge’ icon (b). 

3. The window expands, displaying the contents of the selected bin. 

b
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Tearing Off Groups

To tear off a Group containing Bins: 

STEPS

1. With the Content Manager open, click on the Group you want to tear off, and drag it onto 
the Lightworks desktop. 

2. Release the mouse button to drop the Group onto the desktop. 

3. The Group opens and displays its Bins in a Rack view. 

4. If there are more Bins than the Group can display, use the scroll bar to reveal Bins that are 
hidden from view. 

3 2 1
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Using Tear-Off Bins and Groups

Use the Tear-Off Bins and Groups as follows: 

STEPS

1. Click the Group’s Shrink icon to minimize the Group. 

2. Click the Group’s Enlarge icon to restore it to Rack view. 

3. Click on the Bin’s Enlarge icon to open it. 

4. The Bin opens as a Content Manager. Click the Content List button to alternately reveal and 
hide the Content List panel. 

5. The Bin contains a row of tabs, each tab representing one of the Bins in the Group. Click on 
a tab to navigate quickly to the Bin it represents. 

6. Right-click on a tab to open a drop down list of all Bins in the Group. Scroll through the list 
and click on a Bin to open it. 

7. Click on the Search icon to look for items in Bins or Groups. 

8. Click on the Bin’s Shrink icon to minimize it. 

9. Click on the Bin’s Enlarge icon to restore it to Content Manager view. 

10. In the Group’s Rack view, click on a Bin’s Close icon to remove it from the Group. 

10 9

1 23 7 85 64
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Editing Multiple Sources

Lightworks makes playing and editing material from multiple sources simple, quick, and flexible. 
You can update up to four sources locked together in real time, depending on the type of material 
and the method you choose, but you can lock together as many sources as you want. 

Lightworks offers several methods for playing multiple sources simultaneously: 

• Play the Sequence viewer and a single source viewer, or two source viewers, together

• Play more than two sources, with many in real time based on storage bandwidth and 
resources.

Playing back multiple pictures at the same time completely and smoothly depends on the 
available resources and system bandwidth limitations. 

See the following topics: 

• "Playing Two Sources" on page 271

• "Using Multicam Bins" on page 272

Playing Two Sources 

You can lock two viewers together for twin playing. You can select two Source viewers or one 
Source viewer and one Sequence viewer for playback: 

STEPS

1. Park the first source viewer at the sync frame you want.

2. Park a Sequence viewer, or second Source viewer at the sync frame you want. 

3. Press Alt+2 (Cmd+2 on Mac OS X).

4. Click one of the viewers, and press the Play button on the console.

5. Both viewers play. The audio for the active viewer is routed to the audio monitoring system.

6. Use any of the viewer’s transport buttons, or shortcut keys, to control playback. 

7. To stop twin playing, press Alt+1 (Cmd+2 on Mac OS X). 
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Using Multicam Bins

Even though the same clip can appear on the screen in more than one place, there 
is only one copy of the material on disk. Deleting a clip contained in any Multicam 
Bin deletes every other instance of that clip, for example, other bins, sequences 
and subclips. 

A menu for Multicam Bin functions is available by clicking on the Cogs icon in the top right corner 
of the Content Manager. 

STEPS

1. Multicam Bins are listed in the Content List panel, below Bins, and are identified by a green 
square bullet point next to their name. Click on the Multicam label to view the Bin contents. 

2. Each clip displays as a tile in the Multicam Bin. 

3. To play a tile: 

a) Use the Lightworks Console playback controls. 

b) Use the playback shortcut keys. 

c) Hover the mouse over a tile and click on the viewer icon that displays. A viewer opens 
providing access to the playback controls - if viewer controls are enabled in Settings. 

d) Use the global playback controls at the bottom of the screen, if they are enabled. 

4. To open viewers for all of the tiles, do one of the following: 

• Tick the Compact box at the bottom right of the Multicam Bin. 

• Click the cogs icon on the bin and select ‘Display viewers’ 

The Content Manager shrinks (A), and viewers for each of the tiles open. 

5. To restore the Content Manager view, untick the Compact box. 

6. To close all open viewers, click on the Cogs icon and, from the menu that opens, select Hide 
viewers. 

7. To resize the tiles in the Multicam Bin view, click on the Cogs icon, and from the menu that 
opens, select Small, Medium or Large from the Tile size drop down list. 

8. To enable independent playback of tiles, click on the Cogs icon and, from the menu that 
opens, select Concurrent players > No. To resume synced playback, select Concurrent > Yes. 

2

A
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Live Editing with Multiple Viewers

During Live Editing, Historic Lightworks allows you to open separate viewers for each camera 
angle. A menu for Live Editing functions is available by clicking on the Cogs icon in the top right 
corner of the Content Manager. See the following topics: 

• "Starting a Live Edit" on page 273

• "Viewing an Edit Created by Live Editing" on page 275

Starting a Live Edit

To start a Live Edit: 

STEPS

1. Open the Multicam Bin you want to Live Edit. Choose to display the viewers for the bin 
contents or just use the tiles — the Multicam Bin must not be set to Compact if you want to 
use tiles. 

2. Click the ‘Auto sync with record edit’ button. 

3. Either click on the Cogs icon, or right-click inside the Multicam bin. From the menu that 
opens: 

a) Enable the ‘Live-editing enabled’ box. 

b) Enable the ‘Concurrent players’ box. 

4. Click the Edit icon from the toolbar to start a new Edit. 

a) A new Sequence viewer and timeline open. 

b) Make sure the Record indicator is enabled. 

3a

3b
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5. Click one of the tiles or source viewers to give it playback focus. 

The audio from the selected source is monitored throughout the Live Editing session, irrespective 
of cuts you make. You do not hear audio edits as they are made, only when you play back the 
completed edit. 

6. Start playing the sources by doing one of the following: 

• Click a source viewer (or global) Play button 

• Press the Play shortcut key (L or spacebar) 

• Press the Lightworks Console Play button 

7. At the source In point you want for the first clip, do one of the following: 

• Click on the source tile or viewer to select it 

• Press the Live Cut shortcut key you assigned to the source 

• Press the assigned Cut buttons on the Lightworks Console - see "Using the Lightworks 
Console Cut Buttons" on page 72

8. The first clip displays in the Sequence viewer and timeline. 

9. Repeat step 8 to add more clips to your edit. 

9

4b
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Viewing an Edit Created by Live Editing

To view a Live Edit you created: 

STEPS

1. Stop Live Editing. 

2. Click the Sequence viewer to make it active.

3. Make sure the ‘Auto sync with record edit’ button is enabled.

4. Start playing the edit. 

5. The edit plays back in real time. 

6. When you stop the edit, the synced items stop at the correct section. 

Recording

This section describes basic procedures for ingesting material. You can record material in the 
following ways: 

• Recording without machine control

• Recording with machine control

• Recording with machine control and a Logging database 

You can record material as a series of separate recordings, where each recording is one take of the 
original material, or you can make a continuous recording containing many takes.

See the following topics:

• "Preparation" on page 275

• "Manual Recording" on page 279

Preparation

The following procedures should be followed on changing to a new recording source or when you 
want to change destination folders or video format: 

• "Device and Format Selection" on page 276

• "Choosing a Record Destination" on page 277

• "Reel ID" on page 278

• "Setting Audio Input Levels" on page 279
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Device and Format Selection

You must select the Device and Format in the Record Tool that match the type of signal you 
are recording, otherwise no video will display. 

Once you have set the format, you select file type and compression you want. Each file type 
has different compression options available, including uncompressed options for Avid and 
MOV. If you want to record Avid DNxHD MXF you must purchase an Avid license from the 
Lightworks shop. 

The following procedure assumes that you have already added and configured the source device 
in Lightworks: 

STEPS

1. Click the Record Tool icon in the Toolbar. 

2. The Record Tool opens. 

3. Select the device you want to use from the Device drop down list. 

4. If your device is connected and online, a timecode displays in the information panel. 

5. In the Record Tool, select a video format from the Format drop down list. 

6. Select a Compression type from the Compression drop down list. 

7. Select the file format you require from the File type drop down list.

8. Select Manual from the Recording type from the drop down list. The available video and 
audio tracks display below the Recording Type drop down list. 

31
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Choosing a Record Destination

You can select a record destination. On a production with a very large amount of material, you may 
want to store each episode or reel in a separate disk drive or media space. Recordings are always 
made to the volume that has the most free space unless you manually select a different disk 
volume. 

Make sure there is enough storage space remaining on the volume for the recording you are 
about to make. If you fill a volume during recording, the recording stops automatically, but 
the material recorded so far is kept. 

To choose a record destination: 

STEPS

1. Click the Destination list in the Record Tool.

2. From the menu that opens, select the destination volume you want, or Auto if you want 
Lightworks to decide which destination to use. 

1

2
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Reel ID

When you click the Standby button on the Record Tool, you may be asked to enter a Reel ID. This 
usually occurs when you add or change the source device. 

STEPS

1. When the Reel ID dialog box opens, select a Reel ID from the displayed list. 

2. Alternatively, create a new Reel ID: 

a) Click the ‘Create new reel’ button. 

b) The Create Reel ID dialog box opens. 

c) Type the name or number for the new Reel ID. 

d) Click Do It. The dialog box closes, and the new Reel ID is added to the list. 

3. On selecting the required Reel ID, click Use. 

4. The Reel ID box closes, and the Record Tool expands to show additional recording functions. 

2c
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Setting Audio Input Levels

Audio levels can vary from clip to clip, or from tape to tape. This can be annoying if the levels are 
too high or too low. You can set the incoming audio levels at the time of recording in the Record 
Tool as follows: 

STEPS

1. Start the recording device and select it from the Device drop down list in the Record Tool. 

2. Click the Standby button. If the Reel ID dialog box opens, select a Reel ID as described in 
"Reel ID" on page 278. 

3. The Record Tool expands to display extra audio and video controls. 

4. Audio level bars for the available audio tracks display to the right of the Record Tool. 

5. Do one of the following: 

a) Type negative or positive decibel (dB) values in the Audio Level text box. 

b) Right-click an audio level slider and drag it to the value you want. 

6. Recorded audio is captured at this setting until you change it. 

7. Click the Standby button again if you do not want to proceed with recording at this time The 
Record Tool contracts to its normal size. 

Manual Recording

See the following topics: 

• "Starting a Recording" on page 280

• "Stopping a Recording" on page 281

• "Sound-Only Recording" on page 281

1
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Starting a Recording

Once you have prepared Lightworks for recording (see "Device and Format Selection" on 
page 276) do the following: 

STEPS

1. With the Record Tool open, click the Standby button. 

2. If the Reel ID dialog box opens, select a Reel ID as described in "Reel ID" on page 278. 

3. The Record Tool expands to display extra recording controls. 

4. The video input from the source device displays. 

5. An audio level meter displays for each audio track detected. 

6. Make sure the Video and Genlock buttons located under the video display are green. If they 
are unlit, the video signal or the video reference is unstable. 

7. If enabled, use the transport control buttons to position the tape a few seconds before you 
want the In point to be.

8. Click the Record button. The recording starts. 

9. During recording: 

a) The Record button label and function changes to End, and a Cancel button is added to 
the right of the End button. 

b) A red ‘Recording’ label displays below the transport controls. 

c) A Filecard opens, in which you can review and update metadata. See the Lightworks 
User’s Guide for further information. 

2
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Stopping a Recording

To stop a recording: 

STEPS

1. Do one of the following:

a) To keep the material you have recorded, click the End button (8) in the Record Tool, or 
click the Stop button on the Lightworks Console. 

b) To discard any material recorded so far, click the Cancel button during recording.

2. The recording stops. 

a) The End button label and function changes to Record, and the Cancel button is 
removed. 

b) The red ‘Recording’ label is removed. 

c) The Filecard for the recorded material closes. 

d) Unless you clicked Cancel, the newly recorded material is placed in a Bin named after 
the tape ID. 

3. Press the Standby button again.

4. The Record Tool contracts to its normal size. 

Sound-Only Recording

On clicking the Standby button when a sound-only device is selected, the Record Tool expands to 
show audio tracks only - there is no video display area. Otherwise the recording procedure is the 
same as described in "Starting a Recording" on page 280 and "Stopping a Recording" on page 281. 

1b 43 1a
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Numerics
2D DVE 168
2D Shape, Simple 177
3D

importing 206
settings 122

3D DVE 169
3D LUT 167

A
AAF 210

exporting 220
Active Tasks 126
ALE 211
Ambience 110
Aspect Ratio 121, 121
Atmos, Atmosphere 110
Audio

adding and removing tracks 101
boosting or lowering levels 106
displaying levels 105
displaying waveforms 104
editing 101
enabling while scrubbing 79
importing into 30 and 24fps projects 214
nodes 107
nodes, copying 108
removing nodes 107
removing selected nodes 108
replacing sound with atmos 110
setting input levels 279
signal generator 239
Transitions 149
waveform contrast 105

Audio Fade In/Fade Out 109
Audio Network 223, 225
Audio options 122
Audio Tracks

adding 101
deleting 103
renaming 102
turning OFF and ON 103

Audio View 22
Auto Track Sync 86
Auto Unjoin - see Auto Track Sync
AVI 209

B
Background 110
Backups

automatic 73
restoring sequences 74, 75

Batch Import Tool 267
Bins 31

Adding to Groups 132
appearance 129
changing the field order 136
creating 31
customizing the List View 136
deleting 130
deleting views 137
displaying columns 135
linking tile to viewer 265
List View 134
merging 138, 138, 139
moving clips between 128
removing from Group 132
renaming 128
resizing 129
saving views 137
sorting 132
tearing off 268
Tile View 133
working with 127

Blackmagic RAW Files 206
Bluescreen 176
BWF 213

C
Checking Free Disk Space 124
Chromakey 174
Chunks, MXF 209
Cine Crop 170
Clip Colors on the Timeline 81
Clips

copying to other bins 32
deleting 41
described 33
moving between bins 128
playing in a viewer 36, 264
replacing with black or audio space 93
sliding 92
slipping 91

Color Balance 164
Color Bars 176

Index
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Color Correction 163
color balance 164
curves 166
HSV 166
RGB 165

Color Effects
3D LUT 167
Color Correction 163
Color Temperature 163
Color Tint 161
Greyscale 161
Negative 162
Selective Correction 167
Tri-Tone 162
Two-Tone 162

Color Gradient 177
Color Mask 175
Color Matte 176
Color Temperature 163
Color Tint 161
Comma Separated Files (CSV) 46
Compact view 272
Console controls

global 265
Content Manager 29

Bins 31
browsing 29
Media types filter 30

Contrast 165
Corner Gradient 177
Crawling Titles 178
Creating New Projects 25
Cue Markers

adding 44
deleting 47
described 44
editing 45
exporting 46
jumping to 45

Cues
making multiple subclips 56

Curves 166
Cut

moving 90
rejoining 95
trimming incoming clip 89

D
DEVE

3D DVE 169
Devices 12
Digital Video Effects - see DVE
Dissolve 152
Documentation 14
Drag and Drop

copying in the timeline 98

import using 267
moving in the timeline 97

Drag and Drop Region on Timeline 82
DVE 167

2D DVE 168
Cine Crop 170
Flip 170
Flop 170
Picture in Picture Presets 171
Split Screen 172
Split Screen with Backgroung 173

E
Edit - see Live Editing
Edit View 20
Effects

adding from Timeline 158
adding using Add button 159
Bluescreen and Greenscreen 176
Color Mask 175
configuring 160
favorites 191
Image Key 176
Keys and Masks 174
Lumakey 174
saving templates 191
Titles 178

Exporting
Cues 46
formats 215
keyboard shortcuts 242
Lightworks archives 219
localization file 238
to AAF 220

F
FAQ 15
Film options 123
Filters, Content Manager 30
Flip effect 170
Flop effect 170
Fonts, Title Effects 179, 183
Formats 205

Export 215
Forum 15
Frames, saving from Sequences 66
Full Screen video 37

G
Gamma 165
Global Console Controls 265
Global Look Up Table 185
GPU Tests 240
Greenscreen 176
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Greyscale 161
Groups 127

adding bins 132
creating new 131
deleting 132
described 131
removing 132
removing bins 132
renaming 128, 131
sorting 132
tearing off 269
ungrouping 132

Groups, Bins 127

H
Hardware 12
Hardware Output Tests 239
Hints and tips 24
HSV 164, 166
HTML Report of keyboard shortcuts 243
Hue 166

I
Image Key 176
Image, Matte Effect 178
Images

importing sequences 209
importing single image 208

Import 205
destination 203

Importing
AAF and XML 210
ALE 211
audio files into 30 and 24 fps projects 214
AVI, MOV, MPG, MPEG 209
BWF and WAV 213
clips into Projects 27
image sequences 209
keyboard shortcuts 242
localization file 236
Look Up Tables 186
OMF 212
RED (R3D) files 212
single images 208
single or group files 266
Stereoscopic media 206
supported formats 205
using drag and drop 267
using the Batch Import Tool 267
using the Import Tool 266

In and Out Points 54

K
Key Effects 174
Keyboard 12

Lightworks 13
Keyboard shortcuts 240

assigning keys 241
default values 243, 244
exporting 242
HTML report 243
importing 242
resetting 243

Keyframes
adjusting values 189
creating 189
described 188
enabling and disabling 192
removing 189
smooth and linear interpolation 190

L
Label

displaying timecode 42
Languages

localization 236
Learning Lightworks 24
Letterboxing 120
Lightworks

archives 219
Documentation 14
FAQ 15
Forum 15
Quick Start Guide 14
Technical Support 15

Lightworks Console 14, 72, 251
assigning user defined buttons 255
button combinations 254
controls and functions 252
editing buttons 253
installing 251

Lightworks Keyboard 13, 13
List View 134
Live Edit

starting 71
with multiple viewers 273

Live Editing 70
described 70
stopping 72
using the Lightworks Console 72
viewing a sequence 73
viewing an edit 275

Localization
exporting file 238
file, creating a 236
importing file 236
reverting to default file 238

Logging In 18
Look Up Tables 167

described 184
enabling 120
Global 185
Importing from Project Card 186
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Importing from Timeline 187
Including in Exports 188

Lumakey 174
Luminance 166
LUT - see Look Up Tables

M
Macros

assigning to Lightworks Console 255
creating 247
deleting 248
editing 248
overview 246

Mark and Park 52, 101
Matte Effects

Color Bars 176
Color Gradient 177
Color Matte 176
Corner Gradient 177
Image 178
Simple 2D Shape 177

Memory requirements 12
Merging bins 138, 138, 139
Metadata 39
Monitors, using multiple 239
Mouse 12
Mouse Actions 83
MOV 209
MPG / MPEG 209
Multicam Bins

adding sources 142
changing the current frame 142
combining sync methods 144
compact view 141, 272
creating 140
described 139
removing sources 142
using 141, 272

Multiple Monitors, using 239
MXF 209

N
Negative 162
Nodes

audio 107
copying audio 108
removing 107
removing selected 108

O
OMF 212
Output Tests 239
Overview

Audio view 22

Edit view 20
Projects view 19
Sequence view 20
VFX view 21

P
Panels, resizing 23
Picture in Picture Presets 171
Playback

playing a tile 262
playing in Content Manager 34
Shortcut Keys 34
speed, changing 100
two sources 271
using Multicam Bins 139

Playback controls
positioning 265

Pond5 230
Prints 67
Project

menu 258
view 258

Project Card 117

Transcoding options 125
audio options 122
Checking free disk space 124
Details tab 118
Film options 123
Media Manger, Locations tab 124
opening 117
Reviewing proxles 125
Stereoscopic options 122
Tasks tab 126
Video, Conversions tab 121, 121
Video, Letterbox tab 120
Video, Main tab 119

Projects
closing 28
creating 25
deleting 28
described 24
importing clips 27
opening existing 26

Projects View 19
Proxies (Proxy clips) 144
Proxies, reviewing settings 125
Push (Transition) 153

R
R3D files 212
Ranged Markers

adding 48
deleting 49

Recent Filter 30
Recent Tasks 126
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Recording
device and format selection 276
preparation 275, 276
Reel ID 278
setting audio levels 279
setting record destination 277
sound-only 281
starting 280
stopping 281

RED decode quality 119
RED files 212
Redo 95
Reel ID 278
Rejoining a Cut 95
Renaming Bins 128
Resizing Panels 23
Restoring

described 73
sequences from backups 74, 75

RGB 166
color correction 165

Rolling Titles 178
Rooms

creating within a project 261
deleting 262
described 260
using existing 261

S
Safe Trimming 82
Saturation 166
Saving and Restoring 73
Saving Bins 130
Segment Drag Region 82
Selective Correction 167
Sequence View 20
Sequences 60

backward replace from Out Point 65
copying 67
deleting 66
making prints 67
open-ended replace 62
opening 59
removing material 61
saving video frame from 66
source selection replace 64

Shark, Sharking 259
Shortcuts 34

keyboard 240
Trimming functions 93

Signing In 18
Simple 2d Shape 177
Sound clips 101
Source Viewer 60
Speed, changing playback 100
Split Screen 172

Split Screen with Background 173
Squeeze 154
Starting Flow Story 18
Static Titles 178
Stereo 3D Tab 122
Stereoscopic media 122

importing 206
Subclips

creating 53
deleting 57
described 54
making from marked timeline 55
Mark and Park 52
marking the entire clip 53
multiple from one clip 56
swapping In and Out Points 54
syncing separate video and audio 69
Undo and Redo 57

Sync
combining sync methods 144
selecting a method 143

Sync Groups - see Multicam Bins
Synchroniser 69
Syncs (Subclip type) 54
System

changing the appearance of Lightworks 234
Hardware tests 239
Settings menu 233
specifications 12

T
Tear-off Bins and Groups 268

using 270
Technical Support 15
Templates, Saving Effects 191
Text on the Timeline 80
Thumbnails

resizing in List View 135
resizing in Tile View 133

Tile View 133
Tiles

linking to viewer 265
opening in viewer 35, 263
playback 262
playing in a viewer 36, 264

Timecode
direct entry 43
jumping to 43

Timecode Label
displaying 42

Timeline
copying with drag and drop 98
features 77
marker 78
moving with drag and drop 97
undo and redo 95

Timeline Settings
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audio level display 105
audio waveform contrast 105
Behaviors tab 82
clip colors 81
displaying text 80
displaying waveforms 104
keyframes 192
mouse actions 83

Title Effects 178
effects for static titles 184
shadow 182
text and font properties 179, 183
text color 180
text outline 183
title position and movement 181

Toolbar 259
Transcodng options 125
Transitions

adding 148
audio 149
change video or audio 149
configuring 150
Dissolve 152
Push 153
Squeeze 154
types of 151
Wipe 154

Transport Controls
positioning 265

Trimming
Auto Track Sync 86
incoming clips 89
moving a cut 90
outgoing clip 88
outgoing clips 88
previewing 94
rejoining a cut 95
reopening edits 93
shortcut keys 93
sliding a clip 92
slipping a clip 91
using trimview 87

Trimview 87
Tri-Tone effect 162
Troubleshooting 15
Two-Tone effect 162

U
Undo 95
Ungrouping 132
using the source viewer 60

V
Value, HSV 166
VFX View 21
Video

full screen 37
signal generator 239

Video Effects View 21
Video Routing Panel 193
Viewer

linking to tile 265
opening a tile 35, 263
playback 36, 264
resizing 264

Viewing full screen video 37
Voice Overs

adding 111

W
WAV 213
Waveforms, displaying 104
Wild Track 110
Wipe 154

X
XML 210
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